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Preface

This section explains the objectives, intended audience, and organization of this publication and
describes the conventions that convey instructions and other information.

This section provides the following information:
e Revision History
e Document Objectives
e Audience
¢ Document Organization
e Related Documentation
e Document Conventions
e Obtaining Optical Networking Information

e Obtaining Documentation and Submitting a Service Request

Revision History

This is the first release of this publication.

Document Objectives

Audience

The Cisco Transport Planner DWDM Operations Guide, R10.1 explains how to design networks using
the Cisco Transport Planner design tool for the Cisco ONS 15454 DWDM systems. It contains
information about how to design an optical network. Use the Cisco Transport Planner DWDM
Operations Guide, R10.1 in conjunction with the appropriate publications listed in the Related
Documentation section.

This publication is intended for experienced network system engineers who are responsible for planning
and ordering equipment for Cisco optical networking systems.
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Chapter

Document Organization

This Cisco Transport Planner DWDM Operations Guide, R10.1 is organized into the following chapters:

Chapter 1, “Introduction” provides a list of features, an overview of the network design process, a
description of the internal architecture, and the Cisco Transport Planner procedural flow.

Chapter 2, “Creating and Analyzing Networks” provides instructions for using the Cisco Transport
Planner tool to create a network design.

Chapter 3, “Viewing Network Reports” provides instructions for generating reports and bills of
materials.

Chapter 4, “Editing a Project” provides instructions for adjusting and optimizing design
components.

Chapter 5, “Modeled Network Examples” provides examples of typical optical networks that you
can model using Cisco Transport Planner.

Appendix A, “GUI Information and Shortcuts” provides Cisco Transport Planner graphical user
interface shortcuts.

Appendix B, “Card Types” provides a list of card types that can be used to build a network, and the
corresponding Cisco product identifier.

Appendix C, “System Messages” provides a list of system errors.

Appendix D, “Third-Party DWDM Wavelength Interface Model” provides reference information on
third-party DWDM interface calculation.

Appendix E, “Configuring CTP to Run on a Server” provides instructions to run CTP on a server.

Appendix F, “Pay As You Grow Licensing” provides information about the composition of each
PAYG bundle.

Appendix G, “OSMINE Layout Rules” provides information about the OSMINE layout rules.

Related Documentation

Use this Cisco Transport Planner DWDM Operations Guide, R10.1 in conjunction with the following
referenced Release 10.1 publications:

Cisco ONS 15454 DWDM Configuration Guide
Cisco ONS 15454 DWDM Troubleshooting Guide
Cisco ONS DWDM Licensing Configuration Guide
Cisco ONS SONET TL1 Command Guide

Cisco ONS SDH TL1 Command Guide

Release Notes for Cisco Transport Planner

Release Notes for Cisco ONS 15454, ONS 15454 M2, and ONS 15454 M6 DWDM
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Document Conventions

~

Note

A

This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ ] Keywords or arguments that appear within square brackets are optional.
{xIxIx} A choice of keywords (represented by x) appears in braces separated by

vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the
Control key while pressing the D key.

screen font Examples of information displayed on the screen.
boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Caution

A

Means reader be careful. In this situation, the user might do something that could result in equipment
damage or loss of data.

Warning  IMPORTANT SAFETY INSTRUCTIONS
This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. To see translations of the warnings that appear in
this publication, refer to the translated safety warnings that accompanied this device.
Note: SAVE THESE INSTRUCTIONS
Note: This documentation is to be used in conjunction with the specific product installation guide
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other
enclosed additional documentation for further details.
Cisco Transport Planner DIWDM Operations Guide, R10.1
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Obtaining Optical Networking Information

This section contains information that is specific to optical networking products. For information that

pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information

For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 system. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product

Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco Transport Planner DOWDM Operations Guide, R10.1
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Introduction

Note  Cisco MetroPlanner has been renamed to Cisco Transport Planner starting with Release 8.5.

Wie In this guide, M2 chassis refers to the Cisco ONS 15454 M2 chassis, M6 chassis refers to the
Cisco ONS 15454 M6 chassis, and M12 chassis refers to the Cisco ONS 15454 chassis.

Cisco Transport Planner (CTP) provides a way to model and test wavelength division multiplexing
(WDM) optical networks in a graphical environment. The primary purpose of Cisco Transport Planner
is to help sales engineers (SEs) design and validate networks of Cisco Optical Networking System
(ONS) 15454 Multiservice Transport Platforms (MSTP). Using the CTP, an SE can create multiple
instances of a network to modify different parameters in each instance for comparison. Cisco Transport
Planner generates a shelf view of all the sites deployed in the optical network and provides a complete
bill of materials (BoM) for the network and the differences between instances of a network.

This chapter describes how you use Cisco Transport Planner to design, analyze, and optimize new or
existing Cisco optical networks and contains the following sections:

e 1.1 Overview, page 1-1

e 1.2 Installing Cisco Transport Planner, page 1-16

e 1.3 Uninstalling Cisco Transport Planner, page 1-17

e 1.4 Launching the Cisco Transport Planner, page 1-17

e 1.5 Performing Software Updates in CTP, page 1-21

e 1.6 Setting Cisco Transport Planner Options, page 1-22

e 1.8 Understanding the Pay As You Grow Feature, page 1-43

1.1 Overview

This section describes the Cisco Transport Planner, Release 10.1 features, network design process,
process flow, traffic planning, traffic services, and parameter states.

| Cisco Transport Planner DIWDM Operations Guide, R10.1
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| 1.1.1 Cisco Transport Planner, Release 10.1 Features

Cisco Transport Planner software provides a simple tool set for designing optical networks with

Cisco ONS 15454 MSTP products. You enter all network parameters, or minimal information, such as
site distance, and Cisco Transport Planner models the network you need to build and generate a detailed
BOM with ordering information. Designing optical networks requires the verification of multiple
constraints such, as optical budget limitations and platform architectural restrictions. A single

Cisco Transport Planner project can contain multiple copies of a network. This duplication allows you
to change parameters in one network copy, and then analyze and compare it with another network copy
to study the differences. The new features of Cisco Transport Planner, Release 10.1 are listed in

Table 1-1.

Table 1-1

New Features in Cisco Transport Planner, Release 10.1

Features

Description

100GS-CK-LC cards

Support for 100GS-CK-LC cards for 100GE service type.

AC/DC power supply and cable
support

Support for AC2 data center power cable and DC40 power. From
release 10.1 onwards, DC40 is the default power supply.

Bidirectional communication
between CTP and CTC

CTP supports import of Span length and Span loss, and DCU.

FBGDCU enhancements

CTP supports FBGDCU on all transponder cards for all System
Releases above 9.4.

FLD-OSC Support for FLD-OSC on MSTP nodes.
Pluggables Support for ONS-SC+-10G-xxxx pluggables on the following:
e Cards—10X10G cards.
e Service Types—OC-192/STM-64, 10G-LAN PHY,
10G-FICON, Fiber Channel 10G, OTU2, and OTU2e.
e xxxx denotes wavelength. The supported wavelengths are
1470, 1490, 1510, 1530, 1550, 1570, 1590, and 1610.
Split ROADM CTP supports Node Splitting (from release 10.1 onwards). The

ROADM node can be configured to have separate Network
Elements for different Line Sides (Per-side NE).

1.1.2 Network Design Process

To generate a network design, the SE enters the following parameters:

¢ The topology of the network—ring, linear, or meshed

e The type of equipment used at each site

e The distance separating the sites

e The type of fiber connecting the sites

e Service demands, including the service type, the protection type, and the number of channels

between nodes

e The number of network sites
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When the network parameters are entered, Cisco Transport Planner finds the best routing, defines the
required add/drop filters, places optical amplifiers with dispersion compensation units (DCUs) or
tunable dispersion compensation units (TDCU) to fit the user traffic demands at a minimum cost. The
TDCU operates only over the C-band. Optimization is performed to meet the boundary conditions. The
optimization includes attenuation and amplification.

Finally, Cisco Transport Planner generates a BOM, which includes the product codes, the quantities, and
pricing information. In addition, it creates other reports, such as a shelf-level view of the configuration,
which can be printed. This information helps the SE understand how the shelf is built and helps to avoid
confusion and errors during the actual deployment. Within the BOM is the total network cost, which
allows a quick comparison of various design options. The total network cost is the cost of the equipment
for all of the sites in the designed network.

1.1.2.1 Network Design Constraints

Cisco Transport Planner searches for the best solution to a designed network using an optimization
algorithm.

A network design must meet the optical budget and receiver overload criteria to operate efficiently. An
analysis of the optical budget and receiver overload evaluates the strength of the signal traversing the
ring. If a design solution satisfies the constraints, it is a valid design. The Cisco Transport Planner
optimization algorithms generate multiple solutions and verifies the constraints against those solutions.
If the constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected as the
optimal solution.

If the network design solution fails to satisfy all the constraints, Cisco Transport Planner makes
adjustments to parameters such as signal attenuation and amplification. Amplification is achieved using
an erbium-doped fiber amplifier (EDFA). Attenuation is achieved using the variable optical

attenuator (VOA) modules integrated into the platform. Cisco Transport Planner corrects the optical
budget using an algorithm that includes automatic placement of EDFAs and VOA regulation.

For each internodal demand, Cisco Transport Planner performs an optical budget and receiver overload
analysis and displays the results in various reports in the Graphical User Interface (GUI). If the network
design algorithms are not able to provide a solution, then you can modify the input data (for example,
by relaxing some user constraints) and run the analysis again.

1.1.2.2 Platform Support

Cisco Transport Planner Software R10.1 supports the Cisco ONS 15454 DWDM optical platform
Software Releases 9.0, 9.1, 9.2, 9.2.1, 9.3, 9.4, 9.6.0.3, 9.8, and 10.0.

1.1.2.3 Topology Support

The Cisco Transport Planner supports the following network topologies:
e Linear (single-span or multispan)
¢ Ring (open or closed)
e Meshed

For more information on network topologies, see the “5.1 Supported Cisco Transport Planner
Topologies” section on page 5-1.

The Cisco Transport Planner enables you to design flexible networks with up to 150 site locations. A
flexible network uses ROADM nodes to allow traffic modification or reconfiguration, or both as traffic
requirements change.

| oL-29753-01
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1.1.2.4 Protection Scheme Support

Cisco Transport Planner designs support the following protection schemes:

In Cisco Transport Planner Software R10.1, the maximum number of locations where the optical service
channel (OSC) is terminated is 40. The maximum number of add/drop locations supported is 40.

Y-cable protected—In Y-cable protection, one transponder card is designated as active and the other
as standby. The standby transponder card has the client-side laser turned off to avoid corrupting the
signal transmitted back to the client. The active transponder monitors the signal from the trunk side
and in the event of loss or signal failure, the system switches to the standby path. Figure 1-1 shows
an example of a Y-cable protected link.

Figure 1-1

Y-cable protection

Client

Rx

:

Tx

Y cable

TXP/MXP

TXP/MXP

Side A
Mux/Demux

W - Working (active)
P - Protect (standby)

Side B
Mux/Demux

246590

Client-based 1+1—Two client signals are transmitted to separated line cards or transponder cards
instead of using a Y-cable to split one client signal into two line cards or transponder cards. In client
1+1 protection, the failure and switchover is controlled by the client system. Figure 1-2 shows an

example of a 1+1 protected link.

Figure 1-2

1+1 Protection

Client

X

X

TXP/MXP

Client

X

X

Yo @k

TXP/MXP

Side A
Mux/Demux

W - Working (active)
P - Protect (standby)

Side B
Mux/Demux

246583
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Fiber-switched protection—The single client signal is injected into the client receive (Rx) port. It is
then split into two separate signals on the two trunk transmit (Tx) ports. The two signals are
transmitted over diverse paths. The far-end card chooses one of the two trunk Rx port signals and
injects it into the Tx client port. Figure 1-3 shows an example of a fiber-switched protected link.

Figure 1-3 Fiber-switched Protection
Multitrunk card
Tx W’ x| side A
Mux/Demux
Rx }(—{ Tx
Rx
Client TXP/MXP
4—‘ Tx
DR siges
Mux/Demux
Rx }(—{ Tx 9

W - Working (active)
P - Protect (standby)

PSM-OCH—Channel protection configuration provides protection at trunk level (like
Fiber-Switched protection) for TXP/MXP that do not have dedicated Fiber-Switched cards. PSM
splits the traffic originated by transponder trunk on working and protected TX ports. Working Tx
(W-Tx) and protected TX (P-Tx) are connected to the add ports of Add-Drop stages adding the
channel in two different directions. On the receiving direction PSM W-RX and P-RX are connected
to the drop ports of Add-Drop stages receiving the channel from the two different directions. PSM
switch selects a path among W-Rx and P-Rx ports so that only one direction at a time is connected
to COM-RX ports and therefore to the TXP/MXP. Figure 1-4 shows an example of a PSM-OCH
protected link.

Figure 1-4 PSM-OCH Protection
T W’ RX| Side A
Mux/Demux
Rx }(—{ Tx
Rx Tx }—){ Rx
Client TXP/MXP PSM
Tx Rx }(—{ Tx
T P’ RX| side B
Mux/Demux
Rx }(—{ Tx 2

W - Working (active)
P - Protect (standby)

Unprotected—Protection is not used.

External card switch—Protection not used.
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1.1.25 Service Support

Cisco Transport Planner can support any subset of the following services:

Alien (third-party DWDM interface)
Cisco ONS 15530 2.5 Gbps Aggregated
ONS 15530 10 Gbps Aggregated

ONS 15530 Multirate (MR) Transport
ONS 15530 Data Multiplexer (MXP)
2R Any Rate

3G-SDI

Gigabit Ethernet

10GE—10 Gigabit Ethernet (LAN and WAN)
D1 Video

DVB-ASI—Digital Video Broadcast-Asynchronous Serial Interface
DV-6000

DPSK—Different Phase Shift Keying
ESCON—Enterprise System Connection
Fast Ethernet

Fiber Channel 1G

Fiber Channel 2G

Fiber Channel 4G

Fiber Channel 8G

Fiber Channel 10G

FICON—Fiber Connection 1G

FICON Express 2G

FICON 4G

FICON 8G

FICON 10G

E3 over FE

T3 over FE

DS3 over FE

High Definition Television (HDTV)
ISC-3 Peer (1G)

ISC-3 Peer (1G with STP)

ISC-3 Peer (2G)

ISC-3 Peer (2G with STP)

ISC-3 Peer (2R)

ISC-3 Peer (2R)
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ISC-Compat (ISC-3 Compatibility mode)

HD-SDI
HDTV
OC-3
0C-12
0C-48
0C-192
0C-768
OTU2
SD-SDI

SDI—Serial Data Input

STM-1

STM-4

STM-16
STM-64
STM-256

10GE WAN-Phy
10GE LANtoWAN
100GE

40GE LAN PHY
OTU1

OTU2

OTU2e

OTU3

OTU4

Sysplex CLO—control link oscillator
Sysplex ETR—external throughput rate
LAN-WAN Conversion

Overview H

The Sysplex CLO and Sysplex ETR services are supported only on the following topologies:

Single span—Two terminal sites with 32MUX-0O and 32DMX-O cards, 40MUX-O and 40DMX-O
cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed and no

intermediate sites in between.

Point-to-Point—Two terminal sites with 32MUX-0O and 32DMX-O cards. 40MUX-O and
40DMX-O cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed. Line
amplifiers can be installed between the terminal sites, but intermediate (traffic terminating) sites

cannot be installed.

Two hubs—Two hub nodes in a ring with 32MUX-0O, 32DMX-0, 32WSS, 40MUX-0, 40DMX,
40DMX-0, 40WSS, and 32DMX cards or 32DMX-O cards installed. Line amplifiers can be

installed between the hubs.
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For more information about the supported topologies for the ETR and CLO services, refer the Cisco ONS
15454 DWDM Configuration Guide.

The following features are available only when 100GE or OTU4 is selected as the service type during
network creation:

CRS line card 1-100GE-DWDM (FEC, EFEC [default], or HG-FEC) is available for Point-to-Point,
P-Ring, and ROADM demands.

(For Release 9.6.03 and later) MPO-MPO cables are available in the Net view and Site view of the
BoM report. MPO-MPO cables are not available for combination cards. For example, MPO-MPO

cables are not available if you have chosen 100G-LC-C+CFP-LC or 100G-LC-C+ASR as card type.

The encryption feature is available only:

When 10GE LAN PHY, OTU2e, or OTU2 is selected as the service type during network creation.

1.1.3 Cisco Transport Planner Process Flow

The following stages are used to complete a network design. See Figure 1-5 for the process flow.

1.
2.

Create a project using the Project Creation wizard.

Create a network using the Create Network wizard. The Create Network wizards adds sites and
places the fiber spans between the sites. A span represents a pair of fibers.

Create a point-to-point, Aggregated Ethernet, TDM Aggregated, protected ring (P-ring), and/or
ROADM service demand.

Analyze the network design.

If you would like to force automatic tool choices, adjust the design and repeat the analysis until you
have reached the desired configuration.

Create an Install copy of the network and update the parameters with real data from the field.
Analyze the Install network.

Create an upgrade copy of the network, as needed, to add forecasted channels.
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Figure 1-5 Cisco Transport Planner Process Flow
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1.1.4 Planning Traffic in Cisco Transport Planner

Traffic in Cisco Transport Planner is defined as an optical path for each pair of nodes requiring a service
demand. An optical path is the combined channels between the two nodes. The following list gives
definitions for some basic traffic items:

¢ Circuit—A single channel between a pair of source and destination nodes. In addition to the source
and destination nodes and all the attributes that are common to the service containing the circuit, a
circuit has the following attributes:

Present/forecast indication

Routing direction for unprotected service

ITU channel

Optical bypass indication
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e Demand—A set of circuits with common characteristics, such as:
— Service demand label
— Number of existing circuits
— Number of forecasted circuits
— Client service type
— Protection type
— Optical bypass (number of channels and/or sites)
— WDM interface type (TXT or ITU-LC)
- WDM card type
— Source client interface (SR, IR, or LR)
— Destination client interface (SR, IR, or LR)

e Traffic demand—All traffic between the same set of nodes. Both L-band and C-band are supported.
The following traffic demands are supported: P-ring, Fixed (point-to-point), and Any-to-any
(ROADM).

— In P-ring traffic demands, all the demands are used to support traffic topologies similar to
bidirectional line switched rings (BLSRs) or multiplex section-shared protection rings
(MS-SPRings). Each P-ring demand is between a pair of added/dropped nodes where
BLSR-like (or MS-SPRing-like) traffic must exist. The number of circuits is the same for each
demand, and is user-specified (from 1 to 40).

— In fixed (point-to-point) traffic demands, the set of nodes is restricted to two sites. The number
of circuits is user-specified (from 1 to 40).

- In any-to-any (ROADM) traffic demands, a minimum of two nodes and a maximum of 40
ROADM nodes are supported. The any-to-any traffic demand allows each node to establish one
or more circuits with the other nodes, either as a hub or meshed configuration. In a meshed
configuration, each node defined in the set is connected to each of the nodes. This is the most
common traffic type. In a hub configuration, the user-defined hub node is connected to each of
the other nodes. ROADM circuits have the same protection types and services. The number of
circuits is not user-specified and can vary from O to 40.

a~

Note In any-to-any (ROADM) traffic demand, the default routing strategy is Unprotected minimum
hop count.

A ROADM demand can have multiple client service types and support multiple DWDM card
interfaces for each client service type. A ROADM demand supports the following routing strategies:

— Protected (Default)}—Each node pair in the traffic demand is connected using two connections.

— Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers, but also
restricts the number of channels that can be deployed among the nodes of the traffic demand
(maximum of 40 channels between each node pair) in the installed network.

— Unprotected minimum hop count—Each node pair in the traffic demand is connected by one
connection. The unprotected minimum hop count maximizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic demand, but
requires a higher number of optical amplifiers on the unprotected optimum optical path
(maximum of 40 channels between each node pair) in the installed network.
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— Unprotected subnet—Each node pair in the traffic demand is connected using one connection.
You can manually force connections on only one branch of the ring. For unprotected subnets,
you must manually select one starting node of the branch and the direction the ring must be
traversed to define the subnet, starting from the initial site. The branch direction is specified by
defining the outgoing side first, referred to as the starting node. This routing strategy option
allows you to exclude some critical paths and (with ROADM traffic demands containing two
sites) to force each ROADM connection clockwise or counterclockwise.

1.1.5 Project Explorer Pane

The Project Explorer pane shows all of the open project information, including networks, network
dependencies, sites, fibers, services, and so on. The user-defined traffic services are displayed as folders
and icons in the Project Explorer pane, as shown in Figure 1-6.

Figure 1-6 Project Explorer View
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After you analyze a network design, the colors of the icons change according to the error/warning
condition of the network design. The icons display in red if there are errors in the network design; orange
if there are warnings but no errors; and green if there are no warnings or errors. The icon shows the color
of the most severe condition. For more information about analyzing the network, see the “2.9 Analyzing
the Network” section on page 2-53.

The Project Explorer pane provides the following options to edit the parameters:
e Right-click the folder/icon in the Project Explorer pane to edit the parameters.

e Click sticky to select multiple items in the Project Explorer pane. Edit the properties that are
common to the selected items in the Properties pane.

1.1.5.1 Multiple Selection

Click sticky in the Project Explorer pane toolbar to select multiple folders and icons in the Project
Explorer tree or the Network View. Alternatively, hold the Ctrl key on the keyboard and select multiple
folders and icons. The folders and icons corresponding to the selection in the Project Explorer pane are
highlighted in the Network View and vice-versa. You can also select similar folders and icons by
right-clicking them and choosing Select Similar in the menu. For example, by right-clicking a site
choosing Select Similar in the menu, you can select all the sites in the Project Explorer pane. The
Select Similar option is available only for the folders and icons in the Project Explorer pane that have
properties. The properties that are common to the selected items are displayed in the Properties pane. If
any property has a different value than the others, that value is highlighted in a different color in the
Properties pane.

The following options are available when multiple folders and icons are selected:
e Sites
— Delete, Unlock, and Unlock Pay As You Grow Bundles
— Edit properties
e Ducts
— Delete, Insert Site, and Unlock
— Edit properties
e Service Demands
- Delete and Unlock
— Edit properties

1.1.5.2 Cisco Transport Planner Traffic in the Project Explorer Pane

Cisco Transport Planner represents all of the user-defined traffic services as folders and icons within the
Project Explorer pane.

1.1.5.2.1 Point-to-Point Traffic Demands

Point-to-point traffic demands appear in the Service Demands > PointToPoint folder in the Project
Explorer pane. Each point-to-point traffic demand is categorized by its source and destination site
names. All of the point-to-point services between the two sites appear under the designated demand
name (Figure 1-7).

Cisco Transport Planner DOWDM Operations Guide, R10.1



| Chapter1 Introduction

Overview H

Figure 1-7 Point-to-Point Traffic Demand in the Project Explorer pane
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A point-to-point traffic demand includes the following information:

e Client service type

e Site# — Site# (source and destination site labels for this demand)

1.1.5.2.2 P-Ring Traffic Demands

Each protected ring (P-ring) traffic demand appears in the Project Explorer pane under the
Service Demands > P-Rings folder. Figure 1-8 shows an example of a P-ring traffic demand in the

Project Explorer pane.

Figure 1-8 P-Ring Traffic Demand in the Project Explorer pane
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All the P-ring channels between each site pair are listed under each P-ring traffic demand. Each demand
is labeled with the following information:

e P-ring number
e Client service type

e Site# — Site# (source and destination site labels for this demand)

1.1.5.2.3 ROADM Traffic Demands

Each ROADM traffic demand appears in the Project Explorer pane under the Service Demands >
ROADMs folder. The ROADM folder contains each defined ROADM demand. You can define more
demands for the same ROADM for the same set of nodes. Figure 1-9 shows an example of a ROADM

traffic demand.
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Figure 1-9 ROADM Traffic Demand in the Project Explorer pane
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In the Project Explorer pane, each ROADM includes the ROADM demand name and a list of DWDM
card types that support the client service types. Protection types appear in parentheses.

1.1.5.2.4 Aggregated Ethernet Demand

Each aggregated ethernet traffic demand appears in the Project Explorer pane under the Service
Demands > Aggregated Ethernet folder. The Aggregated Ethernet folder contains each defined
aggregated ethernet demand. Aggregated Ethernet demands are supported on ring and linear traffic
subnets. Figure 1-10 shows an example of an aggregated ethernet traffic demand.

Figure 1-10 Aggregated Ethernet Demand in Project Explorer pane
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1.1.5.25 TDM Aggregated Demand

Each TDM aggregated demand appears in the Project Explorer pane under the Service Demands >

Aggregated TDMs folder. Figure 1-11 shows an example of a TDM aggregated traffic demand in the
Project Explorer pane.
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Figure 1-11 TDM Aggregated Demand in Project Explorer pane
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TDM aggregated demands are supported only on a ring traffic subnet.

1.1.6 Auto, Forced, and Locked Parameters

Parameters in CTP can be in one of three states:

e Auto— This parameter allows the highest degree of flexibility to CTP in designing a network. When
you select Auto, CTP chooses the parameter value during network analysis.

e Forced—When you set a specific parameter value, other than Auto, CTP designs the network using
these constraints. When a setting is forced, the item appears in blue italics in the Project Explorer
pane.

e Locked—The state of a parameter after network analysis. The next time the analyzer is run,
Cisco Transport Planner cannot change the value when it is in the Locked state. You can unlock an
item using the Unlock command. For more information, see the “2.10.5 Unlocking Parameters in
the Network Design” section on page 2-58 and “2.10.5.1 Forcing Manager” section on page 2-58.
Figure 1-12 shows an example of sites in a locked state.

Note  For the WSE card, the encryption option can be modified even when the demand is in locked
state. This is available in the Upgrade or Release-upgrade networks and on A2A finalized
demands that can be edited from A2A Finalized Circuits. When modifications are made without
the unlock, the encryption parameter on the specific port of the WSE card is updated on analysis.

Figure 1-12 Locked Sites in the Project Explorer View
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Depending on the initial state, the network analyzer will:
e Move the parameter into the Locked state if the unit or parameter was set to Auto.

e Leave the parameter in the same state if the user forced a specific value for the unit or parameter.
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1.2 Installing Cisco Transport Planner

Use the following procedure to install Cisco Transport Planner:

Step 1 To download the installer, go to the Cisco software download site.
Step2  Navigate to the location where you want to save the CTP executable file to a local hard drive.
Step3  Click Save.
Stepd  To start the installation of CTP:
¢ Windows—Navigate to the folder containing the CTP executable file and double-click it.

¢ Linux—Assuming the CTP.bin file is accessible from the current shell path, navigate to the directory
containing the CTP.bin file and enter:

% ./CTP.bin
The graphical CTP installation wizard is displayed.
Step5  Click Next. The license agreement is displayed.
Step6  To accept the license, select the I accept the terms of the License Agreement radio button.
Step7  Click Next.
Step8  Specify the installation folder. On Windows XP, the default is C:\Program Files\Cisco\CTP-R10.1.

To choose a different folder, click the Choose... button and browse to the required folder. To restore the
default path, click the Restore Default Folder button.

Step9  Click Next.
Step10  Specify the shortcut folder by choosing any one of the following options:
¢ In a new Program Group—Specify a new folder. The default option is CTP-R10.1.
¢ In an existing Program Group—Select a folder from the list of existing folders.
¢ In the Start Menu
¢ On the Desktop
e In the Quick Launch Bar
e Other—Use this option to specify a commonly used folder.

e Don't create icons—Choose this option if you do not want to create a shortcut.

Note  Check the Create Icons for All Users check box if you want to create shortcuts for all the users
of a system.

Step11  Click Next. The pre-installation summary is displayed.

Step12 Review the pre-installation summary. If no changes are required, click Install; otherwise, click Previous
to make modifications.

A progress bar displays the installation status. Click Cancel at any time to stop the installation.

When the installation process is complete, a screen indicates whether the installation succeeded or
failed.

Step13  Click Done to exit the installation wizard.
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1.3 Uninstalling Cisco Transport Planner

Step 1

Step 2
Step 3

Step 4

Use the following procedure to uninstall Cisco Transport Planner:

Click the Uninstall CTP icon available at the location selected in Step 10 of the “1.2 Installing Cisco
Transport Planner” section on page 1-16.

The graphical Uninstall CTP wizard is displayed.

Click Uninstall.

A progress bar displays the uninstallation status. Click Cancel at any time to stop the uninstallation.
When the uninstallation process is complete, a screen displays the files that could not be uninstalled.

Click Done to exit the uninstallation wizard.

1.4 Launching the Cisco Transport Planner

Step 1

Step 2
Step 3

Before you start the Cisco Transport Planner (CTP), you need to save the user profiles provided by
Cisco Systems to the profiles folder available at the installation location. Access to CTP features
depends on the user profile you select when you start CTP. The default profile is Base Network Designer.

To launch the CTP, perform the following steps:

Launch Cisco Transport Planner using any of the following options:
¢ Click the CTP icon in the Start > All Programs > CTP menu.
e Double-click the CTP icon in the quick launch bar.
e Double-click the CTP icon on the desktop.
e Browse to the installation folder and double-click the ctp.jar file.

CTP validates the installed Java version in the system. If the installed version is Java 1.6 or Java 1.7, the
CTP login dialog box is displayed.

~

Note If Java 1.6 or Java 1.7 is unavailable, CTP displays the JVM Version Error dialog box that lists
the incompatible Java versions. Install the required Java version from the
http://www.oracle.com/technetwork/java/index.html website. Repeat Step 1.

From the Current selected profile drop-down list, select the user profile.
Click Continue to open the Cisco Transport Planner.

The login profile type appears in the lower-right corner of the CTP window.
The Start Page is displayed (see Figure 1-13).

[ oL-29753-01
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Figure 1-13 Cisco Transport Planner Start Page
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The Start Page provides the following options:
e New—Click to create a new project.
e Open—Click to open an existing project.
e Import Network—Click to import node parameters from a network.
¢ Recent Network Files area—Select an existing project to open it.
Selecting any of the above options opens a new tab.

Step4  Check the Do not show Start Page at startup checkbox to disable viewing the start page when
Cisco Transport Planner is started.

Check View Start Page checkbox under Tools > Option > Graphic > Start Page to enable displaying the
Start Page when launching the CTP.

1.4.1 Opening a Project

Use the following procedure to open an existing Cisco Transport Planner project. To create a new
project, see 2.1 Creating a Project, page 2-1.

Step 1 Click the project name under Open in the Tasks Pane. The project opens. If you do not see the project
name listed, continue with Step 2.

Step2  Click Open in the Start Page, click Open under Project in the Tasks Pane, or in the File menu.
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Step3  In the Open Project dialog box, navigate to the desired folder and choose the project. Click Open. The
Cisco Transport Planner project appears.

Note  You cannot open an existing CTP project in multiple CTP instances. The saved project (MPZ file) is
locked for the use of that CTP. If you try to open the project in another instance of CTP, an error message
is displayed. The .MPZ project file is unlocked and released only after you close the Network.

1.4.2 Loading and Unloading Networks

Each network in a project requires memory. To save memory, when Cisco Transport Planner opens a
project, all networks are in the Unloaded state. An unloaded network appears in the Project Explorer
pane with a “U” next to the network identifier (Figure 1-14). To load an unloaded network, double-click
on the network folder in the Project Explorer pane, or right-click the network and choose Load from the
shortcut menu.

Figure 1-14 Unloaded Network in the Project Explorer pane
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A loaded network appears in the Project Explorer pane with an “L” next to the network identifier
(Figure 1-15). To unload a loaded network, right-click the network icon in the Project Explorer pane and
choose Unload from the shortcut menu.

Note  When you load a network containing an alien interface that is not present in the parts database (DB),
warning messages are displayed.

Figure 1-15 Loaded Network in the Project Explorer pane
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1.4.3 Saving a Project

Use the following procedure to save a project:

Step 1 Choose one of the following:

e To save an existing project with the same filename, choose File > Save. You have completed this
procedure.

¢ To save a new project, choose File > Save and go to Step 2.
e To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step2  In the Save Project dialog box, navigate to the desired folder and enter the filename. Click Save.
Cisco Transport Planner saves projects as zipped files with the MPZ extension.

1.4.4 Closing a Project

Use the following procedure to close a Cisco Transport Planner project:

Step 1 From the File menu, choose Close.
Step2  In the Save Project dialog box, click Yes to save or No to close without saving changes.

Step3  If you clicked Yes and have not previously saved the project, the Save Project dialog box appears. Enter
the name of the project and click Save. The project closes.

Step 4 To exit Cisco Transport Planner, choose Exit from the File menu.

1.4.5 Deleting the CTP Cache

To delete the CTP cache, perform the following steps:

~

Wte CTP must be restarted to delete the CTP cache.

Step1  From the Tools menu, choose Delete Cache. An information message is displayed prompting you to
restart CTP. If you do not want to restart CTP immediately, cache deletion is postponed to the next
restart.

Step2  To close the project, choose File > Close after saving the changes.
Step 3 To exit CTP, choose File > Exit.
Stepd  Restart CTP. A message is displayed prompting you to continue with cache deletion.

Step5  Click Yes to delete the CTP cache or No to postpone cache deletion.
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1.5 Performing Software Updates in CTP

CTP enables you to update the CTP software automatically or manually.

1.5.1 Performing Automatic Software Updates in CTP

Step 1
Step 2

Step 3

~

Note

This section explains how to perform an automatic software update.

When CTP is launched, it checks for the latest software update automatically. If available, the following
dialog box appears: Online Update Available, Would you like to Update CTP? Click Yes.

The Software Update Dialog box appears listing the applicable software updates. Select the required
software update and click Apply.

The Update Successful message appears. Click OK.

The Update dialog box appears every time CTP is launched until the software update is applied.

1.5.2 Performing Manual Software Updates in CTP

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

The software update files have a .upz extension and can be downloaded from the CTP IWE page that is
internal to Cisco. Contents of the update will also be made available in the same location:
http://iwe.cisco.com/web/corbu/optical/ctp

Notification about the software update is sent through email (subscribe to the
mstp_network_design@cisco.com mailer list). The file is hosted on the CTP IWE page and can be
downloaded manually. Customers and Partners do not have access to the Cisco internal CTP IWE page.
Please contact the Cisco Sales/Account team to get the software update files.

This section explains how to perform a manual software update.

In the CTP Help menu, go to Help > Check updates. The update CTP dialog box appears.
Click Browse.
Select the .upz update file and click OK.

The Software Update Dialog box appears listing the applicable software updates. Select the required
software update and click Apply.

The Update Successful message appears. Click OK.
Delete the cache and restart CTP.

1.5.3 Performing Software Update Rollback

CTP allows rollback of software updates. A single rollback moves the CTP software to the previous state
(prior to the software update). For example, if there are two updates applied one by one—Update 1 and
Update 2, after the first rollback, CTP removes Update 2 and retains Update 1. Further rollback(s) are
needed if multiple updates are present.

This section explains how to perform a rollback.

[ oL-29753-01
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Step1  Press R while CTP is launching. The CTP launch is interrupted to perform a software rollback.

Step2  Click Yes to confirm software rollback. The rollback successful dialog box appears.

Note e Delete CTP Cache before and after applying update. Procedures about deleting cache are mentioned
in the CTP Operations Guide. Take a backup of the required files (User preferences, CTP Design
Files (.mpz), NeUpdate File, Alien Files, and so on) before deleting CTP cache.

¢ Automatic Update can be performed only when you are connected to the Cisco network. If you are
not on a Cisco network, try to connect to Cisco VPN first. Otherwise, the software update file should
be manually provided by a Cisco representative and manually updated.

¢ Changes caused by the software update is applicable even if the CTP Cache is deleted after the
update. To remove an update, follow the rollback procedure mentioned in the previous section.

e Multiple rollbacks are not supported in this release. Re-install CTP if required.

e In the Java Control Panel, set the Java security to medium and mention the CTP installation
directory in the Exception Site List (if there are issues with the rollback). If the screen is
unresponsive, end CTP process and restart CTP.

e For MAC, force quit the process and restart CTP (if there are issues with the rollback).

e After uninstallation, delete all the files under the directory where CTP is installed manually.
— Default location on Windows OS: C:\Program Files\Cisco\CTP10.1.
— Default location on Mac OS: Applications/CiscoCTP10.1.0.

1.6 Setting Cisco Transport Planner Options

Cisco Transport Planner provides numerous options for customizing the tool and the design.

~

Note  The following procedures for setting options using the Tools menu apply to new projects during project
creation. To change an existing (open) project, click the desired item in the Project Explorer pane
Subnets folder and edit the parameter in the Properties pane.

1.6.1 Setting the Graphical Display

Use the following procedure to set the Cisco Transport Planner graphical display:

Step 1 From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box, right-click the Graphic folder and choose Expand from the shortcut
menu.

Step3  Click Chart Panel and complete the following:

¢ In the Colors area, to change the colors of Border Paint, Background Paint, Line Paint, Plot
Background Paint, and Plot Outline Paint, click the relevant fields in the Colors list, and click the
drop-down arrow to display a color swatch popup window. Then, click the desired color.
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Step 5

Step 6

Step 7

Setting Cisco Transport Planner Options

In the Strokes area, to change the strokes of Border Stroke, Outline Stroke, and Default Line Stroke,
click the relevant fields in the Strokes list, and click the drop-down arrow. Then click the desired
stroke.

In the Font area, click the Font drop-down box to display a font popup window. Then select the
desired Font, Size and Style.

In the Alfa area, enter numeric values for Background Alfa and Foreground Alfa.
In the Shapes area, click the Line Shape drop-down box. Then click the desired line shape.

In the Gridlines area, check the Range Gridlines and Domain Gridlines check boxes to view the
gridlines for the same.

To change the color scheme for Cisco Transport Planner, click Look & Feel and choose the desired
scheme from the drop-down list.

To enable displaying the Start Page when launching Cisco Transport Planner, check the
View Start Page checkbox.

To change the appearance of the Project Explorer tree, click Project Explorer and complete the
following tasks as needed:

Overlapping—Check to reorder sites for a selected network.

Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or choose
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children.

Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the
bottom right of each locked item in the Project Explorer pane.

Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top
right of each alarmed item in the Project Explorer pane. The alarm icon will be green, yellow,
orange, or red to indicate the alarm severity.

To change the NtView Name tab appearance, click Network View and complete the following tasks as
needed:

In the Site area, complete the following tasks:

- Site Color—To set the default site color when no forcing is done, click the drop-down arrow to
display a color swatch popup window. Click the desired color.

— Site Selection Color, and Highlight Color—To change the site colors, click in the Color,
Selection Color, and/or Highlight Color fields in the Site list. Click the drop-down arrow to
display a color swatch popup window. Click the desired color.

— Show Name—Check to display the site name on the NtView Name tab.

— Pass Through, OSC, Add/Drop, Hub, Gain equalizer, R-OADM, Line Amplifier, OXC, OIC,
Background Amplified Color, Background Raman Amplified Span Color—To change the
colors, click in the relevant fields in the Site list. Click the drop-down arrow to display a color
swatch popup window. Click the desired color.

— Show Amplifiers—Check to display the amplifier icon for a site on the NtView Name tab.

— Show Raman Amplified Span—Check to display the Raman amplified span on the NtView
Name tab.

In the Fiber area, complete the following tasks, as needed.
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— True wave Reach Color, Dispersion Shifted Color, Metro Core Color, true wave, True Wave Plus
Color, True Wave Minus Color, True wave Classic Color, Free Light Color, LS Color, Tera Light
Color, E LEAF Color, TRUE WAVE RS Color, G 652 SMF Color, and Selection Color—To
change the fiber color, click in the relevant fields in the Fiber list and then click the drop-down
arrow.

- Show Name—Check to display the fiber name on the NtView Name tab.

- Show Length—Check to display the fiber length on the NtView Name tab.

— Show total SOL Loss—Check to display start of life (SOL) loss on the NtView Name tab.
— Show total EOL Loss—Check to display end of life (EOL) loss on the NtView Name tab.

— Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtView Name
tab.

— Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtView Name
tab.

The duct details displayed in the NtView Name tab is shown in Figure 1-16.

Figure 1-16 Duct Details Shown on the NtView Name Tab
Duct Name [1.0Km] SOL[D.25] EOL[0.25] GD-C[16.7] C0-L[19.03]
(1= R e e Site2 o

~

In the Wavelength Usage (%) area, complete the following tasks, as needed.

The ducts in a network carry a predefined number of wavelengths (2, 4, 8, 16, 32, 64, or 80).
Wavelength usage is the percentage of wavelength used by these ducts.

The percentage of wavelength used in individual ducts are displayed in various colors. Use the
Wavelength Usage (%)option to assign any one of the four predefined colors to the different
percentage of wavelength used. The custom values remain until the cache is deleted. After the cache
is deleted, CTP populates the following default values:

Green—25%
Yellow—50%
Orange—75%
Red—100%

For example, the wavelength usage in an 80 wavelength duct that uses 40 wavelengths is 50%. This
duct is displayed in yellow.

The valid values range from 1 to 100. If you enter a value greater than 100, it is considered as 100,
negative value is considered as 1, while 0 is ignored.

The ducts that do not carry any wavelength are displayed in grey.

Note  The Wavelength Usage (%) option is not supported on remote spur ducts.

For more information on wavelength usage, see Table A-1.
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e To change the color of the traffic demands on the NtView Name tab, in the Point To Point, P-Ring,
and Any To Any areas, click in the Color and Selection Color fields, and then click on the drop-down
arrow to display a color swatch popup window. Click the desired color.

Step8  To change the Network Mgmt Tree tab appearance, complete the following tasks as needed:

e In the Network area, click in the Color and Selection fields. Click the drop-down arrow to display a
color swatch popup window. Click the desired color.

e In the Link area, complete the following tasks:

— To change the link color, click the Color field in the Link list and then click the drop-down
arrow. Choose the desired line width from the drop-down list.

— To change the link appearance, click the Stroke field in the Link list and then click the
drop-down arrow. Choose the desired line appearance from the drop-down list.

Step9  To change the layout appearance, click Layout View and complete the following tasks as needed:

¢ In the General area, click in the Background and Selection Color fields. Click the drop-down arrow
to display a color swatch popup window. Click the desired color.

¢ In the Any/Present View area, complete the following tasks:

— To change the color for Foreground, Locked & Unlocked View, Locked Elements Background,
and Locked Elements Foreground, click the relevant field and click the drop-down arrow to
display a color swatch popup window. Click the desired color.

¢ In the Alarmed View area, complete the following tasks:

— To change the color for Unalarmed Elements Background, Unalarmed Elements Foreground,
and Alarmed Elements, click the relevant field and click the drop-down arrow to display a color
swatch popup window. Click the desired color.

Step10 Click Ok.

1.6.2 Setting the Default Software Release

Use the following procedure to set the default software release for CTP. This release will be used as the
default software release when creating a project. See 2.1 Creating a Project, page 2-1.

Step 1 From the Tools menu, choose Options.
Step2  In the Options Explorer dialog box click General.

Step3  In the column on the right, click the Default CTP Software Release option.
A drop-down list appears.

Step4  Click an option in the list to choose the software release.

Step5  Click Ok.
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1.6.3 Setting the Default Platform Values

Use the following procedure to establish the default traffic mapping, dense wavelength division
multiplexing (DWDM) design, and default layout settings for a particular platform and system release.
The default settings will appear during project creation. All the options that you specify can be changed
after project creation on a per-span basis.

Step1  From the Tools menu, choose Options.
Step2  In the Options Explorer dialog box, right-click Platform and choose Expand from the shortcut menu.
Step3  Click the desired System Release folder and complete the following tasks as needed:

~

Note  Default changes apply only to the specified system release.

For Software Releases 9.0, 9.1, 9.2, 9.2.1, 9.3, 9.4, 9.6.0.3, 9.8, 10.0, and 10.1, choose the required
settings:

e Shelf Management—The options available are Auto, Multi Shelf Integrated Switch, Multi Shelf
External Switch, and Individual Shelf. These options allow you to specify the type of management
to be used for the sites on the network.

Select Auto to set the default option of Multi Shelf Switch for all the nodes with more than one shelf.
Select Multi Shelf Integrated Switch to configure all the Multiservice Transport Platform (MSTP)
optical units (OADMs and amplifiers) in different shelves connected through a LAN. The LAN is
implemented with switches plugged into the MSTP shelves.

Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and
amplifiers) in different shelves connected through a LAN. The LAN is implemented with switches
external to the MSTP shelves. For this option, two external Ethernet switch units

(Cisco Catalyst 2950 and Cisco Catalyst 3650) are used to support the multishelf configuration.
Cisco Catalyst 2950 supports 12 subtending shelves and Cisco Catalyst 3650 supports

24 subtending shelves. CTP supports a maximum of 50 shelves, including the node controller shelf,
in a multishelf configuration when the TNC, TNCE, TSC, TSCE, or TCC3 card is used as the node
controller. CTP supports a maximum of 5 shelves, including the node controller shelf, in a
multishelf configuration when TCC2P card is used as the node controller.

A

Note  When the Multi Shelf External Switch is forced, the multishelf external switch is placed in
the layout irrespective of the node controller.

S
Note  The Cisco ONS 15454 M6 (M6) chassis, when used as a node controller with the Multi Shelf
External Switch, can support only two subtended shelves.
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Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the
same shelf.

S
Note  Shelf management is disabled for HYBRID 15454 ONS configuration in Release 9.1 and
later.

~

Note M6 chassis, when used as node controller, can support three subtended shelves, the
subtended M6 chassis can subtend two more shelves.

Node Protection—The options available are Same Shelf, Separated Shelves, and Node Split.
Select Same Shelf to configure the optical units (amplifiers and OADM) on side A (CW direction)
and side B (CCW direction) in the same shelf.

~

Note  Node protection is disabled for HYBRID 15454 ONS configuration in Release 9.1 and later.

Select Separated Shelves to configure the optical units (amplifiers and OADM) on side A (CW
direction) in one shelf and those on side B (CCW direction) in a second shelf.

C-band Rules—Select the options from the drop-down list. The options appear in the following
format: C 64 Chs 50 GHz (+2 dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and
8; the reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 dBm, 5
dBm, 7 dBm and 8 dBm; and the spacing options available are 100 GHz and 50 GHz. You can use
even wavelengths for 80, 72, and 64 channel design.

For HYBRID 15454 ONS configuration, the available options are 8, 16, 20, 32, 40, 48, 64, 72, 80,
and 96 channels.

L-band Rules— Select the options from the drop-down list. The options appear in the following format:
32 Ch. 100 Ghz +5 dBm. The options available are: None, Expand, and channels available are 32; the
reference per channel power options available are 2 dBm and 5 dBm; and the only spacing options
available is 100 GHz.

Select Expand to indicate that the L-band rules are upgradable.

~

Note L-band is not applicable to HYBRID 15454 ONS configuration in Release 9.1 and later.

Installation w/o CTP—Check this check box to install the network with default parameters. If you
choose this option, CTP designs the network according to a set of predefined conditions, so that the
selected node can be installed without the Cisco Transport Planner configuration files (thresholds
and setpoints).

Dithering Lower Limit—Enter a value that satisfies the following conditions:
- Not lower than zero
— Not higher than 32
— Not higher than the dithering upper-limit value

The dithering value is the site identifier that CTP uses to adjust power on 80-WXC cards. Dithering
value is provided only for sites with 40-WXC cards, that is, for sites with multidegree site structure
and with the functionality “OXC” or “Auto”. This parameter is not displayed for non-OXC sites.

Dithering Upper Limit—Enter a value that is not lower than zero and not higher than 32.
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e Insulators—Check this check box to protect the Express Add/Drop (EAD) colorless ports of the
80-WXC-C cards configured as demux units.

S,
Note The Cisco ONS 15216-FLD-2-ISO optical insulator is not supported in CTP Releases 9.3
and later releases.

~

Note  Optical insulator connections are displayed only in the Patchcord Installation tab in the
Internal Connections report.

e Structure—Choose the site structure from this drop-down list. If the network topology does not
support the selected site structure, then the selection made in this drop-down list is ignored.

¢ MSM External Switch—Choose the multi shelf external switch type, from the drop-down list.

e Use Payg—Check this check box to enable the Pay As You Grow feature. For more information
about the Pay As You Grow feature, see the “1.8 Understanding the Pay As You Grow Feature”
section on page 1-43.

e Service Level—Choose the service level from the drop-down list.

e Service Level Num of Years—Choose the maintenance service level length (in years), from the
drop-down list.

e Enable NCS—Check this check box to use NCS PIDs. For more information, see Table 2-3NCS
PIDs, page 2-9.

¢ Redundant Power—This drop-down list enables you to choose whether the redundant power supply
is to be added.

e UTS AC Power Cables—Choose the type of cables to be used for the AC power supply, from the
drop-down list. Cables are listed based on the country type.

e Filler Card Type—Choose the type of card to be placed in the empty slots of a chassis, from the
drop-down list. The options available are:

— Blank—CTP places only blank cards.

— UTS Filler—CTP places blank cards in M12 chassis and Universal Transport System (UTS)
filler cards in the M2 and M6 chassis. The two type of UTS filler cards placed by CTP are
15454-M-T-FILLER (in TNC and TSC card slots) and 15454-M-FILLER (in other slots).

¢ Node Controller—Choose a chassis to act as the node controller, from the drop-down list.
e M6 Chassis in Use—Enter an integer value for the number of M6 chassis to be used.
e MI12 Chassis in Use—Enter an integer value for the number of M12 chassis to be used.

¢ Redundant Controller Card—This drop-down list enables you to choose whether to use a redundant
controller card.

e Side/Side cabling—Choose the loss value between the west and east side of the site, from the
drop-down list. It is useful in case of multi shelf node protection when the racks are not located close
to each other.

e Anti ASE— The options available in the drop-down list are:

— Auto—CTP decides if the site should be configured as anti-amplified spontaneous emissions
(anti-ASE).

— Yes—The site is configured such that all the express channels on the site are optically dropped
and reinserted. In addition, all the patch cords between the West and East sections are removed.
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— No—The site is not configured as anti-ASE.

Click the Layout folder and complete the following settings as required:

a~

Note

OSMINE Compliant—Check this check box to instruct CTP to ensure that all the sites placing
transponder and line cards are compliant with OSMINE.

OSMINE is supported in R9.2.1 and R9.6.0.x only.

Hybrid Node—Check this check box to notify CTP to ensure that cross-connect, SDH, and SONET
cards are not placed within the optical transport section (OTS) shelf.

Max Num of Shelves—Specify the maximum number of shelves per rack. The maximum number of
shelves you can specify is 4.

Fan Tray—Select the type of fan tray to be placed within each node, from the drop-down list.

AIC—Choose Yes from the drop-down list to instruct CTP to put the AIC card in slot 9 of the first
shelf in each site.

Fiber Storage—Choose Yes from the drop-down list to instruct CTP to put the fiber storage within
the rack below the optical shelf.

Y-Cable—The the Y-cable options from the drop-down list. The options available are:
— Auto—Instructs CTP to set the default value for the Y-Cable option.

— 1RU FlexLayer Shelf Assembly—Instructs CTP to use the ONS 15216 Splitter/Combiner
FlexLayer modules to implement the required Y-cable protections.

— 2RU Y-Cable Panel—Instructs CTP to use the new ADC Splitter/Combiner modules to
implement the required Y-cable protections.

TXP/MXP/XP in OTS—The options in the drop-down list enable you to choose whether to place
client cards in OTS shelves.

Etsi Rack Width—Choose the ETSI rack width from the drop-down list. The 19 inches option adds
15454E-191EC-KIT for each ETSI shelf.

Rack Height in RU—Enter an integer value for the rack height. The default option is Auto, which
assigns 44 rack units (RU) for ANSI and 40 RUs for ETSI.

Alien Shelf Height—Enter the height of the alien shelves in RU. If the alien shelf height is greater
than the rack height, alien shelves will not be added to the site, and an error message will be
displayed in the summary report.

Number of Alien Shelves—Enter the number of alien shelves that are to be added to the site.

Number of alien shelves can vary based on the alien shelf height. Maximum number of alien shelves
that can be added is 600, if the alien shelf height is 1 Rack Unit (RU) and there are no other shelves
in the layout.

The maximum number of racks supported for a site is 15. If the addition of alien shelves require
more than 15 racks, an error message will be displayed in the summary report and the layout is not
built for the site.

Alien Shelf Name—Enter the name of the alien shelves that are added to the site. This name will be
displayed in the Layout reports.

Populate Shelves From Bottom—Check this check box to notify CTP to place the shelves in the rack
starting from the bottom. This is useful in installing shelves in tall racks. For more information about
the order in which CTP fills the rack, see the “4.16.1 General Placement Rules” section on

page 4-76.
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Step 5

Chassis Type—Choose the type of chassis from the drop-down list. The options available are Auto,
M12 Chassis, M6 Chassis, and M2 Chassis. The default option is Auto, which selects combinations
of the chassis in an optimized manner.

Power Supply—Choose the type of power supply from the drop-down list. The options available are
Auto, AC Power, AC2 Power, DC Power, DC20 Power, and DC40 Power. From release 10.1, the
default option is Auto (DC40). However, AC2 Power is not applicable to the M2 Shelf.

~

Note The AC2 power cables are present in the BoM only when AC2 Power and Auto or
AC2 Power and Data Center options are selected in the Power Supply and UTS AC Power
Cables sections respectively.

TCC Type (Release 9.4 and later releases)—Choose the type of TCC card from the drop-down list.
The options available are Auto, TCC2P, and TCC3. The default option is Auto, which selects the
TCC3 card.

~

Note  When used as the node controller, the M12 chassis with TCC2P cards cannot subtend the
M6 chassis.

M6/M2 Controller Type—Choose the type of controller card from the drop-down list. The options
available are Auto, TNC/TSC, and TNC-E/TSC-E. The default option is Auto, which selects the
TNC-E/TSC-E card.

S

Note  You can select a different M2/M6 controller type for a network in the release upgrade or
upgrade state by unlocking the TSCE/TSC or TNCE/TNC card in the site layout.

DCC Shelves Management—Check this check box to notify CTP to reserve Slot 12 for equipping
15454-MR-L1 units to implement data communication channel (DCC) shelf management.

Door—Choose the type of door from the drop-down list. The default option is Auto, which does not
add any door type. Door and deep doors are two types of front doors that act as protective panels in
the ONS 15454 M2 and ONS 15454 M6 chassis. The deep door provides additional space in front
of the shelf to accommodate cables that do not fit inside the standard door.

M12 Shelves—Enter an integer value for the number of empty M 12 shelves to be added to the node
layout. CTP supports a maximum of 29 extra M12 shelves. The default option is Auto, which does
not add any shelves.

M6 Shelves—Enter an integer value for the number of empty M6 shelves to be added to the node
layout. CTP supports a maximum of 29 extra M6 shelves. The default option is Auto, which does
not add any shelves.

M2 Shelves—Enter an integer value for the number of empty M2 shelves to be added to the node
layout. The default option is Auto, which does not add any shelves.

The above values are applied to all the sites in the newly created network. The values can be
modified for individual sites after the network creation.

Click the Restricted Equipment folder. To restrict a unit, check the corresponding check box in the
Restricted column for that unit.

To change the setting back to unrestricted, uncheck the check box. To apply restricted list changes to an
open project, complete the following:
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Right-click the folder for the network that you want to update and choose Expand from the shortcut
menu.

Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project
Explorer pane and choose Edit List from the shortcut menu. The Restricted Equipment list for
MSTP 454 DWDM [Release Number] dialog box appears.

Click Update. The modified Restricted Equipment List is replaced with the global restricted
equipment List.

Click OK to close the dialog box.

Click the Fiber Options folder and specify the fiber parameters as required:

Span Label Tag—Enter the desired span label; the default label is Duct.

Span Length—Enter the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

~

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields.

Connector loss [dB]—Enter the concentrated loss at the end of the span.

Length Based Loss—If checked, the fiber loss is determined by multiplying the Span Length by the
Loss Factor. If this check box is unchecked, you must enter the total loss of the span.

Tot SOL loss w/o conn [dB]—Enter the total start of life (SOL) link fiber loss value for each span,
excluding the connector concentrated loss. This value is applicable only if the Length Based Loss
check box is unchecked.

DCN Extension (With Software R8.0 and later releases)—Check this check box to enable the default
use of data connection network (DCN) extension on each span in the project. This setting implies
that the OSC channel is not used to connect the two nodes. This default can be overridden on the
network wizard pane.

Use one of the following formulas to calculate the fiber loss at SOL:

SOL = km * dB/km + (2 * connector loss)

SOL = user entered loss + (2 * connector loss)

Use one of the following formulas to calculate the fiber loss at EOL:

EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss, or
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

Select the Fiber Type of each span of the network. You can specify a fiber type even if the fiber type
is not supported for the design.

PMD at Fiber—Enter the polarization mode dispersion (PMD) value. PMD is always entered in
ps/nm/km.

Loss—Enter the value of the SOL fiber loss per kilometer used to calculate the loss of each span in
the network. The fiber loss factor is always entered in dB/km.

Click the Traffic Mapping folder and complete the following tasks as needed.
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¢ In the Fixed traffic area, choose the unprotected routing strategy from the drop-down list:

- Auto— CTP automatically selects the minimum number of channels that can be deployed
among the nodes of the traffic group.

— Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers.

— Unprotected minimum hop count—Each node pair in the traffic group is connected by one
connection. The unprotected minimum hop count minimizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic group.

¢ In the General area, complete the following tasks as needed.

— Force Mesh Algorithm—For CTP Software Release 8.5, check this check box to force the mesh
algorithm.

— Allow Different Wavelengths—Check this check box to allow different wavelengths to be used
for regeneration.

— Coloring Priority Option—Check this check box to assign the wavelength from the left side of
the available band, that is, from 1528.7 nm. If this option is unchecked, the wavelength is
assigned from the right side of the available band, that is, from 1566.7 nm.

- Flat Grid Filling Option—Check this check box to assign the wavelength in a flat grid,
allocating each free wavelength without any guard band. If this option is unchecked, the
wavelength is assigned according to the actual assignment rules.

~

Note  Guard band is an unused part of the wavelength spectrum, for the purpose of preventing
interference between the wavelength channels.

— Maximum Separation Option—Check this check box to assign the wavelengths for 40 G and
100 G CP-DQPSK service types from the first wavelength in the C-band (1528.7 nm) and for
other service types from the last wavelength of the C-band (1566.7 nm) to overcome
interference in demands where the wavelength selection is set to Auto.

- Activate AR-XPE—Check this check box to use the AR-XPE card in the network. When this
option is checked, the AR-XP card is replaced by the AR-XPE card in the exported BoM report.
The AR-XPE card does not support the client PAYG license. When the Activate AR-XPE check
box is checked, uncheck the Use Client Payg check box in the Properties pane to avoid error
during network analysis.

Step8  Click the DWDM Design Rules folder and complete the following tasks as needed:

¢ OSNR Alarm For Regeneration—Check this check box to define the
optical signal-to-noise ratio (OSNR) alarm severity. When this limit is reached, CTP suggests a
channel at an appropriate site on the network. After the network is designed and analyzed, in the
Tasks pane (under Reports), click Optical Results to see if any site requires regeneration. The
regeneration column will suggest the site where Regeneration is required.

¢ Run Quick Analysis—Check this check box to use a quick but less accurate algorithm to analyze the
network in a short time. After the analysis, Cisco Transport Planner displays the following warning
message: “Dcu design not optimized due to Run Quick Analysis option.”

¢ No-Tilt-Network-Design—Check this check box to force Cisco Transport Planner to operate the
amplifiers inside the gain range where no tilt is generated and to determine the type and number of
amplifiers in each site of the network accordingly. This option sets all the intermediary points of the
network so that channels are always at the reference power level. The default value is Disabled.
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S

Note Long spans (with insertion loss greater than 25 dB) might not be supportable.

No In-line Bulk Attenuator Design—Check this check box to design the network without using any
inline bulk attenuators. If the network cannot be designed without using external in-line attenuators,
Cisco Transport Planner displays the following error message: “Unfeasible Network design. Site X
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attenuators.”

No TXT/Line-Card Bulk Attenuator Design—Check this check box to design the network without
using any external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients
require Rx bulk attenuators, then the related channel is shown with the working condition (flagged
red, orange, or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical
Channel Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.

Prevent Use of E-LEAF Dispersion Compensation Unit on E-LEAF Dispersion spans—Check this
check box to prevent Cisco Transport Planner from using Extended -Large Effective area fiber
(E-LEAF) dispersion compensation units (DCUs) on E-LEAF spans for the overall network. Leave
unchecked if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

No DCU Design—Check this check box to avoid automatic placement of DCU units.

Max Scalability Placement —Check this check box to scale up or expand the network made in your
network design. You can add new sites and demands depending on your requirements, thus, CTC
automatically creates the flexibility of the possible expansion of your network. It also checks to
force the CTP to choose an EDFA/DCU placement that is best suited for future expansion of the
designed network without any hardware changes.

TDCU—From the drop-down list, select one of options to place the TDCU units (TDCU Coarse and
TDCU Fine) in the network are:

— Auto—Places the fixed DCU units in the network.
— All Positions—Places the TDCU units wherever the fixed DCU units can be placed.
— Never Place—Does not place the TDCU units in the network.

— Selected Positions—Places the TDCU units in ROADM, WXC, and Dynamic Gain Equalizer
(DGE) nodes.

FDCU—From the drop-down list, select one of the options to place the FDCU units in the network.

— Auto—Places standard DCUs in the network, automatically. The FDCU option can be set to
“Always” at the network level for a specific network. FDCU units can also be forced on specific
nodes in the network.

— Always—Places the FDCU units in the network. The FDCU option for new networks is set to
“Always”. Standard DCUs are placed if FDCU units are not available. Standard DCU units can
also be forced on specific nodes in the network.

Turbo Simplex—Check to achieve faster results by optimizing a subset of the total channels based
on type and path rather than optimizing every channel. Unchecking this option can result in longer
analysis times for large networks, especially with any-to-any ROADM traffic.

Max Sc Value—Enables you to enter the maximum slope compensation value.

Enable Connector Loss—Check this check box to apply the default connector loss values to the
fiber. The applied value depends on the type of site where the fiber is connected:

Pass through Connector Loss—Enter the connector loss value for a pass-through site.
OXC Connector Loss—Enter the connector loss value for an OXC site.

ROADM Connector Loss—Enter the connector loss value for a ROADM site.
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OSC Connector Loss—Enter the connector loss value for an OSC site.

Line Amplifier Connector Loss—Enter the connector loss value for a line amplifier site.

The Pass through Connector Loss, OXC Connector Loss, ROADM Connector Loss, OSC
Connector Loss, and Line Amplifier Connector Loss properties are enabled only if the Enable
Connector Loss check box is checked.

The values of these properties can also be specified in the Properties pane for the
Options>DWDM Design Rules>System Release option in the Project Explorer pane and are
applicable to the current network.

Step9  Click OK.

1.6.4 Setting the

Use

Default Project Values

the following procedure to set the default project settings and repair time. These defaults will appear

during project creation.

Step 1 From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box, click Project and complete the following tasks to set the defaults

that

Step3  Clic

appear in the Project Creation wizard:
Customer—Enter the default customer name (128-character maximum).
Created by—Enter the default user name (128-character maximum).

Measurement Units—Choose the default span length unit of measure from the drop-down list, either
Km or Miles.

Price List—Choose the default price list.
Restricted Analysis—Check to use Restricted Analysis in the project.

ANSI/ETSI—Choose either ANSI (American National Standards Institute) or ETSI (European
Telecommunications Standards Institute) from the drop-down list.

k General and complete the following tasks:

MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This value will
apply to every site in the network. If you change the MTTR value after creating sites, the new value
will only apply to sites you create after the change.

Restocking Time (days)—Enter the number of days required (including transportation time) to
restock the units into the maintenance center.

Confidence Level (%)—Choose the confidence level for finding the spare units in the maintenance
center (50, 75, 95, or 99 percent).

Default CTP Software Release—Choose a release to be set as the default CTP software release. This
release will be used as the default release when creating a project. See 2.1 Creating a Project,
page 2-1.

Step4  Click BoM and complete the following:
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e Use Bundles—(Multishelf configuration only) Check this check box to use the Multishelf
Management Integrated Kit bundle when generating the BoM instead of the single items. As a
bundle, a common price is quoted, which is lesser than when the items are listed individually.

¢ Use Global Discount—Check this check box to allow you to edit the discount box (Global
Discount).

¢ Global Discount—Enter the global discount to be applied to the whole BoM.

e Use Client Payg—Check this check box to include license for client cards. This option is applicable
to AR-MXP, AR-XP, 100G-LC-C, 100G-CK-LC-C and 10X10G-LC cards. This check box is
checked by default.

e Enable NCS—Check this check box to use NCS PIDs. For more information, see Table 2-3NCS
PIDs, page 2-9.

¢ Include SW License(s)—This check box is checked by default. The software license for the release
is shipped with the Cisco ONS 15454 chassis.

e Include Paper Documentation—Check this check box to ship paper documentation separately with
the product and listed in BoM.

¢ Include CD Documentation—Check this check box to ship CD documentation separately with the
product and listed in BoM.

e Hide BoM price/discount—Check this check box to hide the BoM discount and the individual unit
price. Only the final price is displayed.

e  WSON PID—Check this check box to display the WSON PIDs in the BoM report.
¢ Service Level—Choose the service level from the drop-down list.

e Service Level Num of Years—Choose the maintenance service level length (in years) from the
drop-down list.

Click OK.

1.6.5 Defining Third-Party DWDM Interfaces

Note

Step 1

Cisco Transport Planner allows you to define a third-party DWDM interface to be used in project
creation. After you define third-party DWDM interfaces, you can choose them when creating traffic
demands. For more information on defining third-party interfaces, see Appendix D, “Third-Party
DWDM Wavelength Interface Model.”

If you create a network design with a third-party interface and need to share the design with other users,
you must provide not only the saved network MPZ file but also the exported database file containing the
third-party interface definition. To view this project, the other user first must import the database with
the third-party interface values.

Use the following procedure to define a third-party DWDM interface:

Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.
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Step 2
Step 3

Step 4

Step 5
Step 6

Step 7
Step 8

Step 9

Step 10

Step 11
Step 12

Step 13
Step 14

Step 15

~

Note  You cannot open the DB Parts Manager if a project is open or if you are using the Base Network
Designer profile.

Right-click Platform Parts and choose Expand from the shortcut menu.

Right-click Group and choose New Group from the shortcut menu. The new group appears under Group
and in each system release under parts DB.

In the Group Editor dialog box, complete the following information:
¢ Name of group—Enter the name of the new database.
¢ Note—(Optional) Enter a description of the group.
In the parts DB for the desired system release, click the group that you created.

In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from
the shortcut menu. A new row appears on the Parts tab for the client hardware.

Double-click the row to open the Alien dialog box.

In the General tab of the Alien dialog box, type the name of the card in the Name field and the enter the
Label name.

Click the Istance tab and complete the following:

¢ Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible
for this third-party interface with ANSI PID completed, the third-party interface is included in the
BoM with the related product identifier.

e Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM
with the related product identifier.

e TAG—(Display only) For internal use.
e SYS. NAME ANSI—Not applicable for third-party interfaces.
e SYS. NAME ETSI—Not applicable for third-party interfaces.

¢ WL START—Choose the wavelength starting range that the third-party interface supports from the
drop-down list.

e WL END—Choose the wavelength ending range that the third-party interface supports from the
drop-down list.

Click the Physical Ports tab and in the Label column, type a label for each port.
The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.
Click Ok.

In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien
from the shortcut menu. A new row appears on the Parts tab for the client software.

Double-click the row to open the AlienSoft dialog box.

In the General tab, complete the following:
¢ Name—Enter the name in the Name field.
e Related Item—Choose the client card that you created in Step 7 to Step 11.

Click any of the following depending on the client card that you choose and proceed to Step 16:
e Default - OCh tab (Figure 1-17)
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e DPSK-OCh tab
e QPSK-OCh tab

Figure 1-17 AlienSoft Dialog Box, Default-OCH Tab
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Step16 Complete the following (see Tables 1-2 through 1-4 for supported value combinations):
e In the Rules area, choose the C-band or L-band design rule from the Design Rule drop-down list.
e In the Technology area, complete the following:
— Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary.

— Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser), or
EML (Electro-absorption Modulated Laser).

— Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).
For DPSK—Choose the Receiver Threshold as Optimal.
For QPSK—Choose the Receiver Threshold as Average.

- Regeneration Type—Choose 3R or 2R regeneration mode.

- FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).
For DPSK or QPSK, set the FEC Mode to E-FEC.

— Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are
12.5, 25, 50, or 100 pm.

¢ Bit Rate—Choose the desired bit rate from the drop-down list. For DPSK or QPSK, choose the Bit
Rate as 40 Gb/s.
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e In the TX Power Range area, complete the following:
- TX Max Power—Enter the maximum power output level (dBm).
- TX Min Power—Enter the minimum power output level (dBm).

¢ In the Back to Back Receiver Sensitivity area, complete the following as needed to define the
working interface area for Back to Back. Back to Back is a configuration where the receiver is placed
in front of the transmitter and no other equipment exists between the two. Back to Back is used to
measure characteristics of the TX and RX pair. Figure 1-18 shows the interface operative area.

— Opverload Power [ps/nm]—Enter the overload power level.
— OL_Power [dBm]—Enter the minimum power level in the OSNR-limited range.

— OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range
(measured in 0.5 increments).

- PL_Power [dBm]—Enter the minimum power level in the power-limited range.

- PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNR-limited range
(measured on 0.5 nm bandwidth).

¢ In the Chromatic Dispersion area, complete the following as needed:

— Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

— CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0 dB, 1 dB, 1.5 dB,
2 dB, or 3 dB.

e Customize Penalties—Check to enable the Gaussian cross-talk Penalties, Single-Interfering
Cross-Talk Penalties, and Scale Q factors fields as needed.

e If Customize Penalties is checked, enter the values to determine the Gaussian cross-talk Penalties in
the A_GXt and B_GXt fields, as needed. Gaussian cross talk refers to random power that interferes
with a signal. The A_GXt and B_GXt values are the coefficients for the exponential curves that
estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and OSNR-penalty (OL) for
Gaussion cross-talk levels in the OL and PL regions of the interface model with dispersion margins
added (see Figure 1-18). The formula is Penalty (GXt) = A_GXt * exp(B_GXt *GXt).

e If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the
exponential curves that estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and
OSNR-penalty (OL) for single-interfering cross-talk in the OL and PL regions of the interface model
with dispersion margins added (see Figure 1-18). The formula is Penalty (IXt) = A_SIXt*
exp(B_SIXt* IXt).

e If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER
increase could be recovered with an increase of OSNR, power, or both (depending in which
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR
and one in power) for each working point OL and PL of the interface model (see Figure 1-18). The
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER
increase) into power and OSNR penalties. The formulas follow:

— P-penalty(PL) = Q-penalty * F-P(PL)
— P-penalty(OL) = Q-penalty * F-P(OL)
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— OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)
- OSNR-penalty(OL) = Q-penalty * F-OSNR(OL)

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL)
are evaluated in the OL working region of the curve with the dispersion margins added.

Figure 1-18 Interface Operative Area
A
Overload
Power
o)
e
o
Keo]
e}
2
£
—_ r:l: .
nE: c% Working Area
21 o
)
=
<)
[
oL
PL Power - limited border
OSNR [dB] )

Step17 Click Ok.
Table 1-2 lists the supported combinations for 40-Gbps third party interfaces.

Table 1-2 Supported Combination for 40-Gbps Third-Party Interface

> Chromatic Dispersion Penalties [dBm]
Modulation RX Stability | P-penalty OSNR- P-penalty OSNR-
Format TX Type Threshold |FEC [pm] (oL) penalty (OL) |(PL) penalty (PL)
Duo Binary |MZ Optimal E-FEC +12 0 1 0 1

Table 1-3 lists the supported combinations for 10-Gbps third party interfaces.
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Table 1-3 Supported Combinations for 10-Gbps Third-Party Interface
™ Chromatic Dispersion Penalties [dBm]
Modulation RX Stability | P-penalty OSNR- OSNR-
Format TX Type Threshold |FEC [pm] (oL) penalty (OL) |P-penalty(PL) |penalty (PL)
NRZ Mz Optimal E-FEC + 25 0 2 1 0
NRZ MZ Optimal FEC + 25 0 1.5 1 0
NRZ MZ Average no FEC +25 2 0 2 0
NRZ EML Average no FEC + 100 0 3 3 0

Table 1-4 lists the supported combinations for 2.5-Gbps third party interfaces.

Table 1-4 Supported Combinations for 2.5-Gbps Third-Party Interface
> Chromatic Dispersion Penalties [dBm]
Modulation RX Stability |P-penalty OSNR- P-penalty OSNR-
Format TX Type Threshold |FEC [pm] (oL) penalty (OL) |(PL) penalty (PL)
NRZ DML Average FEC +25 0 2 2 0
NRZ DML Average no FEC +25 0 2 2 0
NRZ DML Average no FEC +25 3 0 3 0
NRZ DML Average no FEC + 25 3 3 3 3
NRZ EML Average no FEC +25 0 2 2 0
NRZ DML Average no FEC + 100 0 3 3 0

1.6.6 Exporting User Options, Price Lists or Alien Definitions

Use the following procedure to export user options, price lists, maintenance contracts, and the parts
database files. The export command creates a ZIP file that includes all of the created files.

Step 1 From the Tools menu, choose Export. The Export dialog box appears.

Step2  In the Export dialog box, enter a file path and name in the file name field. To export to an existing file,
click the ... button and navigate to the desired folder and file. Click Select to choose the file.

Step3  To select the items to export, complete the following as needed:
e User Option—Check to export the user options set using the Tools > Options command.
e PartsDB—Check the desired platforms.

e PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the
individual price lists that you want to export.

Step4  Click Ok.
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1.6.7 Importing User Options, Price Lists or Alien Definitions

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

Use the following procedure to import user options, price lists, maintenance contracts, and the parts
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

From the Tools menu, choose Import. The Import dialog box appears.

In the Import dialog box, click the ... button and navigate to the desired folder and file. Click Select to
choose the file to import.

Click load.

If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple
exported options, complete the following as needed:

e User Option—Leave checked to import a file with the user options that were set with the Tools >
Options command.

e PartsDB—Leave checked to import the parts database for the desired platform.

e PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired
individual price lists.

Click OK.

In the confirmation dialog box, click OK.

1.6.8 Importing the OSMINE Configuration File

Step 1

Step 2
Step 3
Step 4

The OSMINE configuration updates are provided in an OSMINE configuration file. When a new
OSMINE configuration file is available, use this procedure to import it. The networks analyzed after the
import operation will be OSMINE compliant as per the configurations provided in the OSMINE
configuration file.

From the Tools menu, choose OSMINE File Import. The Select OSMINE Config File dialog box is
displayed.

Browse and select the OSMINE configuration XML file.
Select the MSTP release from the drop-down list.
Click OK. The new configuration is loaded into CTP.

1.6.9 Resetting the Default Layout

Your graphical layout settings are saved when you exit Cisco Transport Planner. The next time that you
launch Cisco Transport Planner, the layout appears as it did upon exiting. The default graphical layout
includes items such as whether the panes are visible and/or docked.

To return to the Cisco Transport Planner default layout, choose Default Layout from the View menu. To
restore the user modified layout, choose My Default View from the View menu.
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1.6.10 Adding User Profiles

Step 1
Step 2

Step 3
Step 4
Step 5

A user profile is a set of privileges used for running Cisco Transport Planner. Each profile offers different
capabilities. Cisco Transport Planner is packaged with the Network Designer profile, but you can add
other user profile types provided by Cisco. All the procedures in the Cisco Transport Planner DWDM
Operations Guide are written for users with Network Designer access.

Use the following procedure to add a user profile to Cisco Transport Planner:

Close all open instances of Cisco Transport Planner.

Identify the folder where Cisco Transport Planner is installed on your computer, see the “1.4 Launching
the Cisco Transport Planner” section on page 1-17.

Create a profile folder; if profile folder already exists, go to Step 4.
Copy the profile JAR file provided by Cisco Systems into the profile folder.

Launch Cisco Transport Planner. For more information, see the “1.4 Launching the Cisco Transport
Planner” section on page 1-17. The new profile will appear in the Current Selected Profile drop-down
list.

1.6.11 Understanding Sides Labeling

In Cisco Transport Planner Software R8.5 and later, the label for each supported site structure is different
from the labels that have been used in the previous releases. Table 1-5 summarizes the labeling format
in Cisco Transport Planner.

Table 1-5 Sides Labeling in Cisco Transport Planner
Default labeling in Cisco Transport

Sites Labeling in Previous Releases Planner Software R8.5 and later

Terminal/Terminal+ Only one side is created and Label A is used for the existing side.

labeled, T.

Line/Line+ Two sides are created and are Labels A and B are used for the existing

labeled, West and East. sides.

Multidegree with — Labels A, B, C, and D are used for the

PP-MESH-4 existing sides.

Multidegree with — Labels A, B, C, D, E, F, G, and H are used

PP-MESH-8 for the existing sides.

PSM Line — Labels Aw and Ap are used for the
existing sides, where w stands for
working and p stands for protection.

PSM Section — Labels Aw and Ap are used for the
existing sides, where w stands for
working and p stands for protection.
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Understanding Hybrid Configuration

The default labels applied to the sides can be edited. For more information about editing side labels, see
the “4.4 Editing Side Labels” section on page 4-49.

1.7 Understanding Hybrid Configuration

Typically a node has ONS 15454 MSTP configuration with add/drop units like 40-MUX-C/40-DMX-C,
ROADM units and so on. However, the node configuration can also have ONS 15454 amplifiers along
with ONS 15216 FlexLayer add/drop units like FLB-2s, FLA-8s, and FLD-4s, and is known as Hybrid
15454 ONS configuration. A network design can have up to 80 channels in a typical MSTP
configuration; however, in a Hybrid configuration the number of channels is restricted to 40. In a Hybrid
configuration, the Data Connection Network (DCN) manages the traffic instead of Optical Service
Channel (OSC). Hybrid nodes are add/drop nodes with express traffic and are comparatively less
expensive than MSTP nodes.

1.8 Understanding the Pay As You Grow Feature

The Pay As You Grow (PAYG) feature enables you to implement a cost effective solution when the
wavelength requirements are comparatively less than the maximum capacity of the network. Instead of
purchasing a standard card that is configured to work on maximum supported wavelengths, you can
purchase a PAYG license that comprises of license restricted cards and a base license. The license
restricted cards support only a number of wavelengths for which the licenses are installed on the card.
The base license supports only 10 wavelengths. Therefore, a license restricted card having only the base
license will support only ten wavelengths even if its maximum capacity is to support 40 wavelengths.
The cost of the PAYG license is less than the cost of the standard card. For more information about the
PAYG licenses, see the Appendix F, “Pay As You Grow Licensing”.

When there is a need of more than ten wavelengths, additional licenses can be purchased to support the
increased demand. Each new license supports ten additional wavelengths. Therefore, the PAYG
functionality significantly reduces the initial setup cost and enables the purchase of additional
wavelength capacity on a need basis.

During the analysis of the network, the CTP algorithm decides on whether to use a standard card or a
PAYG license depending on the lower implementation cost.

The cards and units that support a PAYG bundle are:

e 40-SMR1-C

e 40-SMR2-C

¢ 80-WXC-C

¢ AR-MXP

e AR-XP

e 100G-LC-C

e 100G-CK-LC-C

e 10X10G-LC

e 15216-MD-40-ODD
e WSE
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e 15216-EF-40-ODD

The PAYG licensing is applied to each side of every site. The license depends on the cards placed on that
side and the wavelengths that are added, dropped, or expressed. The PAYG licensing is not dependent
on site, type, or functionality.

The applied PAYG bundle is displayed in the Bill of Material of the site. To view it, right-click the site
in the Project Explorer pane and select the Bill of Material option from the shortcut menu.

The PAYG bundle to which a card is associated is displayed in the card property. To view it, select the
card in the Project Explorer pane; the PAYG bundle name is displayed for the Payg Bundle property in
the Properties pane.

1.8.1 Unlock Pay As You Grow Bundles

When a license restricted card is associated with a PAYG bundle, the association is maintained for future
analysis. Therefore, if the network is analyzed with increased wavelength demands, CTP adds additional
licenses even though using a standard card is cost effective.

During a network upgrade, the association of the license restricted card with the PAYG bundle is not
modified unless the Unlock Pay As You Grow Bundle option is selected. Right-click the site either in
the Project Explorer pane or in the NtView Name tab, and select the Unlock Pay As You Grow Bundles
option from the shortcut menu. On selecting the Unlock Pay As You Grow Bundle option all the PAYG
bundle information from a previous analysis are deleted and are recalculated when the network is
analyzed again.

~

Note  The Unlock Pay As You Grow Bundle option is enabled only in the Upgrade or Install mode.

1.8.2 Forcing PAYG Bundles On a Card

The Developer and Optical Designer profile users can decide whether to associate a card with the PAYG
bundle or not. Select the card in the Project Explorer pane; the Force Payg drop-down list is displayed
in the Properties pane. The options available are:

e Auto—The PAYG bundle or the standard card is used based on cost effectiveness.

e Yes—The card is always associated with the PAYG bundle even if using the PAYG bundle is not the
most cost effective solution.

e No—The card is never associated with a PAYG bundle even if using the PAYG bundle is a more cost
effective solution.

~

Note  The Force Payg drop-down list is enabled only in the Upgrade and Install modes, when the card is in the
locked state.

Cisco Transport Planner DOWDM Operations Guide, R10.1



Creating and Analyzing Networks

A project consists of a single network or multiple networks that you analyze and compare. In a project,
you can have multiple copies of a single network with the same customer input data, but use different
options in each to investigate multiple solutions.

2.1 Creating a Project

Note

Step 1

Use the following procedure to create a single network in a project. A new network is in the Design state.
For more information about the different network states, see the “2.10 Managing the Network Design”
section on page 2-54.

All options that the Project Creation wizard sets can be changed as needed, except Measurement Units
and ANSI/ETSIL.

From the File menu, choose New or click New in the Start Page. The Project Creation wizard appears
(Figure 2-1).
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Figure 2-1 Project Creation Wizard
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Step2  In the Project Parameters area complete the following:
¢ Created By—Enter a user name. You can enter a maximum of 128 character.

¢ Customer Name—Enter the name of the customer requiring this network design. You can enter a
maximum of 128 character.

e Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI)
service demands.

¢ Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit
of measure used for span length.

e Price List—Choose a price list from the drop-down list.

Step3  Click Next.
The Choose Platform area appears.

Step4  In the Choose Platform area, check the desired platform and click Next.
The Choose Release area appears.

Step 5 In the Choose Release area, check the desired software release for the network design and click Next.
The Subnet Options area appears.
To set a default software release see “1.6.2 Setting the Default Software Release” section on page 1-25.

Step6  In the Subnet Options area, complete the following:
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Step 11
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e Traffic Mapping Algorithm Release 10.1—Check to select the ONS 15454 Software R10.1 version
of the interface and the wavelength routing optimization algorithm to be used in the network design.
Software R10.1 is backward compatible: it allows you to manage Software Releases 9.0, 9.1, 9.2,
9.2.1,9.3,9.4,9.6.0.3, 9.8, 10.0, and 10.1 and load 7.0 and 8.0.

¢ Design Rules Release 10.1—Check to select DWDM Design Rules Release 10.1.

¢ Layout Release 10.1—Check to define the ONS 15454 Software R10.1 version of the algorithm used
to generate the layout of each site within the subnetwork.
Software R10.1 is backward compatible: it allows you to manage Software Releases 9.0, 9.1, 9.2,
9.2.1,9.3,9.4,9.6.0.3, 9.8, 10.0, and 10.1 and load 7.0 and 8.0.

e Bundle Licensing Release 10.1—Check this check box to select the PAYG bundle licensing for
Release 10.1. For more information about the Pay As You Grow (PAYG) feature, see the
“1.8 Understanding the Pay As You Grow Feature” section on page 1-43.

Click Next.
Complete one of the following:

e To run the Network Creation wizard, check the Run the Network Wizard Now check box and click
Finish. Continue with Step 9.

e To create an empty project to add sites and fibers manually, un-check the Run the Network Wizard
Now check box and click Finish. Project Creation wizard creates the project and an empty network
and subnetwork where you can manually add sites and fibers. Skip the remaining steps in this
procedure. To add sites manually, see the “2.2 Adding Sites” section on page 2-12.

In the Topology area of the Network Creation wizard, choose one of the following options from the
Network-Topology drop-down list:

e Ring—Supports MSTP 15454 ONS, HYBRID 15454 ONS, and NG-DWDM configurations.

~

Note In HYBRID 15454 ONS configuration, at least one node must be hub for the ring topology.

e Linear—Supports MSTP 15454 ONS, HYBRID 15454 ONS, and NG-DWDM configurations.
e PSM Line—Supports only MSTP 15454 ONS configuration.
e PSM Section—Supports only MSTP 15454 ONS configuration.

To instruct Cisco Transport Planner to automatically create a traffic subnet associated with the created
network, check the Create Traffic Subnet check box. Cisco Transport Planner creates (in addition to the
Traffic_ALL) an additional traffic subnet (Traffic_Ring or Traffic_Linear) depending on the topology value
you specify in the Network Creation wizard.

Click Next.
The Configuration page appears.

Choose one of the following options from the node type drop-down list:
e MSTP 15454 ONS—To create an MSTP 15454 configuration.
e HYBRID 15454 ONS—To create a 15216 FlexLayer Hybrid configuration.
e NG-DWDM—To create an NG-DWDM configuration.

15216 FlexLayer Hybrid configuration cannot be mixed with the 15454 MSTP configuration. However,
a network can have two clusters one being MSTP and the other 15216 hybrid, without any connection
between the two. In the same way, an NG-DWDM configuration cannot be mixed with any other
configuration.
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S
Note  For PSM Line and PSM Section topologies, the only possible configuration is MSTP 15454 ONS and
the node type drop-down list is disabled.

Step13  Enter the number of sites in the fields displayed depending on the network topology selected in Step 9.
The following options are available:

Maximum, Minimum, and Default

Network topology Fields to be entered... Number of Sites

Ring or Number of Sites Maximum: 150

Linear Minimum: 2
Default: 3

PSM Line ¢ Intermediate Sites on Working path |Both for working and protected
paths:

¢ Intermediate Sites on Protected path
Maximum: 74

Minimum: 0
Default: 0

PSM Section ¢ Intermediate Sites on Working path |Both for working and protected
paths:

¢ Intermediate Sites on Protected path
Maximum: 74

Minimum: 0

Default: 0

The maximum number of locations where the optical service channel (OSC) can be terminated in a
network is 150. The maximum number of add/drop locations (equipped with WSS, WXC,
multiplexer/demultiplexer, or OADM cards) traversed by an optical circuit is by default limited to 40.
However, this maximum limit can be customized to 150.

Step14 On the Site Name and Topology area, choose the topology for each site from the drop-down list.
For multi-degree sites, choose the number of sides from the drop-down list or see 2.2 Adding Sites,
page 2-12. For corresponding options for NG-DWDM nodes, see Table 2-2.
Available Site Topology options are:

Structure Supported Configurations Description
Line e MSTP 15454 ONS Site with two sides facing two fiber spans. The
e HYBRID 15454 ONS default site value for ring topology is Line.
¢ NG-DWDM
Terminal e MSTP 15454 ONS Site with one side facing one fiber span.
e HYBRID 15454 ONS
e NG-DWDM
Line+ MSTP 15454 ONS Site with two sides facing two fiber spans that can
provide multidegree expansion capability through
an MMU unit.
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Structure

Supported Configurations

Description

Terminal+

MSTP 15454 ONS

Site with one side facing one fiber span that can
provide multidegree expansion capability through
an MMU unit. Terminal+ is not allowed for ring
network or linear network topology intermediate
sites.

Multi-degree

e MSTP 15454 ONS
¢ NG-DWDM

Sites have two or more sides and face two or more
fiber spans.

The default is two and you can choose up to eight
sides for a site.

PSM Terminal -
Optical Path
Protection

MSTP 15454 ONS

Provides protection for terminal sites at line level
through an optical protection switching module
(PSM). In this configuration, the PSM is directly
connected to the fibers after the amplification
stage.

PSM Terminal -
Multiplex
Section
Protection

MSTP 15454 ONS

Provides protection for terminal sites at multiplex
level through an optical protection switching
module (PSM). In this configuration the PSM is
equipped between the mux/demux stage and the
amplification stage.

The site topology options displayed depend upon the restrictions listed in the following table. See

Table 2-1.
Table 2-1

Site Topology Restrictions

If the Network

Topology is... then...
Ring You cannot choose the following options:

e Terminal

e Terminal+

e PSM Terminal - Optical Path Protection

e PSM Terminal - Multiplex Section Protection
Linear You cannot choose the following options:

¢ Terminal for the intermediate sites
e Terminal+ for the intermediate sites
e PSM Terminal - Optical Path Protection

e PSM Terminal - Multiplex Section Protection
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Step 15

Step 16

Step 17

Table 2-1 Site Topology Restrictions

If the Network
Topology is... then...

PSM Line You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:

e PSM Terminal - Optical Path Protection for the two PSM sites

¢ Line for the intermediate sites

PSM Section You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:

e PSM Terminal - Optical Path Protection for the two PSM sites

e Line for the intermediate sites

The Topology and Scalable upto Degree options for NG-DWDM node are given in the following table.
See Table 2-2.

Table 2-2 Topology and Scalable Upto Degree for NG-DWDM

If the Network Topology is... then the network is scalable upto...
Line 2 degrees

Terminal 1 degree

Multi-degree 4, 8, and 12 degrees

To enable the Split Node feature in any site, check the corresponding check box. The Split Node feature
is available only for MSTP 15454 node type.

Click Next
The Options area appears.

The Options area allows you to define C-band and L-band rules for the network design. In the Options
area complete the following:

e (C-band rules—The C-band options appear in the following format: 80Ch. 50 GHz +1dBm. The
channels available are 80, 72, 64, 40, 32, 20, 16, or 8; the reference per channel power options
available are -1 dBm, +1 dBm, 2 dBm, -2 dBm, +4 dBm, 5 dBm, 7 dBm and 8 dBm; and the spacing
options available are 100 GHz or 50 GHz. You can use even wavelengths for the following channel
designs:

— 80 (40 even wavelengths + 40 odd wavelengths)
— 72 (40 even wavelengths + 32 odd wavelengths)
— 64 (32 even wavelengths + 32 odd wavelengths)

Note L-band Expand is also supported in the 50 GHz even wavelengths design.

Note  For the HYBRID 15454 ONS configuration, 32 channels is the default value. The channels
available are 8, 16, 20, 32, and 40.
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e L-band Rules— The L-band options appear in the following format: 32 Ch. 100 Ghz +5dBm. The
options available are: None, Expand, and channels available are 32; the reference per channel power
available are 2 dBm and 5 dBm; and, the spacing options available is 100 GHz.

L-band is not applicable for the HYBRID 15454 ONS and NG-DWDM configurations.

If you use a Line+ or Multidegree site, you must select design rules based on 100 GHz channel spacing,
and in the case of Line+, you must also select 32-channel rules. If these conditions are not met,

Cisco Transport Planner will provide an error message when you attempt to analyze the network. See
Table 4-1 and Table 4-2 for additional details on site design rules.

Click Next
The Site Management area appears.

In the Site Management area, complete the following.
¢ Shelf Management—Choose one of the shelf management configurations:

— Auto—External switch is placed if node controller is M12. If M6 is the node controller, the
external switch is placed only if it is required.

— Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards
(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this
option, the Multi Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf
configuration.

— Multi Shelf External Switch—All the MSTP optical cards (OADMs and amplifiers) reside in
different shelves connected by a LAN. The LAN is implemented with switches external to the
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units
(Cisco Catalyst 2950 and Cisco Catalyst 3650) are used to support the multishelf configuration.
The Cisco Catalyst 2950 supports 12 subtending shelves and Cisco Catalyst 3650 supports
24 subtending shelves. CTP supports a maximum of 50 shelves, including the node controller
shelf, in a multishelf configuration when the TNC, TNCE, TSC, TSCE, or TCC3 card is used
as the node controller. CTP supports a maximum of 5 shelves, including the node controller
shelf, in a multishelf configuration when TCC2P card is used as the node controller.

Note  When the Multi Shelf External Switch is forced, the Multi Shelf External switch is placed
in the layout irrespective of the node controller.

Note The M6 chassis, when used as node controller, can support three subtended shelves. The
subtended M6 chassis can subtend two more shelves.

— Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf.
For this option, the multishelf management is not supported; every shelf is managed as an
independent shelf.

~

Note  Shelf Management is disabled for HYBRID 15454 ONS configuration.
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Note If you select the Shelf Management type as Multi Shelf Integrated Switch or Multi Shelf
External Switch, you can modify the MSM Shelf ID for Multi Shelf Management
Configuration. To modify the MSM Shelf ID, refer “3.2.6 Viewing the Layout of Single
Site” section on page 3-15.

Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves
places OADM/ROADM units (west-facing and east-facing) in separate shelves in the node and it is
selectable only if Multishelf management is selected. You can also set node protection for a
multidegree node.

~

Note Node protection is disabled for HYBRID 15454 ONS configuration with an auto-selected
value of Same Shelf.

Hybrid Site Config—Check to create all the nodes configured as hybrid MSTP/Multi Service
Provisioning Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf
as the Shelf Management type.

OSMINE Compliant—Check this option to place the DWDM units in the shelves according to

Operations Systems Modifications for Integration of Network Elements (OSMINE) placement rules.

DCC Chain—Check to put a TXP(P)_MR_2.5G card in slot 12 on each shelf of each site to use
DCC.

Max Shelves per Rack—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves
(equipping optical cards or TXP/MXP cards) that can be placed in each rack in the site when
generating the layout of the site.

Installation w/o CTP—Check this box to design a network that does not require the setup of
configuration files (thresholds and setpoints). Installation without Cisco Transport Planner is also
known automatic node turn up. When this feature is enabled, the software in the node will configure
itself with parameters; XML configuration files are not required to configure the node. When this
option is selected at the end of EDFA and DCU placement, Cisco Transport Planner will analyze the
resulting network and verify that in each node, where the option installation w/o Cisco Transport
Planner is enabled, has:

— A preamplifier in each direction.

— All amplifiers working in gain control mode.

— A flat node output spectrum, that is, the resulting channel tilt at the exit of the node is 0.
— A feasible set point forced during simulation.

Use Payg—Check this check box to enable the Pay As You Grow feature on all the sites created in
the current network. For more information about the Pay As You Grow feature, see the
“1.8 Understanding the Pay As You Grow Feature” section on page 1-43.
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¢ Enable NCS—Check this check box to enable NCS feature on all the sites created in the current
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network. The existing MSTP PIDs are replaced with new NCS PIDs. The NCS PIDs corresponding
to the existing MSTP PIDs are given in the following table.

Table 2-3 NCS PIDs

NCS PID DESCRIPTION MSTP PID
NCS2006-SA= NCS 2006 Shelf Assembly 15454-M6-SA=
NCS2006-DC= NCS 2006 30A DC Power Filter 15454-M6-DC=

NCS2006-DC20=

NCS 2006 20A DC Power Filter

15454-M6-DC20=

NCS2006-DC40=

NCS 2006 40A DC Power Filter

15454-M6-DC40=

NCS2006-AC=

NCS 2006 1500W AC Power Supply

15454-M6-AC2=

NCS2006-PWRFLR=

NCS 2006 Power Filter/Supply Filter

15454-M6-PWRFLR=

NCS2006-ECU=

NCS 2006 External Connections Unit

None

NCS2006-LCD=

NCS 2006 LCD Display with Backup
Memory

15454-M6-LCD=

NCS2006-FTA=

NCS 2006 Fan Tray

15454-M6-FTA2=

NCS2006-DR= NCS 2006 Standard Door 15454-M6-DR=
NCS2006-DDR= NCS 2006 Deep Door 15454-M6-DDR=
NCS2002-SA= NCS 2002 Shelf Assembly 15454-M2-SA=
NCS2002-DC-E= NCS 2002 ETSI DC Power Filter 15454-M2-SA=
NCS2002-DC= NCS 2002 ANSI DC Power Filter 15454-M2-DC-E=
NCS2002-DC= NCS 2002 AC Power Supply with Backup |15454-M2-DC=
Memory
NCS2002-AC= NCS 2002 AC Power Supply with Backup |15454-M2-AC=

Memory

NCS2002-FTA=

NCS 2002 Fan Tray

15454-M6-FTA2=

NCS2002-DR= NCS 2002 Standard Door 15454-M6-DR=
NCS2002-DDR= NCS 2006 Deep Door 15454-M2-DDR=
Use MSTP PID Transport Node Controller for M2 and M6 |15454-M-TNC-K9=

Chassis

Use MSTP PID

MSTP / NCS 2K Transport Node
Controller with Ethernet PTP

15454-M-TNCE-K9=

Use MSTP PID

Transport Shelf Controller for M2 and M6
Chassis

15454-M-TSC-K9=

Use MSTP PID

MSTP / NCS 2K Transport Shelf
Controller with Ethernet PTP

15454-M-TSCE-K9=

L-NCS2K-CH-10=

NCS 2K / MSTP Lic ROADM Add/Drop
or Exp - 10Chs e-Delivery

15454-LIC-CH-10=

L-NCS2K-AR-10G-DM=

NCS 2K/ MSTP Lic Any-Rate XP/MXP -
10G Data MXP e-Delivery

15454-LIC-10G-DM=

L-NCS2K-AR10G-MXP=

NCS 2K /MSTP Lic Any-Rate XP/MXP -
4x2.5G MXP e-Delivery

15454-LICMXP4X2.5=
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Table 2-3 NCS PIDs

NCS PID DESCRIPTION MSTP PID

L-NCS2K-AR-MR-MXP= |NCS 2K /MSTP Lic Any-Rate XP/MXP - |15454-LIC-MXP-AR=

MultiRate MXP e-Delivery

L-NCS2K-AR10G-REG= |NCS 2K /MSTP Lic Any-Rate XP/MXP - |15454-LIC-REG-10G=

OTU?2 Regen e-Delivery

L-NCS2K-AR-MR-TXP= |NCS 2K / MSTP Lic AnyRate XP/MXP - |15454-LIC-TXP-8G=

8G FC/10GE TXP e-Delivery

L-NCS2K-AR-VD-MXP= |NCS 2K / MSTP License Any-Rate XP - |15454-LIC-VD-XP=

3G Video MXP e-Delivery

L-NCS2K-WSE-1= NCS 2K / MSTP License WSE - 1x L-P-O-WSE-1=

Encryption Stream e-Delivery

L-NCS2K-100G-10G= NCS 2K / MSTP License 100G MXP - 1x |15454-M-LIC-10G=

10G MR Port e-Delivery

Step20 Click Next.
The Span Parameters area appears.

Step21 In the Span Parameters area, complete the following.

Span Label Tag—Enter the desired span label.
Span Fiber Type—Choose the fiber type for each span in the network.

Span Length—Enter the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

~

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields. Use one of the following formulas to calculate the fiber loss at SOL:
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL:
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

Connector loss [dB]—Enter the concentrated loss at the end of the span.

CD factor [ps/mn/km]—Enter the fiber chromatic dispersion (CD) factor. The default value is
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm and
L-band is defined at 1590.4 nm.

PMD factor [ps/sqrt(km)]—Enter the polarization mode dispersion (PMD) factor. The default value
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. PMD is always entered per kilometer.
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Length Based Loss—If this check box is checked, the fiber loss is determined by multiplying the
Span Length with the Loss Factor. If this check box is unchecked, you must enter the total span loss
value for the Tot SOL Loss w/o Connectors property.

Loss factor [dB/km]—Enter the value of the SOL fiber loss per kilometer that is used to calculate
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

Tot SOL Loss w/o Connectors—Enter the start of life fiber loss value for each span, excluding the
connector concentrated loss.
This property is disabled if the Length Based Loss check box is checked.

DCN extension—Check this check box to use DCN extensions on each of the spans in the network.
This implies that the OSC channel is not used to connect the two nodes. All nodes facing a span with
the DCN Extension option enabled require a ITU-T G.709 generic communications channel (GCC)
access that must be provided by the customer.

~

Note For HYBRID 15454 ONS configuration, this option is disabled by default.

OSC Frame Type—Choose the OSC frame type. The options available are Auto, OC3 Frame,
GE Frame, and FE Frame. The default option is Auto. When set in Auto, CTP will use FE Frame as
the preferred frame type.

CTP does not allow connecting different types of frames through a pass-through site.

CTP does not allow removing a node if different frame types are used in the node.

Click Finish. CTP checks the validity of the fiber factor values. If the fiber factor values are within the
valid range (Table 2-4), CTP creates a visual representation of the network. If the values are out of range,
CTP issues a warning, asking you to confirm the input values.

All options set by the Network Creation wizard can be changed as needed per site and per span.

Table 2-4 Valid Ranges for Fiber Factor Values
Min. Min. Max. Max.
Error Warning |Default |Warning |Error
Fiber Type Parameter Value |Value Value Value Value Unit
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.652-SMF | Chromatic 0 16.2 16.7 17.1 30 ps/nm/km
dispersion factor
at 1545.3 nm
(C-band)
Chromatic 0 18.53 19.03 19.43 30 ps/nm/km
dispersion factor
at 1590.4 nm
(L-band)
PMD factor 0 0.0 0.1 0.5 10 pf(fim)
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Table 2-4 Valid Ranges for Fiber Factor Values (continued)
Min. Min. Max. Max.
Error Warning |Default |Warning |Error

Fiber Type Parameter Value |Value Value Value Value Unit
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.655-E-LEAF | oy romatic 0 3.4 3.80 42 10 ps/nm/km

dispersion factor

at 1545.3 nm

PMD factor 0 0 0.1 0.5 10 pafillan)
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.655-True  |Cpromatic 0 3.8 4.19 4.6 10 ps/nm/km
Wave dispersion factor

at 1545.3 nm

PMD factor 0 0 0.1 0.5 10 pa/(lan)
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.652-DS Chromatic 0 2.43 2.83 3.23 30 ps/nm/km
(Dllspers1on dispersion factor
shifted) at 1590.4 nm

(L-band)

PMD factor 0 0 0.1 0.5 10 padiflan)

2.2 Adding Sites

Use the following procedure to add new sites to an existing network. A site is a customer premise
equipment (CPE) where any equipment can be co-located in a rack within a building. The

Cisco Transport Planner supports up to 150 sites in a network. The number of racks and nodes in a site
is independent of the number of sites in the network. The maximum number of locations where the OSC
can be terminated in a network is 40. When the number of locations where the OSC is terminated exceeds
the maximum supported value, the tool completes the design, but in the summary report an alarm is reported
to indicate this situation. The maximum number of add/drop locations in a network is 40. The maximum
number of add/drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or OADM) traversed
by an optical circuit is limited to 40.

Note  Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with Same
Shelf protection. To change this, you can edit the site properties after adding it to the network design.
See the “4.3 Editing Site Parameters” section on page 4-3.

Step 1 Right-click the network folder in the Project Explorer pane and choose Expand from the shortcut menu.

Step2  Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard
appears. As an alternative, if sites already exist in the network design and you have the NtView Name
tab open, click the Create a new site icon in the toolbar. For more information about the Cisco Transport
Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Step3  Choose the type of node from the Node Type drop-down list. The options available are:
e MSTP 15454 ONS
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Step 4

Step 5

Step 6

Step 7

Adding Fiber Spans W

e HYBRID 15454 ONS
¢ NG-DWDM

Choose the type of interface from the Select line or terminal site drop-down list. The options
available are:

e Line—Two pairs of fibers are terminated at the node.
e Terminal—A single pair of fibers is terminated at the node.

¢ Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An
MMU card (topology upgrade) must be installed.

e Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be
increased. An MMU card (topology upgrade) must be installed.

e Multi-degree—Nodes have two or more sides and face two or more fiber spans.

e PSM Terminal - Optical Path Protection—Provides protection for terminal sites at Line level
through an optical protection switching module (PSM). In this configuration, the PSM is directly
connected to the fibers after the amplification stage.

e PSM Terminal- Multiplex Section Protection—Provides protection for terminal sites at multiple
levels through an optical protection switching module (PSM). In this configuration the PSM is
equipped between the mux/demux stage and the amplification stage.

>
Note Inthe HYBRID 15454 ONS configuration, the supported interface types are line and

terminal. In NG-DWDM configuration, the supported topologies are Terminal, Line and
Multi-degree.

If you chose multi-degree in Step 4, choose the number of sides from the No of Sides drop-down list.
The default option is two.

Enable NCS—Check this check box to use NCS PIDs for the selected site. For more information, see
Table 2-3NCS PIDs, page 2-9.

Click Finish.

2.3 Adding Fiber Spans

Note

Step 1

Step 2

Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the
NetViewName tab. Within a fiber duct, more than one fiber pair can exist.

The number of fiber spans that each site can support is defined in the site properties. See the
“2.2 Adding Sites” section on page 2-12 or the “4.3 Editing Site Parameters” section on page 4-3.

In the NtView Name tab, click the Create a new duct icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Click one of the sites that you want to connect with a fiber span. This site becomes the source site for
network analysis output, later.
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Step 3

Step 4

Step 5

Click the destination site. The New Duct dialog box appears. The selected site becomes the destination
site for network analysis output, later. For the first span, the source site is set as A and the destination
site is set as B. Cisco Transport Planner automatically adjusts East and West for additional spans.
HYBRID 15454 ONS configuration cannot be connected to the 15454 MSTP configuration. However, a
network can have two clusters, one being the 15454 MSTP and the other being the 15216 hybrid without
any connections between the two.

S

Note  To connect any two sites using a duct, both the source and destination sites must have at least
one unconnected side.

~

Note For NG-DWDM nodes, the number of new ducts created is limited to the scalable upto degree
value.

Choose the Connection Type:
e Line
e Remote Add/Drop

A Remote Add/Drop duct can be created only between a terminal site and the Remote Add/Drop
side of any non-terminal site.
The remote terminal site to which the remote add/drop side is connected must fulfill the following

site functionality type, and equipment constraints in addition to the rules in Table 4-1 and Table 4-2:

- Site functionality must be Auto or Add/Drop.
- Site type must be Auto or Mux/Demux.

— Add/Drop units can be 40-MUX-C/40-DMX-C, 15216-MD-40-ODD, 15216-MD-40-EVEN,
15216-EF-40-ODD, or 15216-EF-40-EVEN.

For more information see “4.22 Modifying Site Properties” section on page 4-126.
Choose the sides of the source and destination site to connect.

If you chose Line in Step 4, only the line sides are displayed here. If you chose Remote Add/Drop, the
line side is displayed for the terminal site, while the pane of the other site lists the unconnected Remote
Add/Drop ports of the site.

2.4 Creating an Optical Subnet

An optical subnet is a collection of spans with certain associated, defined, common properties. You can
define distinct optical subnets on the same network and can also set a list of associated properties on
each of them.

The following properties are supported in an optical subnet:

e (C-band Rules—Allows you to define rules for the C-band channels, the maximum per channel
power, and the channel spacing for the design.

¢ [-band Rules—Allows you to define, for the L-band channels, the maximum per channel power, and
the channel spacing for the design.
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Step 2

Creating an Optical Subnet

When you create a new project (see 2.1 Creating a Project, page 2-1), Cisco Transport Planner
automatically creates an optical subnet associated to the network. At least one optical subnet (even if
empty) must exist for each network in a project.

You can create an optical subnet using the Project Options (default) Optical Subnet property (Design
Rules) values. To do this:

Select the Optical Subnet folder in the Project Explorer pane. The Optical Subnet Pane appears in the
Task Pane on the right side of the screen (Figure 2-2).

Figure 2-2 Creating Optical Subnet
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Click Create. The Create Optical Subnet dialog box appears (Figure 2-3). Alternatively, right-click the
Optical Subnets folder and select Create.

The default name, which is a combination of the user-created C-band and L-band rules, and the
wizard-created default C-band and L-band rules are displayed.
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Step 3

Step 4

Note

Note

Figure 2-3 Create Optical Subnet Dialog Box
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Select C-band and L-band design rules from the C Design Rule and L Design Rule drop-down lists for
the new optical subnet that you want to create.

Click OK. A new optical subnet with the design properties you selected is created and placed in project
explorer under the Optical Subnets folder.

You cannot create more then one optical subnet with the same properties values and each span must be
part of only one optical subnet.

Cisco Transport Planner allows you to do the add or remove spans, edit designs rules, define an optical
subnet as current, and to delete an optical network. To do these, select the optical subnet you want to
change under Optical Subnets in the Project Explorer pane. In the Tasks Pane, choose the following:

e Add/Remove Spans—Adds or removes the spans that are included in a given optical subnet.
e Edit Design Rule—Modifies the property value of the design rule of a new or existing optical subnet.
¢ Set as Current—CTP automatically defines the optical subnet with the greatest number of spans.

e Delete—Deletes the optical subnets in the Tasks Pane.

When you delete an optical subnet, all the spans contained in the deleted optical subnet are placed within
the current optical subnet. In case the current optical subnet is deleted, all their spans will be
automatically placed within the optical subnet with the greatest number of spans. When the current
optical subnet is removed, the tool automatically defines as current the optical subnet with the greatest
number of contained spans.

2.5 Adding Notes to a Project

Step 1
Step 2

Use the following procedure to add a note to any item in the Project Explorer pane. Each network has a
Notes folder in the Project Explorer pane. After you have created a note, it appears in the Notes folder
for that particular network.

Right-click the desired item in the Project Explorer pane and choose Edit Note from the shortcut menu.

In the Edit Note creation box, enter the desired text.
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Step3  To close the Edit Note creation box and to save the note, click the X in the upper right corner of the
window.

Step4  To view notes, double-click the Notes folder. The Notes window appears. Table 2-5 lists the columns in
the Notes window.

Table 2-5 Notes Window

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header
to expand the text.

Action Click Go to open the item in the Project Explorer pane where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2. W.

Step5  To close the Notes window, click the X in the upper right corner of the window.

2.6 Creating Traffic Subnet

Step1  In the Project Explorer pane, scroll down to Traffic Subnets. Right-click Traffic Subnets, and select
Create.

The Traffic Subnet Creation wizard appears.

Step2  Select the Topology for the subnet from the drop-down list (Ring, Linear, and Mesh), then click Next.

Note If Ring or Linear topology is selected for the subnet, the spans in the subnet must be adjacent and also
ordered.

Step3  Click Press to build new subnet. The Traffic Subnet Builder Wizard appears (Figure 2-4).

Step4  Select the ducts that should be a part of the subnet from the list displayed on the left handside, and click
OK. This takes you back to the Traffic Subnet Creation Wizard.

Step5  Click Finish to complete the creation of the traffic subnet. The created subnet appears under Traffic
Subnets in the Project Explorer pane.

| Cisco Transport Planner DIWDM Operations Guide, R10.1
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Figure 2-4 Traffic Subnet Builder Wizard
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2.7 Creating a Demand

Cisco Transport Planner provides five types of service demands:
e Point-to-point
e Protected ring (P-ring)
¢ ROADM
e FEthernet aggregated
e TDM aggregated

You can also create regeneration sites while creating a service demand.

2.7.1 Manual Regeneration

In optical networks, as the fiber length increases, a loss in the signal ratio and power could occur due to
attenuation and dispersion. A regenerator is required to recreate the weak and distorted optical signals
through reamplification, regeneration, and retiming processes. The regenerators remove noise and
distortion, convert the optical signal to an electrical signal, and then convert the signals back to optical
signals (O-E-O conversion).

Cisco Transport Planner supports the creation of regeneration sites in the network. Regeneration is
supported for the following demands:

¢ Point-to-point
e P-ring
e Ethernet Aggregated
e TDM Aggregated
The demand is displayed in the following manner:
Demand > Service > Trail > Section
e “Service” is the circuit through which traffic flows between nodes.

e “Trail” is the network section joining two traffic nodes. By default, a trail has only one section. The
trail can be split in different regeneration sections.

e “Section” is a contiguous subset of the span.

A new section is added whenever a regeneration site is created. The sections can have different
wavelengths based on availability. Regeneration can be performed using any two cards back-to-back
(OTU2_XP, TXP, or MXP) or with a dedicated regenerator card.

2.1.2 Understanding Omnidirectional Functionality

The omnidirectional functionality on a side enables you to connect the side to a local multiplexer and
demultiplexer that can add or drop traffic to or from any of the node directions. Omnidirectional traffic
can be added or dropped only on the omnidirectional side.

Omnidirectional sides are different from standard add/drop sides in the following ways:
e Omnidirectional sides are internal sides that cannot be connected through fibers or ducts.

e Amplifiers on omnidirectional sides are placed between the 80-WXC-C card (bidirectional mode)
and the Add/Drop (Mux/Demux) units.

[ oL-29753-01
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e Raman amplification is excluded on omnidirectional sides, as the amplification depends on the
Raman Amplified option on a duct.

Multi-degree sites that use the OXC functionality and are equipped with the following equipment can
support omnidirectional sides:

- 40-WXC-C/MESH-PP-4

- 40-WXC-C/MESH-PP-8

- 80-WXC-C/MESH-PP-4

- 80-WXC-C/MESH-PP-8

— Flexible (nodes equipped with 80-WXC-C and 40-WXC-C equipment)
- 40-SMR2-C

Multi-degree OXC sites equipped with 40-WXC-C or 40-SMR2-C units can support both
omnidirectional sides and the Omnidir Entry Point options. However, both options cannot be used on the
same side.

For more information see the*“4.22 Modifying Site Properties” section on page 4-126.

2.7.2.1 Omnidirectional Demands

In all service demands (except ROADM demands), the value of the omnidirectional property is
independent for each section or trail of a service.

You can perform operations at the trail level. The following are some examples:

e Terminate a working trail on the omnidirectional stage, and connect the protected trail to a standard
add/drop stage.

e Terminate a trail on a line side and regenerate the trail in an intermediate omnidirectional side.

e Force both working and protected trails (or consecutive trails in the case of a P-Ring demand) to
terminate on the same omnidirectional side. By default, traffic from all demands (except ROADM
demands) terminates on two different omnidirectional sides.

The omnidirectional property is available for the source and destination of each section of a service trail.
A section terminating on an omnidirectional side can be routed in all possible directions. If multiple
omnidirectional sides are available for a site, you can force the section to terminate on a specific side.

2.1.3 Understanding Colorless Functionality

The colorless property enables tuning of channel wavelengths without changing the optical interface of
the port. A colorless side is connected to two 80-WXC-C cards configured as a multiplexer and
demultiplexer.

A colorless stage is available at the local add/drop stage on line, terminal, or multi-degree sites.
In line and terminal sites, you can implement colorless sides using the following configurations:

e Line or terminal ROADM site with 80-WXC-C cards

S

Note  For line sites, you must have 80-WXC-C cards on both sides even when only one of the ports is
forced as colorless.
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e Line or terminal sites equipped with 40-SMR1-C
e Line or terminal sites equipped with 40-SMR2-C

In multi-degree sites you can implement colorless sides through a node having OXC functionality and
are equipped with the following:

¢ 40-WXC-C/MESH-PP-4
e 40-WXC-C/MESH-PP-8
¢ 80-WXC-C/MESH-PP-4
e 80-WXC-C/MESH-PP-8
e 40-SMR2-C

2.1.3.1 Colorless Demands

In all service demands (except ROADM) the colorless property is available separately for each trail and
section of a service demand.

For example, in a P-ring demand you can terminate one trail on a colorless mux/demux stage and connect
the other trail to a standard (colored) mux/demux stage.

Colorless sections must be associated to an 80-WXC-C colorless port and can be terminated on sides
having colorless add/drop ports to achieve full wavelength tuning capability on fixed physical ports.

2.1.4 Understanding Colorless Omnidirectional Functionality

~

Note

A colorless and omnidirectional side is connected to a multiplexer (80-WXC-C card) and demultiplexer
(80-WXC-C card) that can add or drop traffic to or from any of the node directions. You can define an
omnidirectional colorless side by adding one or more colorless ports to an omnidirectional side.

In all service demands (except ROADM), you can configure colorless termination points as
omnidirectional, to achieve full routing capability for all possible wavelengths.

In a 50GHz design, an omnidirectional demand can be dropped only on a colorless omnidirectional side.

2.15 Creating a Point-to-Point Demand

Step 1

Step 2
Step 3
Step 4

Step 5

Use the following procedure to add a point-to-point traffic demand:

In the NtView Name tab, click the Create new Point-to-Point demand icon in the toolbar. For more
information about the Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.”

Click the source site of the demand.
Click the destination site of the demand. The Point to Point Demand Creation wizard appears.

From the drop-down list, select Traffic Subnet ALL or any of the previously created traffic subnets to
which this service demand should be part of, and proceed to Step 5. If you wish to create a new traffic
subnet see “2.6 Creating Traffic Subnet” section on page 2-17.

Click Next.

[ oL-29753-01
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Step6  On the General Parameters page, complete the following:
e Label—Enter the name of the demand.
¢ Source—(Display only) Displays the source site name.
¢ Destination—(Display only) Displays the destination site name.

e Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-6.

e Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

¢ Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Step7  Click Next. The Platform Parameters page appears.
Step8  On the Platform Parameters page, complete the following in the Platform area:

¢ Protection—Choose the protection type from the drop-down list: Client 1+1, Y-Cable, Fiber
Switched, Unprotected, or PSM-OCH. For more information on protection types, see the
“1.1.2.4 Protection Scheme Support” section on page 1-4.

~

Note  Y-cable protection is not available for encrypted traffic types.

e Path—(Unprotected only) Choose the routing type from the drop-down list:

— Auto—Allows the highest degree of flexibility in routing the channels. Cisco Transport Planner
routes the channels with the lowest possible cost, given the other constraints.

— A—Select this for a Terminal or a Terminal+ site.
— A or B—Select either of these for a Line or a Line+ site.
- A, B, C, or D—Select either of these for a Multidegree site if four ducts are connected.

- A,B,C,D, E, F, G, or H—Select either of these for a Multidegree site if eight ducts are
connected.

— Aw or Ap—Select either of these for a PSM Terminal - Optical Path Protection or PSM
Terminal - Multiplex Section Protection site.

e Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

~

Note Optical Bypass cannot be performed for an NG-DWDM node.

¢ Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-20.

— Auto—(Default) Disables colorless functionality on the demand.
— Yes—Enables colorless functionality on the demand.

— No—Disables colorless functionality on the demand.
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Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-19.

Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

Yes—Enables omnidirectional functionality on the demand.

No—Disables omnidirectional functionality on the demand.

Encryption—Choose an option from the Encryption drop-down list.

~

Note

Yes—Enables encryption functionality on the demand.

No—Disables encryption functionality on the demand.

The Encryption option is available only if you have selected 10GE LAN PHY, OTU2e, or
OTU?2 as Service Type in Step 6.

Step9  In the Platform Parameters page, complete the following fields in the Interface/Card Type area. The
options available are based on the service type selected in Step 6.

Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.

If you have selected 10G FICON, 10GE WAN PHY, Fiber Channel 10G, 8G FICON, 8G Fiber
Channel, OC192/STM64, 10GE LAN PHY, OTU2e, or OTU2 as Service Type in Step 6 and
enabled encryption in Step 8, then, the encryption feature is available in the WSE-TXP Mode
card. If you choose not to encrypt, this card is still available and is used without encryption.

If you have chosen 100GE or OTU4 as Service Type in Step 6, then the 100G-CK-LC-C card is
available as a standalone card. If you have chosen 100GE as Service Type in Step 6, then the
100GS-CK-LC (with SD-FEC) card is available as a standalone card. For other service types,
100G-CK-LC-C and 100GS-CK-LC cards are available only in combination with the
10X10G-LC card.

A 100 G demand which goes through a Cisco Aggregation Services Router (ASR) is labelled as
an ASR demand in CTP. A one-port ASR demand contains one 100G-LC-C card, one pluggable
and one cable associated with it. A two-port ASR demand contains two 100G-LC-C cards, two
pluggables and two cables associated with it. To create an ASR demand, select the Service Type
as 100GE in Step 6. From the Transponder folder, select 100G-LC-C+ASR (with FEC, with
EFEC, or with HG-FEC) or 100G-LC-C+ASR2 (with FEC, with EFEC, or with HG-FEC)
demand and proceed to Step 11.

ASR demands are available for ROADM demands and Point-to-Point demands with protection.
To view the ASR bundle, see “2.11.3.1 Viewing the ASR Bundle in the Site BoM” section on
page 2-66.

If you have selected the Service Type as LAN-WAN Conversion in Step 6, when you expand the
Transponder folder, select any one of the following OTU2-XP LAN-WAN modes and then
proceed to Step 10:

OTU2-XP- Mixed Mode—Select this mode if the Protection type is either Unprotected, Client
1+1, or PSM-OCH.

OTU2-XP- Txp Mode—Select this mode if the Protection type is either Unprotected, Client
1+1, or PSM-OCH.

OTU2-XP- Splitter Mode—Select this mode if the Protection type is Fiber-Switched.

| oL-29753-01
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Step 10

Step 11

Step 12

Step 13
Step 14

Step 15
Step 16

S

Note  Y-cable protection is not supported on the LAN to WAN interface (ports 1 and 3)

e Line Card—Click to expand the Line Card folder and then check the Card Type check box to select
the card at the end sites of the service channels. For a list of line cards supported for specific service
types, see the “1.1.2.5 Service Support” section on page 1-6.

e Alien Card—Appears only if you created a third-party interface as described in the “1.6.5 Defining
Third-Party DWDM Interfaces” section on page 1-35. Click to expand the Alien Card folder and
then check the card type check box to select the card at the end sites of the service channels.

e Pluggable Card—Click to expand the Pluggable Card folder and then check the card type check box
to select the card at the end sites of the service channels.

In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

~

Note  Inthe LAN-WAN conversion mode, CTP automatically selects the Source and Destination client
interface type if you have not selected the Source and Destination client interface type.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.

The demand appears in the NtView name tab and in the Project Explorer pane in the

Service Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when
not selected. The line has a number above it that indicates the number of channels that are present.
Figure 2-5 shows a selected point-to-point demand with five channels between sites 1 and 2.

Figure 2-5 Point-to-Point Demand Between Two Sites

151654

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To set path constraints, click the Path Constraints Editor icon in the toolbar and complete the following
as required:

¢ Output Node Interface—Choose from the drop-down list, the side through which the demand must
be routed.

¢ Exclude Sites—Choose the sites that must be excluded from the demand route.

¢ Exclude Ducts—Choose the ducts that must be excluded from the demand route.
Click OK to save the changes and Cancel to close the dialog box without saving the changes.
This icon is available only at the trail level of the service demand.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-46.
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Click OK to save the changes to the channels and close the Demand editor dialog box, or Cancel to close the
dialog box without saving the changes.

To make changes to the demand parameters, see the “4.7 Editing a Point-to-Point Demand” section on
page 4-52, or click Cancel to close the Demand Editor dialog box.

For each network, Cisco Transport Planner automatically creates a default subnet that exactly matches
the overall network topology. This cannot be deleted.

2.1.6 Creating a Protected Ring Demand

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7
Step 8

Use the following procedure to create a P-ring traffic demand.

Create a ring network using either the procedures in 2.1 Creating a Project, page 2-1or by manually
placing sites into a ring configuration.

In the Native Net# tab, click the Create new P-Ring demand icon in the toolbar. The P-Ring Creation
wizard appears. For more information about the Cisco Transport Planner icons, see Appendix A, “GUI
Information and Shortcuts.”

For each network, the tool automatically creates, a default subnet that exactly matches the overall
network topology. This cannot be deleted. From the drop-down list, select any previously created traffic
subnet with a ring topology that this circuit should be part of and proceed to Step 4. If you wish to create
a new traffic subnet see 2.6 Creating Traffic Subnet, page 2-17.

On the General Parameters page, complete the following:
e Label—Enter the name of the demand.

e Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-6.

e Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

e Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Click Next.

On the Sites Selection page, in the Protection Sites area, press Ctrl and click the sites that you want to
add to the P-ring. A P-ring requires at least two sites. Click the right arrow button. To remove a site added
to the list, click the site and click the left arrow button.

In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Click Next. The WDM Client Selection page appears.
On the WDM Client Selection page, enter the following Platform Parameters:

¢ Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-20.
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— Auto—(Default) Disables colorless functionality on the demand.
— Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

¢ Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-19.

— Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

— Yes—Enables omnidirectional functionality on the demand.
— No—Disables omnidirectional functionality on the demand.
¢ Encryption—Choose an option from the Encryption drop-down list.
- Yes—Enables encryption functionality on the demand.
— No—Disables encryption functionality on the demand.
~

Note The Encryption option is available only if you have selected I0GE LAN PHY, OTU2e or
OTU?2 as Service Type in Step 4.

Step9  Complete the following in the Interface/Card Type area. The options available are based on the service
type selected in Step 4.

¢ Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.

- If you have selected 10GE LAN PHY, OTU2e, or OTU2 as Service Type in Step 4 and enabled
encryption in Step 8, then, the encryption feature is available in the WSE-Txp Mode card. If you
choose not to encrypt, this card is still available and is used without encryption.

If you have selected the Service Type as LAN-WAN Conversion in Step 4, when you expand
Transponder, select any one of the following OTU2-XP LAN-WAN modes:

— OTU2-XP- Mixed Mode—Select the card type as OTU2-XP Mixed Mode if the Protection type
is either Unprotected, Client 1+1, or PSM-OCH.

— OTU2-XP- Txp Mode—Select the card type as OTU2-XP Txp Mode if the Protection type is
either Unprotected, Client 1+1, or PSM-OCH.

— OTU2-XP- Splitter Mode—Select the card type as OTU2-XP Splitter Mode if the Protection
type is Fiber-Switched.

e Line Card—Click to expand, then check the card type check box to select the card at the end sites
of the service channels. For a list of line cards supported for specific service types, see the
“1.1.2.5 Service Support” section on page 1-6.

e Alien Card—Appears only if you created a third-party interface as described in the “1.6.5 Defining
Third-Party DWDM Interfaces” section on page 1-35. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

e Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.
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Step 14
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In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

~

Note In the LAN-WAN Conversion mode, CTP automatically selects the Source and Destination
client interface type if you have not selected the Source and Destination client interface type.

Click Finish. The Demand Editor dialog box appears.

The demand appears in the NtView name tab and in the Project Explorer pane in the

Service Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not
selected. The line has a number above it that indicates the number of channels present. Figure 2-6 shows
a selected one-channel P-ring between sites 1, 2, 3, and 5 with an optical bypass of site 4.

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-46.

Click OK to save the changes to the channels and close the Demand Editor dialog box, or Cancel to close
the dialog box without saving the changes.

To make changes to the demand parameters, see the “4.8 Editing a P-Ring Demand” section on
page 4-55, or click Cancel to close the Demand Editor dialog box.

Figure 2-6 P-Ring Demand
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2.1.7 Creating a ROADM Demand

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Step 8
Step 9

Note

Use the following procedure to create ROADM traffic groups and demands:

In the Project Explorer pane, under Nets, right-click the ROADM folder and choose New ROADM
Group. The ROADM Group Creation wizard appears.

Select the desired traffic subnet from the Traffic Subnet field. You can create a new traffic subnet if
desired using the “2.6 Creating Traffic Subnet” section on page 2-17.

Enter the ROADM traffic group name in the Group Name field.
Check the desired sites.

Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer
pane.

Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut
menu. The Create ROADM Demand dialog box appears (Figure 2-7).

Figure 2-7 Create ROADM Demand Dialog Box
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(Optional) If you copied properties of an existing ROADM demand, click Use Template to use the
properties of the copied ROADM demand.

Enter a name for the demand in the Demand Name field.

Select a traffic pattern type (Hub, Meshed, or Ring) from the Traffic Type drop-down list:
e Hub—If you select Hub, select the originating site from the First Site drop-down list.
e Meshed—If you select Meshed, go to Step 10.

e Ring—If you select Ring, select Routing Strategy as either Unprotected Minimum Hop,
Unprotected Optimum Path, or Unprotected Subnet, and proceed to Step 11

Refer to the “1.1.5.2.3 ROADM Traffic Demands” section on page 1-13 for more information on the
connectivity choices.
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Step10 Select a routing strategy from the Routing Strategy drop-down list: Protected, Unprotected Minimum
Hop, Unprotected Optimum Path, or Unprotected Subnet. If you chose Unprotected Subnet, continue
with the next step; otherwise proceed to Step 12.

Step11  If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed
from the drop-down lists.

Step12 In the Service Types list, check the boxes for one or more client service types for the ROADM demand.
The client interfaces that support each service type appear in the table to the right of the Service Types
list. For a list of line cards supported for specific service types, see the “1.1.2.5 Service Support” section
on page 1-6.

Step13  Check the OmniDirection check box to enable the omnidirectional property for the ROADM demand.

~
Note e The omnidirectional property is applied to the unprotected ROADM demand only when all the sites
in the ROADM group have a minimum of one omnidirectional side with two colorless ports on each
side.
e The omnidirectional property is applied to the protected ROADM demand only when all the sites in
the ROADM group has minimum two omnidirectional sides with two colorless ports on each side.
e When the ROADM demand is finalized, CTP shows the omnidirectional property as Yes irrespective
of the source or destination.
Step14  Check the Colorless check box to enable the colorless property for the ROADM demand.
~
Note e The colorless property is applied to the unprotected ROADM demand only when one line side with
one colorless port is available in each site.
e The colorless property is applied to the protected ROADM demand only when two line sides with
one colorless port are available in each site.
e Ifthere are no colorless ports on the line side but available on the omnidirectional side, CTP displays
an error message.
e When the ROADM demand is finalized, CTP shows the colorless property as Yes irrespective of the
source or destination.

Step15 To further define the client interfaces, complete the following options for each client interface listed in
the table. Check boxes in gray are not available for selection.

¢ Yes/No—Check to select this card to implement the service type.

¢ Client Interface—(Display only) Displays the card type for the selected service type.

¢ Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

)

Note  Y-cable protection is not available for encrypted traffic types.
¢ 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.
e Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.
e Supported Service—(Display only) Displays the service types supported for the card.

Cisco Transport Planner DIWDM Operations Guide, R10.1
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You can select more than one client interface to support the same service type. By default,
Cisco Transport Planner checks the best client interface to support each service.

Step16 Click OK to create the demand. Figure 2-8 shows an example of ROADM Demand.

Figure 2-8 ROADM Demand
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Step17 Copy ROADM demand properties. The following properties are copied:
e Traffic Type
e Routing Strategy
e Service Types
* OmniDirection
¢ Colorless
e DWDM Card Interface table (Yes/No, Client Interface, and Protection Type columns)

These properties can be used as a template while creating a new ROADM demand or editing an existing
one. To copy the properties, select the ROADM demand, right-click, and choose the Copy Properties
option. When the ROADM demand properties are copied, the Use Template button is enabled in the
Create ROADM Demand and Edit ROADM Demand dialog boxes.

Note e The Copy Properties option is not available when you log out of the CTP session.

¢ ROADM demand properties copied from Release 8.5 and later can be used in an upgraded network
up to Release 10.1.

¢ ROADM demand properties copied in the later releases (for example, Release 10.1) is not available
in the earlier releases (for example, Release 9.1).

Step18  Analyse the network.
Click the Analyze Network icon in the toolbar.
Step19 Finalize the Any-to-Any demand. Perform one of the following:
e To finalize Any-to-Any demand in design-analyzed state, complete Step 20.

¢ To finalize Any-to-Any demand in upgrade state, complete Step 21.
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Step20 To finalize Any-to-Any demand in design-analyzed state, complete the following steps:

Click the Finalize Any-to-Any traffic icon in the network view toolbar or right-click the ROADM
group in the Project Explorer and choose the Finalize Connectivity option. The Finalize
Any-to-Any Traffic window appears.

Click Please select a Site or Click here in the left pane to select the required connectivity (for
example, Sitel - Site2). Click OK.

Select a card listed under the ROADM demand and click the Finalize button. The ROADM Finalize
Connectivity wizard appears.

On the General Parameters page, complete the following:
- Label—Enter the name of the demand.

— Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-6.

— Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

— Forecast # ch—Enter the number of channels to be installed at a later date. This value includes
the Present # ch value.

In the Platform area of the Platform Parameters page, complete the following:

— Choose the protection type from the drop-down list: Y-Cable Protected, or Client 1+1. For
more information on protection types, see the “1.1.2.4 Protection Scheme Support” section on
page 1-4.

— Encryption—Choose an option from the Encryption drop-down list.
In the 454DWDM area, complete the following:

— Transponder—Click to expand, then check the card check box to select the card at the end sites
of the service channels. If you have chosen Yes for Encryption in the platform area, select the
WSE-Txp Mode card to enable encryption.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and
destination from the Source and Destination drop-down lists. This option is available for
transponder and muxponder interfaces that have pluggable client interfaces, which depend on the
selected service type and card type.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete
the parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-46.

Click OK to save the changes to the channels and close the Demand Editor dialog box, or Cancel to close
the dialog box without saving the changes.

Click Close to exit the Finalize Any-to-Any Traffic window.
Analyse the network again. The A2A Finalization Report appears.
Click OK to complete the finalization.
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~

Note  When the network state is changed, demands that were finalized before the change in the
network state are deleted.

Step21 To finalize Any-to-Any demand in upgrade state, complete the following steps:
a. Upgrade the analyses network.

b. In the upgraded network, go to the card listed under the ROADM demand, select the required
connectivity (for example, Sitel - Site2), right-click and select the Finalize connectivity option. The
ROADM Finalize Connectivity wizard appears.

c. Perform Steps 20d through 201.
d. Analyse the upgraded network again.
The demands that were finalized appear in the reports.
Step22 To edit any Any-to-Any finalized demand, complete the following steps:
a. Click the Mgmt Tree tab and right-click the analyzed network.
b. Choose A2A Finalized Circuits from the drop-down list. The A2A Finalized Circuits tab appears.

c. Select any Any-to-Any Finalized demand and click Edit on the toolbar or double-click the demand
in The A2A Finalized Circuits tab. CTP prompts to unlock the network. Choose Yes to open the
demand editor. The network is set to Any-to-Any Finalization mode on unlocking the demand.
Modify as required and click OK to close the demand editor.

Note e CTP does not allow the card type to be edited in Any-to-Any Finalized demand.
¢ When multiple demands are selected in the A2A Finalized Circuits tab, the Edit option is disabled.

Step23 Finalize the demand again for the changes to be reflected in the A2A Finalized Circuits report.
Step24 To delete any Any-to-Any finalized demand, complete the following steps:
a. Click the Mgmt Tree tab and right-click the analyzed network.
b. Choose A2A Finalized Circuits from the drop-down list. The A2A Finalized Circuits tab appears.

c. Select any Any-to-Any Finalized demand and click Delete on toolbar in The A2A Finalized Circuits
tab. CTP prompts to confirm deletion. Choose Yes to delete the selected demand.

~

Note  When multiple demands are selected in the A2A Finalized Circuits tab, the Delete option is
disabled.

2.1.8 Creating Ethernet Aggregated Demands

An Ethernet aggregated demand is a collection of low-rate Gigabit Ethernet/10Gigabit Ethernet services
that can be aggregated on a single 10-Gbps wavelength division multiplexing (WDM) trunk. This
demand is supported only by the GE_XP, 10GE_XP, GE_EXP, and 10GE_EXP cards when configured
as an L2-Switch.
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The Ethernet Aggregation Creation wizard allows you to:

Create one WDM transport channel at a time over a predefined traffic subnet.

Specify the wavelength to be used for the channel, and define a list of locations with add/drop VLAN
circuit capability.
Create a set of desired VLAN circuits on this WDM transport channel.

The check functionality generates a report showing for each section of the subnet where the WDM
transport channel is over allocated and then perform corrective action when required.

The clone functionality creates an identical copy of the current WDM transport channel with the
same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.

Use the following procedure to create Ethernet aggregated demands:

In the NtView name tab, click the Create new AggregatedEthernet demand icon in the toolbar. For
more information about Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.” The EthernetAggr Creation wizard appears.

Choose the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired (see 2.6 Creating Traffic Subnet, page 2-17).

Click Next. The General Parameters page appears.

In the General Parameters pane, enter values in the following fields:

Label—Enter the name of the demand. The default value is EthernetAggrl.

Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.

Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-20.

— Auto—(Default) Disables colorless functionality on the demand.
- Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

Omni-directional—Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-19.

— Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

— Yes—Enables omnidirectional functionality on the demand.

— No—Disables omnidirectional functionality on the demand.

Click Next.

In the Sites selection pane, complete the following tasks:

In the Protection Sites area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.
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¢ In the Optical Bypass area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. Click the right arrow button. To remove a site added to the list, click the site
and click the left arrow button. If the Present/Forecast check box is checked, you cannot select
Optical Bypass sites. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

Step7  In the Node Configuration selection pane, enter values for the following options:

e DWDM Trunk—Select the DWDM trunk type. You can specify the kind of WDM trunk interface
for the card in each add/drop site. Allowed values are:

Auto
w/EFEC
w/FEC
w/o FEC

e Wavelength—Select the WDM transport channel wavelength. This option allows you to force the
current WDM transport channel wavelength. Wavelengths are listed based on the selected band.
Allowed values are:

Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the
other set of constraints.

C band-32 ch.odd
L band- 32 ch.odd
C band- 40 ch
C band- 64 ch
C band-72 ch
C band- 80 ch

¢ New CFG—Choose the desired card type for each of the protected sites.

Step8  Click Finish. The name Demand window appears (Figure 2-9).
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Figure 2-9 EthernetAggr1 Demand Window, TrafficTab

e EthernetAgar1 Demand

|5 Clone ﬁ Check

~ Traffic | DWDM channel

e s s EEE] S ED B

aL Label F Sre Sike Dst Site Rate Client Prot Trunk Prok Message

B -~ = = <& > g
=

Close g

ol

Step9  Click Close.

Step10 To add a circuit, right-click the Ethernet Demand in the Project Explorer pane and choose New point to
point request. The New Request window appears (Figure 2-10).
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Figure 2-10 New Request Window
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Step11  The New Request window contains four areas of information: Quantity, General, Src, and Dest.

Quantity Area
Quantity—Enter the number of circuits to be created.

General Area
e Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.

e Trunk Protection—Enter the trunk protection type. Allowed values are:
— Unprotected

— Protected

e P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.

e Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:

— Auto—(Default) Causes the tool to automatically define the trunk path.

— Side x—Represents the label of the side on the Src site where the circuit is routed.
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¢ (lient Protection—Allowed values are:
- Unprotected
— Client 1+1

e Circuit rate—Displays the allowed circuit rates.

Src Area
e Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.

e SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

e (Card—Select the Card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Src area contains Working and Protected subareas.
Working sub-area

e Port CIR—Select the Committed Information Rate (CIR), with 1 being the highest and 0.1 being the
lowest.

e Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

e Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Protected sub-area
These fields are enabled only if client protection is enabled in the Client Protection field.
e Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

e Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

e Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Dest Area

e Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

e SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

e (Card—Select the card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Dest area contains Working and Protected subareas.
Working sub-area
e Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

e Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

e Port Num—Select the port number. Allowed values are Auto, and 1 to 20. Auto allows the tool to
select an appropriate port number based on other constraints.
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Protected sub-area

These fields are enabled only if the client protection is enabled in the Client Protection field.

Port CIR—Select the CIR, with 1 being the max and 0.1 being the lowest.

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Port Num—Select the port number. Allowed values Auto, 1, to 20. Auto allows the tool to select an
appropriate port number based on other constraints.

Step12 Click OK.
Step13 The Traffic tab displays the following details about the circuit:

AL—Displays the alarm (if any) for the circuit.

Label—Displays the name of the circuit.

F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.
Src Site—Displays the source site.

Dst Site—Displays the destination site.

Rate—Displays the circuit rate/bandwidth.

Client Prot—Displays the client protection scheme.

Trunk Prot—Displays the trunk protection scheme.

Message—Displays a message related to the circuit.

Step14  If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Step15 Click the Check tab in the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-11). The Report tab
displays, in a row, each of the sites on the subnet, and each span in between.
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Figure 2-11 Circuit Path View in a Ethernet Aggregated Demand
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Step16 The Traffic Result tab displays the following:

Label—Displays the name of the circuit.

F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.

Src Site—Displays the source site.
Dst Site—Displays the destination site.

Trunk Protection—Displays the trunk protection scheme.

Creating a Demand I

Path Forcing—Displays the output Node interface. If no client or trunk protection is used, displays

NA.

Client Protection—Displays the client protection scheme.

Circuit Rate—Displays the circuit rate/bandwidth.

Src Wrk Port Num—Displays the source working port number.

Src Prt Port Num—Displays the source protect port number.

Dst Wrk Port Num—Displays the destination working port number.
Dst Prt Port Num—Displays the destination protect port number.

Src Wrk Port CIR—Displays the source working port CIR. The highest is 1 and O the lowest.

Src Prt Port CIR—Displays the source protect port CIR. The highest is 1 and O the lowest.

Dst Wrk Port CIR—Displays the destination working port CIR. The highest is 1 and O the lowest.
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e Dst Prt Port CIR—Displays the destination protect port CIR. The highest is 1 and 0 the lowest.

e Src Wrk Port Rate-Reach—Displays the PPM for the source working port. For example, Rack
1.Shelf 1. Slot 5.

e Src Prt Port Rate-Reach—Displays the PPM for the source protect port. For example, Rack 1.Shelf
1. Slot 4.

e Dst Wrk Port Rate-Reach—Displays the PPM for the destination working port.
e Dst Prt Port Rate-Reach—Displays the PPM for the destination protect port.

¢ Src Card—Displays the source card.

e Dst Card—Displays the destination card.

e Working Src Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the working
source card.

e Working Dst Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the working
destination card.

e Protecting Src Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the protect
source card.

e Protecting Dst Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the protect
source card.

e Alarm—Displays the alarm status.

Step17 To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.10 Creating a Regeneration Site” section on page 2-46.

Step18 Click Close. To edit circuits, see the “4.10 Editing an Ethernet Aggregated Demand” section on
page 4-60.

2.1.9 Creating TDM Aggregated Demands

A TDM aggregated demand is a collection of low-rate SONET and Gigabit Ethernet services that is
aggregated on a single 10-G WDM trunk. The TDM aggregated demand is a specific service demand that
is carried only by the ADM-10G card.

The TDM Aggr Creation wizard allows you to:
¢ Create one WDM transport channel at a time over a predefined traffic subnet

e Specify the wavelength to be used for the channel, and define a list of locations with add/drop STS
circuit capability.

e Create a set of STS circuits on this WDM transport channel to pass traffic.

¢ The check functionality generates a report showing, for each section of the subnet, where the WDM
transport channel is over allocated and then perform, when required, the corrective action.

The total amount of bandwidth used by all the defined circuits in each section of the WDM transport
channel cannot exceed the maximum channel capacity of STS-192c. Sections exceeding the maximum
capacity are colored red in the report. Demands that fail the check are flagged as invalid demands and
the Analyzer stops.
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The clone functionality allows you to create an empty copy of the current WDM transport channel, with
the same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.

Use the following procedure to create TDM aggregated demands:

Step 1 In the NtView name tab, click the Create new TDM Aggregated demand icon in the toolbar. For more
information about CTP icons, see Appendix A, “GUI Information and Shortcuts.”
The TDMAggr wizard appears.

Step2  Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired using (see 2.6 Creating Traffic Subnet, page 2-17).

Step3  Click Next. The General Parameters page appears.
Step4  In the General Parameters pane, complete the following tasks:
¢ Label—Enter the name of the demand. The default value is TDMAggrl.

e Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.

¢ Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-20.

— Auto—(Default) Disables colorless functionality on the demand.
— Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

¢ Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-19.

— Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

- Yes—Enables omnidirectional functionality on the demand.
— No—Disables omnidirectional functionality on the demand.

Step5  Click Next.
Step6  In Sites selection pane, complete the following tasks:

¢ In the Protection Sites area, press Ctrl and click the sites that you want to add to the TDM
aggregated demand. A TDM aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.

e In the Optical Bypass area, press Ctrl and click the sites that you want to add to TDM aggregated
demand. Click the right arrow button. To remove a site added to the list, click the site and click the
left arrow button. If the Present/Forecast check box is checked, you cannot select Optical Bypass
sites. A channel in optical bypass is dropped on one side of the node and added on the other side of
the same node to allow the future use of that node as an add/drop location.

Step7 In the Node Configuration selection pane, complete the following tasks:

e DWDM Trunk—Select the DWDM trunk type to specify the kind of WDM trunk interface for the
card in each allowed add/drop site. Allowed values are:

- Auto
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- w/EFEC
- w/FEC
- w/o FEC

¢ Wavelength—Allows you to force the current WDM transport channel wavelength. Allowed values

are:

— Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the

other set of constraints.
— C band-32 ch.odd
— L band- 32 ch.odd

- C band- 40 ch
- Cband- 64 ch
— Cband- 72 ch
— C band- 80 ch
Step8  Click Finish. The name Demand window appears (Figure 2-12).
Figure 2-12 TDMAggr Demand Window
x
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Step9  Click Close.
Step10 To add a circuit, right-click the Ethernet Demand in the Project Explorer pane and choose New point to

point request. The New Request window appears (Figure 2-13).
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Figure 2-13 New Request Window
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The New Request window contains four areas of information: Quantity, General, Src, and Dest.

Quantity Area

Quantity—Enter the number of circuits to be created.

General Area
e Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.

e Trunk Protection—Enter the trunk protection type. Allowed values are:
— Unprotected
- UPSR

e P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.

e Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:

— Auto—(Default) Causes the tool to automatically define the trunk path.
— Side x—Represents the label of the side on the Src site where the circuit is routed.

¢ C(Client Protection—Allowed values are:

| oL-29753-01
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— Unprotected
- 1+1 APS

e Circuit rate—Displays the allowed circuit rates.

Src Area
e Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.

e SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

e (Card—Select the Card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.

The Src area contains Working and Protected sub-areas.
Working sub area

e Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.

In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands.
Following are the guidelines to use port 17:

— Port 17 must be selected only when the ADM-10G card is used in a single-card configuration.

— Port 17 supports the circuit rates VC4-64C/STS-192C. It also supports the circuit rates from
STS1/VC4 to STS-48c/VC4-16¢ or a combination of them.

— For circuit rates VC4-64C/STS-192C with the port number as Auto, port 17 automatically
becomes the source and the destination port. Port 17 will not be selected for any other circuit
rate unless the user specifically forces the port.

— Port 17 supports UPSR Client Protection on ANSI platform and SNCP client protection on ETSI
platform, except for the circuit rates VC4-64C/STS-192C.

e Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.

Protected sub area
The following fields are available only if client protection is enabled:

e Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.

You can force port 17 as protected source or destination port for Client UPSR/SNCP protection with
circuit rates less than VC4-64/STS-192c.

e Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.

Dest Area
e Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

e SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

e (Card—Select the card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.
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Step 15
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The Dest area contains Working and Protected sub areas.
Working sub area

e Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.

In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands. The
guidelines to use the port are the same as given in the Working sub area for source ports.

¢ Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Protected sub-area

e Port Num—Select the port number. Allowed values are Auto and 1 to 16. Auto allows the tool to
select an appropriate port number based on other constraints.

e Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Click OK.

If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Click the Check tab on the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-14). The report shows, in
a row, each of the sites on the subnet, and each span in between.

Figure 2-14 Circuit Path View in a TDM Aggregated Demand
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To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.10 Creating a Regeneration Site” section on page 2-46.

Click Close. To edit circuits, see the “4.11 Editing a TDM Aggregated Demand” section on page 4-64.
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2.1.10 Creating a Regeneration Site

A regeneration site is required when the optical communications link has to span long distances. The
optical signal has to be regenerated when the optical signal-to-noise ratio (OSNR) goes beyond a critical
limit. After a network is analyzed, the Optical Results highlights if any site requires regeneration. For
more information about optical results, see the “3.2.10 Viewing Optical Results” section on page 3-24.

Use the following procedure to create a regeneration site in the network.

Note A regeneration site cannot be a site with the functionality as OLA, OSC, pass-through, or hub.

Note  The Regeneration... icon is active only when you select a trail in the Demand Editor.

Step1  In the Demand Editor, click the Regeneration... icon in the toolbar. The Regeneration Editor appears,

Figure 2-15. For more information about Cisco Transport Planner icons, see Appendix A, “GUI
Information and Shortcuts”.

Figure 2-15 Regeneration Editor
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Step 2 In the Available Sites area, choose the site and click the down arrow icon. To remove a site added to the
Regeneration Sites list, choose the site and click the up arrow icon.
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Note

Step 5

Step 6

Step 7

Note
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When adding more than one regeneration site to the path, ensure the regeneration sites are added in the
correct sequence to avoid unfeasible routing. For example, if you create a point-to-point demand from
sitel (source) to site 3 (destination), the sites available in the path are site 4 and site 5. Site 5 must be
selected first, followed by site 4, because site 5 is closer to site 1.

To sort the regeneration sites in the list, use the up and down arrow icons located on the left.

If you chose a source or destination card for a regeneration site, choose the card type for the site from
the drop-down list. The regeneration cards that are compatible with the source and destination cards are
displayed in the interface.

The OTU2_XP card has four modes. For more information on these modes, refer to the
“2.7.10.1 Configurations for OTU2_XP” section on page 2-48.

The encryption card (WSE-Txp Mode) is available in the card drop-down list only if you have selected
OTU2e as the service type during demand creation.

Colorless— Choose an option from the drop-down list. Colorless traffic demands are terminated at
colorless add/drop ports, so that, these demands can be tuned in all possible wavelengths without
changing the optical interface of the port.

~

Note  These values apply only to the selected trail.

e Auto—(Default) Disables colorless functionality on the demand.
¢ Yes—Enables colorless functionality on the demand.
e No—Disables colorless functionality on the demand.

Omnidir Src Side, Omnidir Dest Side— Choose an option to enable omnidirectional functionality on a
source or destination side. An omnidirectional side allows routing of the added and dropped traffic in all
the possible directions associated to Line sides.

¢ Auto—(Default) Disables omnidirectional functionality on the sides.
¢ Yes—Enables omnidirectional functionality on the sides.
e No—Disables omnidirectional functionality on the sides.

Click OK.

To allow different wavelengths to be used for regeneration, choose the Allow different wavelengths
option in the Properties pane in Net > Options > Traffic Mapping > System Release 10.1.
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2.1.10.1 Configurations for 0TU2_XP

The OTU2_XP card operates in six different configurations as shown in the following table:

Configuration Card listed as |Port 1 Port 2 Port 3 Port 4

Dual Transponder |OTU2-XP-Txp |Client port |Client port2 |Trunk port 1 Trunk port 2
2 x 10G mode 1

transponder)

Dual Regenerator |OTU2-XP- Trunk port 1 |Trunk port 2 |Trunk port 1 Trunk port 2

(2 x 10G standard Regen mode
regenerator with

enhanced FEC
[E-FEC] only on
one port)
Single Regenerator | OTU2-XP- Not used Not used Trunk port Trunk port
(1x 10G E-FEC  Single Regen
. mode
regenerator with
E-FEC on two
ports))
10 GE LAN Phy to |OTU2-XP- Client port |Client port |Trunk port Trunk port in
WAN Phy Tx.p mode in Note In a Multi transponder or
Mixed mode transponder trunk card. |regenerator
Splitter mode or trunk port the LAN " |configuration.
mn port is
regenerator always on
configuratio Portl. and
n not on port
2.
Protected OTU2-XP- Client port |Not used Trunk port Trunk port
Transponder Splitter mode (working) (protect)
(1 x 10G splitter
protected
transponder)
Mixed Mode OTU2-XP- Client port |Trunk port4 |Trunk port 1 Trunk port 2
(1x 10G Mixed mode without without FEC or without FEC
FEC or with |with FEC or or with FEC
transponder and 1 x
FEC E-FEC or E-FEC

10G standard
regenerator)

2.7.10.1.1 Dual Transponder (0TU2-XP-Txp)

You can configure the OTU2_XP card as a dual transponder (Figure 2-16). When configured as a dual
transponder (OTU2-XP-Txp), the card supports two completely independent bidirectional 10-Gbps
services. Port 1 and Port 2 support traffic from or to port 3 and port 4, respectively. Both paths are
completely independent and can support different services. G.709 wrapping or unwrapping and FEC
correction capability can be independently activated on each path.
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Figure 2-16 Dual Transponder Configuration
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You can assign one the following service types as the client:

¢ 0OC-192/STM64
e 10GE WAN-PHY
e 10GE LAN-PHY

e 10G-FC

¢ LAN-WAN Conversion

NOFEC
FEC
EFEC

273488
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You can set one of the following trunk modes on both trunks for any of the service types:

e No FEC
e FEC
e E-FEC

2.1.10.1.2 Dual Regenerator (0TU2-XP-Regen)

You can configure the OTU2_XP card as a dual regenerator (Figure 2-17). When configured as a dual
regenerator (OTU2-XP-Regen), the unit regenerates two completely independent bidirectional 10-Gbps
signal paths (similar to the OTU2-XP-Txp configuration). In this configuration, all four ports support
DWDM XFPs. You can also independently set G.709 framing and FEC capability for all four ports. You
can enable E-FEC encoding only on ports 3 and 4.

Figure 2-17
Trunk 1 €« - - —-»
Trunk2 <« — - ->»

Dual Regenerator Configuration

1 3

I » < — — —» Trunk 3
OTU2_XP

I S »|<« - — -» Trunk 4

2 4

NOFEC
FEC
EFEC

273489

You can use the following combinations of trunk modes according to the framing of the service to be

regenerated:

e OC-192/STM-64 service type:
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— Trunk ports 1 and 2: No FEC
— Trunk ports 3 and 4: No FEC
e OTU-2 service type:
— Trunk ports 1 and 2: FEC
— Trunk ports 3 and 4: FEC
or

— Trunk ports 1 and 2: E-FEC
— Trunk ports 3 and 4: FEC

2.7.10.1.3 Single Regenerator (0TU2-XP- Single Regen)

You can configure the OTU2_XP card as a single regenerator (Figure 2-18). When configured as a single
regenerator (OTU2-XP- Single Regen), the card regenerates only one bidirectional 10-Gbps signal path.
The ports 3 and 4 support DWDM XFPs and G.709 framing as well as E-FEC.

Figure 2-18 Single-Regenerator Configuration
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2.7.10.1.4 Protected Transponder (0TU2-XP- Splitter)

You can configure the OTU2_XP card as a protected transponder (Figure 2-19). When configured as a
protected transponder (OTU2-XP- Splitter), the card implements the fiber-switched protection. In this

configuration, the client service on port 1 is transmitted to ports 3 and 4 and then on to both trunks. Only
one signal received from the two trunks on ports 3 and 4 is transmitted to port 1 (the signal from the other
port is only monitored). After detecting a failure on one trunk, the unit automatically switches on the

other port, which restores the signal on port 1. In protected-transponder configurations, port 2 is always
disabled.
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Figure 2-19 Protected-Transponder Configuration
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You can set one of the following service type for the client port:
e 0OC-192/STM64
e 10GE WAN-PHY
¢ 10GE LAN-PHY
¢ 10G-FC
¢ LAN-WAN Conversion
You can set one of the following trunk modes on both trunks for any of the service types:
e No FEC
e FEC
e E-FEC

2.7.10.1.5 Mixed Mode (0TU2-XP- Mixed)

You can configure the OTU2_XP card in mixed mode (Figure 2-20). When configured in mixed mode
(OTU2-XP- Mixed), the card is a regenerator on one set of the ports and a transponder on the other set.
The two sets are completely independent and can be configured to transmit or regenerate different
services. You can independently set G.709 framing and FEC capability on each trunk port, but ports 1
and 2 cannot have E-FEC encoding.

Figure 2-20 Mixed-Mode Configuration
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You can swap the configuration of the two sets, that is, ports 1 to 3 set as the regenerator and ports 2 and
4 as the transponder.

You can set one of the following service types for the client port:
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e 0OC-192/STM64
e 10GE WAN-PHY
e 10GE LAN-PHY
¢ 10G-FC
e OTU2
¢ LAN-WAN Conversion
You can set one of the following trunk modes on all the trunks for all service types:
e No FEC (all)
e FEC (all)
e E-FEC (only to ports 3 and 4)

CTP does not automatically select mixed mode for OTU2_XP cards. You need to select mixed mode for
an OTU2_XP card to force it.

The FI and FC demands are not supported on port 2 as a source when the LAN-WAN traffic is fed as a
source on port 1.

For further information on the OTU2_XP card, refer to the Cisco ONS 15454 DWDM Configuration
Guide, Release 9.6.x.

2.8 Viewing Circuits in a Network

You can view all the circuits that have been created in any of the Service Demands folders in the Traffic
tab of the Net1 tab.

The following columns are displayed:

¢ SA—Indicates the system alarms that affect the circuit. This indication is available only after the
network is analysed.

e AL— Indicates the optical alarms that affect the circuit.This indication is available only after the
network is analysed.

e F—Indicates if the demand will be needed in the future.

e Demand —Displays the name of the demand.

e Group—Displays the demand group to which the circuit belongs.

e Label —Displays the label of the circuit.

e TMSubnet—Displays the name of the traffic subnet in which the circuit is defined.
¢ SrvType— Displays the service type value.

e Sites—Lists the add/drop site.

e Card/TrunkType—Displays the card type and trunk type.

e Protection type— Displays the protection type of the demand.

¢ Wavelength —Displays the assigned wavelength.

¢ Encryption—Displays whether the traffic is encrypted or not.
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You can edit the circuits for any demand by double-clicking the circuit or by choosing the circuit and
clicking the Edit button in the toolbar.

Use any one of the following options to group and order the circuits:

e Type\Demand\Group— The circuits are first grouped and ordered by demand name. Each set of
circuits with the same demand name is then ordered by the group name.

e  SrvType\Type\group—The circuits are first grouped and ordered by service type. Each set of circuits
with the same service type is then ordered by the group name.

You can also select a set of fields in a particular order in the Group by dialog box to build a grouping
rule to be applied to the table.

2.9 Analyzing the Network

Step 1
Step 2

Step 3

Step 4

Note

After you have created the desired sites, fiber spans, and service demands, you must analyze the network
to determine network performance. The network must be in the Design, Install, or Upgrade state before
you can analyze it. Cisco Transport Planner automatically optimizes the design and summarizes the
optical transmission performance. If there are problems with the design, Cisco Transport Planner lists
the problems and descriptions in the Analyzer Messages pane.

Use the following procedure to analyze the network:

Click the Mgmt Tree tab, and click the network that you want to analyze.

Click the Analyze Network icon in the toolbar. For more information about the Cisco Transport Planner
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks
Pane.

The Cisco Transport Planner analysis status bar indicates when the network analysis is complete.

If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer
Messages pane. The Summary report appears. See the “3.2.1 Viewing the Summary Report” section on
page 3-2 for more information. Warning and error messages help you identify problems with your
current design. For a list of all system messages, see Appendix C, “System Messages.”

If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the
network, you can analyze the network again.

You can return a Design-Analyzed network to the design state to make further changes by clicking the
network icon in the Mgmt Tree and clicking Design in the Tasks Pane.

2.9.1 Viewing the Site Functional View

The Site Functional View displays a graphical view of the circuit connections, optical power, alarms, and
signal loss of a selected site. After you have created the desired sites, fiber spans, and service demands,
and analyzed the network, you can now view the Site Functional View. All the cards in each side are
grouped together.
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You can view the site functional view in either of the following ways:
e Right-click on the Site in the Project Explorer pane and select Open Site Functional View.
¢ In the Network view, right-click on the Site and select Open Site Functional View.
e Select the Site in the Network view and click Open Site Functional View in the Tasks Pane.

The Site Functional View of a selected site is displayed in a new tab. Double-click a side to see the details
of that side. To return to the normal view, right-click on the side and click Close Node.

2.9.1.1 Changing the View

You can change the view of the graphical display to view the layout information in detail. Right-click
on the sides of the image (grey area outside the image) to change the view.

You can select the following:
e Fit to View—Fits the side view into the available display space.
e Zoom In—Magnifies the view of the graphical display.
e Zoom Out—Shrinks the view of the graphical display

2.9.1.2 Alarm Information

Within the side display, an alarm box is shown that gives the alarm count for the Critical (CR), Major
(M1J), and Minor (MN) alarms that affect that side. The alarm associated with the card is indicated to
reflect the severity of the alarm (red, orange, and yellow).

2.9.1.3 Transponder and Muxponder Connections

All the transponder and muxponder cards with the patchcords are grouped together. To open and view
the transponder and muxponder connections, right-click the patch panel and select Open Patch Panel.

2.9.2 Viewing the Site Connection View

The Site Connection View displays a graphical view of the connections between various cards.
You can view the site functional view in either of the following ways:

¢ Right-click on the Site in the Project Explorer pane and select Open Site Connection View.

¢ In the Network view, right-click on the Site and select Open Site Connection View.

e Select the Site in the Network view and click Open Site Connection View in the Tasks Pane.

The Site Connection View of a selected site is displayed in a new tab. Use the Export Graph option to
export the view as an image file.

2.10 Managing the Network Design

After creating and analyzing a network design, you must prepare the design for installation at a customer
site. After a network has been installed, you can reanalyze to correct any problems.
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A tooltip is displayed when a network is selected for a copy, upgrade, release upgrade, install, or
upgrade to design operation.

Network designs have several possible states:

Design—The initial state for any new network design. You can add, delete, or change any aspect of
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back
into the Design state to modify it by choosing Design in the Tasks Pane.

Design-Analyzed—The state of the network design after you run the network analyzer. All reports
are available and updated. You cannot change any aspect of the network design. You can modify the
BoM, such as changing global discounts and spare parts. You can return to the Design state after
analyzing the network by choosing Design in the Tasks Pane.

Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for
testing different design options. You can copy a network before or after analyzing it. A copied
network inherits the set of project options defined in the original network. For more information,
see the “2.10.1 Creating a Copy of the Network™ section on page 2-55.

Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.).
When a network is installed in the field, you can move the network into the Install state so that you
can enter and check the real fiber parameter values. You can create an Install network from a network
in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits the set of
project options defined in the analyzed network. All sites in an Install network are locked. You
cannot modify any aspect of the network design except the span parameters and (on unlocked sites)
amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be changed
while in this state. For more information, see the “2.10.3 Creating a Network in the Install State”
section on page 2-56.

Install-Analyzed—The state of the Install network design after you run the network analyzer. All
reports are available and updated. Cisco Transport Planner locks all sites, spans, demands, and
equipment when a network is in the Install-Analyzed state.

Upgrade—During network design, you define a number of the channels to be implemented at the
present time and a number of channels to be implemented in the future (forecast). After installing
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade
network and then select the forecast or traffic demand services that you want to implement. You can
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You
can unlock specified parameters to alter the design to include forecasted channels and traffic
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed
network. For more information, see the “2.10.4 Creating an Upgrade Network” section on

page 2-56.

Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer.
All reports are available and updated. Cisco Transport Planner locks all sites, spans, demands, and
equipment when a network is in the Upgrade state.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “1.4.1 Opening a Project” section on page 1-18 and the “1.4.2 Loading and Unloading Networks”
section on page 1-19.

2.10.1 Creating a Copy of the Network

To create a copy of a network in any state, right-click the network and choose Copy from the shortcut
menu. A new copy appears in the Network Mgmt Tree tab.
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Cisco Transport Planner DWDM Operations Guide, R10.1 g



Chapter2  Creating and Analyzing Networks |

Il Managing the Network Design

2.10.2 Creating a Copy of the Network in Design State

To create a copy of a network in the design state, right-click the network and choose the

Upgrade to Design option from the shortcut menu or click Copy & Go back to Design Mode on the
toolbar. A new copy appears in the Network Mgmt Tree tab. This copy retains all the forcing options and
removes the reports, BoM, and output data.

The Upgrade to Design and Copy & Go back to Design Mode options are available only for networks
in “Upgrade” or “Upgrade Analyzed” state from Release 8.5 and later.

2.10.3 Creating a Network in the Install State

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Use the following procedure to create a network in the Install state:

If the network is not analyzed, complete the “2.9 Analyzing the Network™ section on page 2-53.
Click the Mgmt Tree tab.

Right-click the network and choose Install from the shortcut menu. A new network appears in the Mgmt
Tree in the Install state. All results from the analyzed network are imported into the Install network and
are placed in the Locked mode.

Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber
loss value, fiber CD, fiber PMD, and fiber length. See the “4.14 Editing Fiber Span, Pair, and Fiber
Parameters” section on page 4-69. Cisco Transport Planner also allows you to unlock site parameters for
modification. To change site parameters, see the “4.3 Editing Site Parameters” section on page 4-3.

In the Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.” The Transport
Planner Analyzer status window appears to indicate the progress. As an alternative, click Analyze in the
Tasks Pane. The Cisco Transport Planner analysis status bar indicates when the network analysis is
complete. The network now appears in the Install-Analyzed state.

~

Note If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages help you identify problems with your current design. For
a list of all system messages, see Appendix C, “System Messages.”

When you have analyzed the network and are satisfied with the results, import the new generated
installation parameters to each site of the network. For more information, see the “3.2.2 Saving the NE
Update File” section on page 3-4.

2.10.4 Creating an Upgrade Network

Step 1
Step 2

Use the following procedure to put a network in the Upgrade state:

If the network is not analyzed, complete Analyzing the Network, page 53.
Click the Mgmt Tree tab.
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Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network
appears in the Mgmt Tree tab. All results from the analyzed network are imported into the Upgrade
network.

Make the necessary changes to the Upgrade network. For more information, see the Editing Fiber Span,
Pair, and Fiber Parameters, page 69 and the “4.3 Editing Site Parameters” section on page 4-3.

In the Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information about
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.” The Transport
Planner Analyzer status window appears to indicate the progress. As an alternative, click Analyze in the
Tasks pane in any view. The Cisco Transport Planner analysis status bar indicates when the network
analysis is complete. The network now appears in the Upgrade-Analyzed state.

~

Note  If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages can help you identify problems with your current design.
For a list of all system messages, see Appendix C, “System Messages.”

In an Upgrade network, you can perform the following tasks:
¢ Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and
aging).
* Add or delete traffic
e Convert forecasted traffic to present traffic
¢ Finalize ROADM traffic to present traffic
e Modify the type of a node

¢ Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules,
OADM cards, and DCU modules)

In an Upgrade network, you can force certain installation parameters:
e Amplifier per-channel output power setpoint

e Amplifier output tilt setpoint

OADM card aggregate output power setpoint

Full multiplexer/demultiplexer or ROADM output power setpoint

~

Note If a network is analyzed in the Upgrade state when the cards are in the unlocked state, CTP
replaces any existing TCC2P card with a TCC3 card in the M12 shelf.

You cannot change the following parameters when in Upgrade state:
¢ Node input channel fail threshold
¢ Node OSC channel fail threshold
e Preamplifier input power threshold
e OADM card aggregate input power setpoint
¢ Full muxponder/demuxponder or ROADM input power setpoint
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~

Note

e Channel drop power
When upgrading a network that has a point-to-point demand, you can:

e Move Future circuits to become Present. This move can be done without unlocking the circuit.

e Add new, present, or future point-to-point services to the existing demand.

e Delete any present or future channel originally defined in the baseline network.

¢ Change any unlocked point-to-point circuit or unlocked point-to-point service demand parameter.
When upgrading a network that has an any-to-any demand, you can:

e Move any of the Any-to-Any (future) services to become Present. This move can be done without
unlocking the circuit.

¢ Create a new Any-to-Any demand on an already existing Any-to-Any group.
e Create a new Any-to-Any group.
e Delete an existing Any-to-Any demand from an Any-to-Any group.

e Delete an Any-to-Any group with all of its Any-to-Any demands.

Any-to-Any services that have been moved to Present will be represented as Point-to-Point services.

2.10.5 Unlocking Parameters in the Network Design

The Locked state occurs when no value is set for a parameter and Auto option is selected. During
network analysis, Cisco Transport Planner assigns a value for each parameter set with Auto and puts
them in the Locked state. The Locked state indicates that the next time the network is analyzed, the
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers,
boosters, add/drop filters, TDCU, and DCU units that the site/network requires as a result of running the
analyzer previously.

Locked elements are indicated by a closed padlock icon in the Project Explorer pane. For more
information on the Auto, forced, and locked states, see the “1.1.6 Auto, Forced, and Locked Parameters’
section on page 1-15.

>

To unlock network components, right-click the desired element in Upgrade or Install mode in the
Project Explorer pane and choose Unlock from the shortcut menu. You can unlock at the network level
or the site level or the element level. Unlocking items at higher level unlocks all elements under that
level.

2.10.5.1 Forcing Manager

Step 1

Forcing Manager enables you to unlock multiple interfaces connected to various ducts and sites. This
helps you unlock a group of sites and ducts based on individual units such as amplifiers, DCUs, add/drop
units, band parameters, and node layout.

For example, you can unlock all the amplifiers, TDCUs, and DCUs of all the sites in the network in one
go, with the help of Forcing Manager.

Use the following procedure to unlock multiple units in different sites/ducts:

Right-click the network folder in the Project Explorer pane and choose Forcing Manager from the
shortcut menu. The Forcing Manager dialog appears (Figure 2-21).
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To create a network in design mode, see 2.10.2 Creating a Copy of the Network in Design State.

To create an upgrade network, see 2.10.4 Creating an Upgrade Network.

Forcing Manger can be used in both the design mode and the upgrade mode.

Step2  Choose any one of the following options from the left pane of the Forcing Manager dialog:
e Sites—When a site is selected, all the interfaces under that site will be selected.
e Ducts—When a duct is selected, both the interfaces associated with the duct are selected.
The list of sites and ducts available for selection is displayed in the left pane. If you choose the option
sites, the list of ducts are disabled. When you choose ducts, the list of sites are disabled.
Figure 2-21 Forcing Manager Dialog Box
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Step3  Choose the required sites/ducts that need to be unlocked.
The network layout is displayed in the right pane of the Forcing Manager dialog. The chosen sites/ducts
are highlighted in a different color.
Step4  Click Select to select the individual units from the site/duct.
Step5  Click Close to the close the Forcing Manager dialog.
Step6  Click Help to display the Help content for CTP.
Step7  Clicking Select to open the Select Units to Force dialog box.
Cisco Transport Planner DIWDM Operations Guide, R10.1
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Figure 2-22 Select Units to Force Dialog Box
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Step8  Select any one of the following options from the Select Units to Force dialog box (Figure 2-22):
e Unlock Tree—Unlocks all the units from the selected sites/ducts.

¢ Unlock Individual Item—From the chosen sites/ducts, you can unlock one or more of the following
items:

— Amplifier units—Unlocking an amplifier will unlock the DCUs in a particular interface.
— TDCU—Can be unlocked without unlocking amplifiers.

— DCUs—~Can be unlocked without unlocking amplifiers.

— Add/Drop units

- WDM-ANS Optical Parameters

— NodeLayout—Unlocking a node unlocks all its children. This option is not available for ducts,
as it is a site parameter.

¢ Reset to Auto—Choose one or more of the following items to reset the values:
— Anmplifier units
- DCUs
— Add/Drop units
Step9  Click Apply to apply the changes to the network.
Step10  Click Cancel to cancel the changes and close the dialog box.
Step11  Click Help to display the Help content for CTP.
Step12 Click OK to close the Forcing Manager Dialog box.
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2.10.6 Creating a JPEG of the Network Design

Use the following procedure to create a snapshot of your network design in JPEG format:

Step 1 Click the NtView Name tab.

Step2  Complete the “4.21 Arranging Sites” section on page 4-121 as necessary so that the sites in the network
appear in the tab in the desired arrangement.

Step3  Click the Save network view image icon in the toolbar.
Step4  In the Save network view image dialog box, navigate to the desired directory.

Step5  Enter the file name in the File Name field and click Save.

| 2.10.7 Upgrading to CTP Software Release 10.1

| Use the following procedures to upgrade a release to CTP Software Release 10.1:

S

| Note e CTP Release 10.1 supports upgrading CTP Software Release 7.0 and later releases.

¢ You can upgrade a software release only to its next highest supported release. For example,
Release 7.0 can be upgraded to Release 8.0 but not to Release 8.5.

e If you upgrade from an OSMINE compatible release to a non-OSMINE compatible release and
attempt to analyze the network, CTP displays an error message. To correct this, do one of the
following:

— Continue upgrading till you reach an OSMINE compatible release and then analyze the
network.

- Remove the OSMINE compliance (uncheck the OSMINE compliance option under the Layout
section in the Properties pane) from all the nodes and unlock the site layout in the existing
network. Then, analyze the network.

Step1  From the File menu, click Open to load the saved CTP project (Release 7.0 and later releases).

Step2  Right-click on the network loaded in the Project Explorer pane and choose Release Upgrade.
CTP automatically creates a copy of the initially loaded network and updates the system release to the
next highest release. The newly created copy is moved into the Upgrade administrative state.

| Cisco Transport Planner DIWDM Operations Guide, R10.1
| oL-29753-m .m.



Chapter2  Creating and Analyzing Networks

Ml Viewing a BoM

Step 3

Repeat Step 2 until the release is upgraded to Release 10.1.

a~

Note  CTP allows you to manually enter the details of a deployed network even if the
Cisco Transport Planner design file is not available. You can perform a release upgrade only on
a network that has been analyzed.

a~

Note If a network is analyzed in the Release Upgrade state when the cards are in the unlocked state,
CTP replaces any existing TCC2P card with a TCC3 card in the M12 shelf.

2.11 Viewing a BoM

Note

You can generate a BoM when a network is in the Install or Upgrade state or after you have successfully
analyzed your network design. The price database selected during project creation is used to generate
the BoM.

The BoM can be exported in BoM to Excel spreadsheet. The Excel spreadsheet contains the following
tabs:

e Net View (BoM)
e Site View (BoM)
e SalesForce BOM (BoM)

In addition to the above tabs, the Excel spreadsheet contain the following tabs when the Use Spare Parts
check box is checked in the BoM report.

e Net View (Spare)
¢ Site View (Spare)
e SalesForce BOM (Spare)

When the unit discount or the quantity of a unit of any site is updated in the Net View (BoM) or the Site
View (BoM) tab of the Excel spreadsheet, the associated fields such as the total price, discounted total
price, and the quantity of the unit are updated. The cumulative BoM price and the cumulative discounted
BoM price are also updated.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “1.4.1 Opening a Project” section on page 1-18 and the “1.4.2 Loading and Unloading Networks”
section on page 1-19.

2.11.1 Viewing BoM Report Totals

Step 1

Use the following procedure to view the BoM report totals:

Click the Mgmt Tree tab and click the network.
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Step2  In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. As an alternative, you can
access this report by choosing Bill of Materials from the Reports folder in the Project Explorer pane.

The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following
information:

e BoM total discounted—Displays the price for the overall network (without spare parts) for each item
in the BoM. If Use global discount is checked, the total includes the discount from the Global
discount percentage field.

e Spare total discounted—Displays the price for all of the recommended spare parts in all of the
maintenance centers for the overall network. It is the sum of each spare item using the discounted
price. The total appears after you check the Spare Part Report check box.

¢ BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total
discounted price.

e Price List—Displays the name of the price list database selected for the project.
e Price List last update—Displays the date that the selected price list was last updated.

e Currency—Displays the value of the currency used for each of the price values as specified within
the selected price list database.

Step3  To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single
items, check Use MSM bundle.

Step4d  Check Use Spare Parts to include the spare parts in the report totals.

~

Note  You can check the Use Spare Parts check box only if the network is in Design mode.

Step5  The Global discount percentage field shows the percentage from the Global Discount Percentage option
in the Default Project Options window. To change the global discount for the entire network, check
Use global discount and enter a new global discount in the form of a percentage in the Global discount
percentage field. The global discount is applied to all components in the BoM and will overwrite any
discount specified in the Global Price List.

2.11.2 Viewing a Network BoM

Use the following procedure to generate a BoM for the network:

Step1  Click the Mgmt Tree tab and click the network.

Step2  In the Tasks Pane, click Bill of Material. The Bill of Material tab (see Figure 2-23) appears. The Net
View subtab is selected by default. Items that are not found appear in yellow in the BOM.
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Figure 2-23 Bill of Material Tab, Net View Subtab
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15454-M-LSBCBL= USE cable for passive devices 2 80.00 0.0
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15454-Ma-DC= 6 service slok M3TP chassis 404 DC power Filker 4 125.00 n.o
15454 -ME-FTAZ= & service slot MSTP chassis Znd gen fan tray 2 200,00 0.0
15454-M-ALMCELZ= SC5I Alarm cable 24AWS & inputs 2 75.00 0o
15454-R9.6,05WKI= 15454 ANSI ETSI MSTP Rel.9.6.0 Pkgs.,DVWD,R... z2 1,935,00 0.0
15216-ATT-LC-10= Bulk attenuator - LC Connectar - 10dB 2 200.00 0.0
OMS-CkP-1005-5R10= C¥P-100GBASE-SR -Caommercial bermp z2 10,000, 00 0.0
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Table 2-6 describes the Net view subtab columns. See the “2.11.1 Viewing BoM Report Totals” section
on page 2-62 for a description of the data, check boxes, and fields at the top of the window.

Table 2-6 BoM Net View Columns

Column Label Description

Product ID Displays the ordering code used to order the BoM from Cisco.
Description Displays a description of the product.

Quantity Displays the number of specific products in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will

display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.
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Table 2-6 BoM Net View Columns (continued)

Column Label Description

Total price Displays the total price of the products before applying the discount.

Discounted Total Displays the total price of the products after applying the discount.

Price

Site # Displays the number of products to be assigned to a particular site. The number
of Site columns is the same as the number of sites in the network.

Step3  To close the Bill of Material report, click the X in the upper right corner of the Bill of

2.11.3 Viewing a Site BoM

A site BoM lists all of the hardware and software parts required for the system to work as designed at a

given site. Use the following procedure to generate a BoM for a site:

Step 1 Click the NtView Name tab and click the site.

Material tab.

Step2  Inthe Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-24). Items

that do not appear in the price list appear in red.

Figure 2-24 Bill of Material Tab, Site View Subtab
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[ Empty slat Filler Panel 15454-BLAMK= 9 225,00 0.0
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Step 3

Table 2-7 describes the Site view subtab columns. See the “2.11.1 Viewing BoM Report Totals” section
on page 2-62 for a description of the data, check boxes, and fields at the top of the window.

Table 2-7 BoM Site View Columns
Column Label Description
Name Displays the site name. Click the plus (+) sign to expand the site and display

the categories. Click the plus (+) sign to expand each category to view the
items in the BoM.

Product ID Displays the ordering code used to order the BoM from Cisco.
Quantity Displays the number of that specific item in the BoM.
Unit price Displays the price for each unit. If the price does not appear, Invalid will

display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.

Total Price Displays the total price of the products before applying the discount.
Discounted Total Displays the total price of the products after applying the discount.
Price

To close the Bill of Material report, click the X in the upper-right corner of the Bill of Material tab.

2.11.3.1 Viewing the ASR Bundle in the Site BoM

Step 1
Step 2

Step 3

Step 4

Use the following procedure to view the BoM for 100 G ASR demands. This is applicable for both ASR
one-port and two-port demands. Table 2-8 displays the components of the ASR bundle in the Site view
of the BoM.

Click the NtView Name tab and click the site.

In the Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-24). The
various units and components associated with each site are displayed.

Locate Payg Bundle and click on the plus (+) sign next to it. The 100 G ASR demand is displayed. The
associated pluggables, cables, 100 G transponder cards, and PID for the 100 G ASR demand are bundled
together and displayed as a single component.

Click on the plus (+) sign next to the 100 G ASR demand to expand and display the items present in the
bundle.

Cisco Transport Planner DOWDM Operations Guide, R10.1



| Chapter2 Creating and Analyzing Networks

ViewingaBom W

Table 2-8 ASR Bundle in the Site View
Name PID Quantity
Payg Bundle of ASR one-port
ASR 9K 1-port 100G IP+DWDM upgradable kit A9K-100G-WDM-1P-U 1
e ASR 9K 2-port 100GE - TR LC A9K-2X100GE-TR 1
e CXP-CFP MPO cable, 10m long A9K-CCC-100G-10 1
e CXP - 100GBASE-SR - Commercial temp A9K-CXP-100G-SR10 1
e 100G OTU-4ITU-T CP-DQPSK Full C-band A9K-M-100G 1
Tuneable LC
Payg Bundle of ASR two-port
ASR 9K 2-port 100G IP+DWDM Starter kit A9K-100G-WDM-2P-K 1
e ASR 9K 2-port 100GE - TR LC A9K-2X100GE-TR 1
e CXP-CFP MPO cable, 10m long A9K-CCC-100G-10 2
e CXP - 100GBASE-SR - Commercial temp AI9K-CXP-100G-SR10 2
e 100G OTU-4ITU-T CP-DQPSK Full C-band A9K-M-100G 2
Tuneable LC

2.11.4 Generating a Spare Parts Report

After you generate the BoM, use the following procedure to determine the spare parts required by the
network. If the network is in the Upgrade state, the report includes the parts required to support the
implemented services and the new additional present services. To generate a spare parts report, you must
associate a site with a maintenance center before network analysis. For more information, see the

“4.3 Editing Site Parameters” section on page 4-3.

Step 1 Click the Mgmt Tree tab and click the network.

Step2  In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-25).
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Figure 2-25 Bill of Material Tab, Spare Subtab
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Table 2-9 describes the Spare subtab columns. See the “2.11.1 Viewing BoM Report Totals” section on
page 2-62 for a description of the data, check boxes, and fields at the top of the window.

Table 2-9 BoM Spare Subtab Columns

Column Label Description

Name Displays the name of the item at the site. Right-click the maintenance center
and choose Expand All from the shortcut menu to view all spare parts.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of specific items in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will

display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount

Displays the per-unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the field displays the default
value from the Price List database.
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Table 2-9 BoM Spare Subtab Columns (continued)

Column Label Description

Total Price Displays the total price of the parts before applying the discount.
Discounted Total Displays the total price of the parts after applying the discount.
Price

Step3  To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.11.5 Exporting a BoM

Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML,
or text format:

Step 1 Click the Mgmt Tree tab and click the network.
Step2  In the Tasks Pane, click Bill of Material. The Bill of Material tab appears.
Step3  Click Export. The BoM export dialog box appears.

Step4  In the BoM export dialog box, type the name of the file, choose the file type (.xIs and .html) from the
drop-down list, and navigate to the desired folder. Click Save.

2.12 Managing the Price List

A price list is defined for each project and is used to generate a BoM. Cisco Transport Planner can
manage multiple price lists. You can even change a project price list after a project has been established.
The Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco
Connection Online (CCO).

Only the selected price value is saved with a project; the actual price database is not saved with the
project. When opening a saved project (for example, a project received from another designer), the
associated price database might not be available. If this is the case, Cisco Transport Planner notifies you
that the Master Price list will be used.

To save memory, Cisco Transport Planner automatically loads only the price list selected for the current
project.

2121 Creating a New Price List

Use the following procedure to download a price list from CCO. You can download price lists from CCO
if no projects are currently open.

Step 1 If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-20.
Step2  From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26).
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Figure 2-26
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Step 3

shortcut menu.

Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10

2.12.2 Viewing a Price List

Click Close to close the Price Manager dialog box.

In the Create a New Price DB dialog box, enter the price list name.
From the drop-down list, choose the desired CCO price list.

Click OK.
Click OK to update from CCO.

Use the following procedure to view and filter a price list:

Step 1

page 2-70).

In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the

In the CCO User Name/Password dialog box, type your user name and password, and click OK.
Cisco Transport Planner downloads the CCO price list.

When the update is complete, click OK to close the confirmation dialog box. The new price list appears
in the PriceDBManager tree.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
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The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco Transport Planner
automatically loads only the price list selected for the current project (unless the user requests
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a
price list is currently not loaded in memory and is not available.

To load or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left
corner of the Price Manager dialog box:

e Last update—Indicates the date of the last download from CCO for this price list. If Never appears,
this indicates that the user created a price list without downloading from CCO.

e Updated by—Identifies the way in which the price list was updated.
The price list displays the following columns:

e Price List ID—For internal use.

e Major Parent ID—Lists the platform.

e Minor Parent ID—Lists the equipment type.

¢ Product ID—Identifies the ordering code for the specific unit.

e Description—Provides detail about the item.

¢ Service Category—For future use.

e List Price—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has
not been updated.

e Major ID—For internal use.

e Minor ID— For internal use.

e Update Status—Identifies how the last update was made to an item:
— None—Indicates that the price list has never been updated.
— local_file—Indicates that the price list has been updated from a local file.
— cco—Indicates that the price list has been updated from CCO.

— user—Indicates that the price list has been manually updated by the user who directly edited the
price list. The user can modify the Discount field.

e Discount—If a discount applies, identifies the discount percentage. To modify this field, enter the
new percentage.

To search for a specific item in a price list, type the desired item in the Search field at the top of the list.
As you type, Cisco Transport Planner filters the list items to match your search entry. To choose Search
options, click the Search Tool icon to the left of the Search field and choose one of the following:

¢ Column name—Searches only the specified column for the search string. The All option searches
all columns.

e (ase sensitive—Matches the case of the search string.

¢ (Case insensitive—Disregards the case of the search string.

e Match from start—Searches only for the search string if it appears at the beginning of column text.
e Match any where—Searches for the search string if it appears anywhere in the price list.

To sort the items in the price list, click on a column to sort by that column.
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Step 6

Click Close to close the Price Manager dialog box.

2.12.3 Loading and Unloading Price Lists

Step 1

Step 2

To save memory, Cisco Transport Planner automatically loads only the price list selected for the current
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following
procedure to load or unload price lists in Cisco Transport Planner:

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
page 2-70).

Right-click the price list and choose Load or Unload from the shortcut menu.

2.12.4 Updating a Price List from CCO

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Use the following procedure to update a specified price list from CCO or from a local file. You can also
update all price lists, even the lists that are not currently loaded. You can update a price lists from CCO
if no projects are currently open.

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-20.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
page 2-70).

Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the
shortcut menu.

Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut
menu.

In the Update from CCO dialog box, choose Update single price list to download data for the specified
list or Update all price lists to download the latest data for all price lists.

In the CCO User Name/Password dialog box, type your user name and password and click OK.
Cisco Transport Planner downloads the price list.

When the update is complete, click OK to close the confirmation dialog box.

Click Close to close the Price Manager dialog box.
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2.12.5 Copying a Price List

Step 1
Step 2

Step 3
Step 4

Step 5

Use the following procedure to create a new price list by copying from an existing one. The new price
list will have all of the attributes and values of the original price list (such as Updated By, Last Update,
unit price, discounts, and so on). You can copy a price list if no projects are currently open.

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-20.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
page 2-70).

Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Enter the name for the new price list and click Ok. The new price list appears in the PriceDBManager
tree.

Click Close to close the Price Manager dialog box.

2.12.6 Deleting a Price List

Step 1
Step 2

Step 3
Step 4

Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list
that is in use by a project. You can delete a price list if no projects are currently open.

If a project is open, close the project. See the “1.4.4 Closing a Project” section on page 1-20.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
page 2-70).

Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Click Close to close the Price Manager dialog box.

2.12.7 Viewing Maintenance Contracts

Step 1

Step 2

Step 3

Step 4

Step 5

Use the following procedure to view maintenance contracts:

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-26 on
page 2-70).

Right-click Maintenance Contracts and choose Expand from the shortcut menu.

Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and
software parts used by Cisco Transport Planner. The Contract Category column describes the service
programs.

Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the
service contract identifier.

Click Close to close the Price Manager dialog box.
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2.13 Importing Designs Created in the Sherpa Tool

The Sherpa tool is used to create Layer 2 network designs using Cisco Carrier Packet Transport (CPT)
system. These network designs can be saved as XML files and imported into CTP. Use the following
procedure to import designs created in the Sherpa tool.

Step1  From the Tools menu, choose Import From Sherpa. The Sherpa file import wizard is displayed.
Step2  In the Import XML area:

¢ Click the Browse button to browse for the Sherpa generated XML file. Select the XML file and click
Open. The file path is displayed in the Import field.

e Select one of the following radio buttons to define the import mode:

— Custom—The Sherpa network is manually mapped to an existing CTP network that is in the
Design or Upgrade mode.

— Green Field—Sherpa design is imported into a new network in a new CTP project. Ensure that
there is no project currently open in CTP, as two projects cannot be simultaneously open.

Step3  Click Next.

Stepd  Inthe Project/Network Options area, these radio buttons are available under two categories—Project and
Network:

e The following radio buttons define project creation:

- Use existing CTP project—The Sherpa design is imported into an existing CTP project, which
is currently open. This option is unavailable if Green Field is selected as the import mode.

— Create a new project—The Sherpa design is imported into a new CTP project. This option is
unavailable if Custom is selected as the import mode.

¢ The following radio buttons define network creation:

— Use existing network—The sites in the Sherpa design are imported into an existing network,
which can be selected in the adjacent drop-down list. This option is unavailable if Green Field
is selected as the import mode.

— Create a new Network—The sites in the Sherpa design are imported into a new network. This
option is unavailable if Custom is selected as the import mode.

Step5  To complete importing the Sherpa file, do one of the following:

e If you have selected the Green Field option, click Finish. The Sherpa design is imported into CTP.
The sites, ducts, and demands are created in CTP with the same parameters as defined in the Sherpa
design.

e Ifyouhave selected the Custom option, click Next to choose the settings to map the Sherpa elements
to CTP elements.

You can map sites, fibers, and demands. The elements present in the Sherpa project are displayed as a
tree structure on the left side of the Sherpa file import wizard.

Step6  In the Sherpa - CTP Site Mappings area:

e Check the check box corresponding to the Sherpa site that needs to be mapped to a CTP site. By
default, all the check boxes are selected.

e Click the cell in the CTP Match column. The list of available sites in the CTP network are displayed
as a drop-down list. You can select:

— Create New—A new site is created in CTP with the same name as that of the Sherpa site.
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Step 8

Step 9

Step 10
Step 11

Step 12

Step 13

Note

Importing Designs Created in the Sherpa Tool

— Site name—The Sherpa site is mapped to the selected CTP site. If there is any conflict between
the fibers at the Sherpa site and the fibers at the CTP site being mapped, those fibers in the
Sherpa Project tree structure are displayed in red. The conflict is resolved once the fibers are
correctly mapped, as described in step 8.

Click Next.
In the Sherpa - CTP Fiber Mappings area:

¢ Check the check box corresponding to the Sherpa fiber that needs to be mapped to a CTP fiber. By
default, all the check boxes are selected.

¢ Click the cell in the CTP Match column. The list of available ducts in the CTP network are displayed
as a drop-down list. You can select:

— Create New—A new duct is created in CTP with the same name as that of the Sherpa duct.
— Duct name—The Sherpa duct is mapped to the selected CTP duct.

Click on a duct in the Fibers Imported From Sherpa column. In the Fiber Property Chooser area, check
the check box to retain either the Sherpa value or the CTP value for the duct parameters. No parameters
are displayed in the Fiber Property Chooser area if the CTP match for the duct is set as Create New.

Click Next.
In the Sherpa - CTP Demand Mappings area:

¢ Check the check box corresponding to the Sherpa demand that needs to be mapped to a CTP demand.
By default, all the check boxes are selected.

e (Click the cell in the CTP Match column. The list of available demands in the CTP network are
displayed as a drop-down list. You can select:

— Create New—A new demand is created in CTP with the same name as that of the Sherpa
demand. This is the only option available when the Sherpa design is being imported for the first
time.

— Demand name—The Sherpa demand is mapped to the selected CTP demand. This option is
available only when the Sherpa design is reimported into the same CTP project.

Click the cell in the Circuits Imported From Sherpa column. In the Demand Property Chooser area,
check the check box to retain either the Sherpa value or the CTP value for the demand parameters. No
parameters are displayed in the Demand Property Chooser area if the CTP match for the demand is set
as Create New.

Click Finish. The Sherpa design is imported into CTP. All the imported Sherpa elements are now
converted as standard CTP elements.

The sites, fibers, and demands in the Sherpa Project tree structure are displayed in blue if the elements
they are being mapped to are in the locked state in CTP. This can occur while importing a Sherpa design
into a CTP network that is in the upgrade or release upgrade state. In case of locked fibers, and demands,
a message window is displayed after clicking Next in the Fibre Options page or Finish in the Demand
Options page, respectively. Click Yes to unlock the elements.

However, the sites do not get unlocked during the import process. If the analysis generates any error due
to the sites being locked, you have to unlock the sites manually.
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Note  The CPT cards like fabric card, line card, and CPT 50 panel are not included in CTP reports and layouts.
However, CTP supports the two CPT trunk pluggables—ONS-XC-10G-C and ONS-XC-10G-EPxx.x.
These pluggables are visible in Optical Results, Traffic Matrix, and Internal Connections reports.

2.14 Bidirectional Communication with the Network Element

CTP communicates with the network element to import and export node parameters of the network. Use
the following procedure to import a network from the node, analyze the network, and export the network
to the node element.

Note  CTP releasel0.1 supports importing 9.603, 9.604 and 9.605 networks.

Step 1 From the CTP File menu choose Import Network or click Import Network in the Start Page. The Node
Login dialog box appears.

Step2  In the Node Login dialog box, complete the following:
¢ Node IP—Enter the IP address of the Cisco Transport Controller (CTC) node.
e Username—Enter the CTC username.
e Password—Enter the CTC password.

Step3  Click Ok. The CTC window opens. The CTP window becomes inactive.

Step4  (Optional) Perform node provisioning as required in the CTC window.

Step 5 In the network view, click Circuits > Circuits tabs. Verify that all the circuits are in the DISCOVERED
state in Status column.

Step6  From the Tools menu in the CTC window, choose Export XML to export the node data to CTP. The
Export Network Information into XML window appears listing all the nodes that are discovered. Verify
that all nodes are discovered.

~

Note  The Export XML option is available only when CTC is launched through CTP.

Step7  Select the nodes to be exported into XML and click OK. The Export Successful dialog box appears when
all the node data is exported.

For release 9.8 and later, CTP supports importing the following cards from CTC:
e 100G-LC-C, 100G-CK-LC-C and 10 X 10 G-LC standalone cards.

e ]100G-CK-LC-C + 10X10G-LC, 100G-CK-ME-C+10X10G-LC, 100G-CK-LC-C+CFP-LC,
100G-CK-ME-C+CFP-LC, 100G-LC-C + CFP -LC, 100G-ME-C + CFP-LC, 100G-ME-C + 10 X
10G TXP, and 100G-LC-C + 10 X 10 G-LC combination cards.

e TNC-E and TSC-E cards.
Step8  Click OK.
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Step 11
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Step 13
Step 14

Step 15

Step 16
Step 17

Step 18

Step 19
Step 20

Step 21
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Close the CTC window.
a. From the File menu, choose Exit.
b. Click Yes to confirm exit.

The CTC window closes, the CTP window becomes active, and the Import Network wizard appears. This
may take about 1 minute depending on the size of the network.

In the Project/Network Options area, these radio buttons are available under two categories—Project and
Network:

¢ The following radio buttons define project creation:

— Use existing CTP project—This imports the node data from CTC into an existing CTP project.
This option is disabled.

— Create a new project—This imports the node data from CTC into a new CTP project.
e The following radio buttons define network creation:

— Use existing network—This imports the sites from the CTC node into an existing network. This
option is disabled.

— Create a new Network—This imports the sites from the CTC node into a new network.
Click Next to choose the settings to map the node elements to CTP elements.

In the Site Options area, check the check box corresponding to the site that needs to be modelled to a
CTP site. By default, all the check boxes are selected.

S

Note  CTP does not support omnidirectional and colorless sites or cascading 80-WXC-C cards.

Click Next.

In the Node - CTP Fibre Modelling area, check the check box corresponding to the fiber that needs to
be modelled to a CTP fiber. By default, all the check boxes are selected.

Click on a duct in the Fibre Imported From Node column. In the Fiber Property Chooser area, for
fibre type, select the fiber type from the drop-down list in the Node column.

Click Next.

In the Node - CTP Demand Modelling area, check the check box corresponding to the demand that needs
to be modelled to a CTP demand. By default, all the check boxes are selected.

~

Note CTP supports the import of only point-to-point demands.

Click Finish. The Network creation done dialog box appears indicating that the imported OCHNC
circuits may not be associated with TXP/MXP properly and requires the card and client/trunk pluggables
to be forced appropriately.

Click OK. The Importing Complete dialog box appears when the node properties are imported into CTP.

To view the import logs, click Yes else click No. All the imported node elements are now converted as
standard CTP elements. The Log Viewer displays the import log. This log file is saved in the CTP cache
directory.

The network is imported in the design mode.

In the Project Explorer pane, the invalid demands are underlined in red. Double-click on the invalid
OCHNC demands and edit the parameters as required.
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Step 22

Step 23
Step 24

Step 25

Step 26

Step 27

Step 28

Step 29

Step 30
Step 31

~

Note  Aninvalid OCHNC demand is one in which Traffic Type may be set to I0GE LAN PHY, Source
and Destination Client Cards may be set to Auto and Protection Type may be set to Unprotected
because their values could not be found. Therefore, set the values as required for these
parameters and then validate the demand.

In the Project Explorer pane, right-click the edited demand and choose Validate. Next, proceed to
Step 25.

To validate multiple demands, right-click the demand and choose Select Similar.

After multiple demands are selected, right-click the selected demands and choose Validate.

~

Note  If you try to analyze the network when any demand is still invalid, a warning message is
displayed indicating that the invalid demand must be validated before analysis.

(Optional/Not recommended) Modify the network in CTP as required.

Analyze the network for the imported node data to be applied. Perform the “Analyzing the Network™ task
described in “2.9 Analyzing the Network” section on page 2-53. After the network is analyzed, CTP
provides an option to export the CTP NE Update Configuration file to the node.

To export NE UPdate Configuration file to the node, right-click on any node in the analyzed network and
choose Provision Node. The Node Login window appears.

In the Node Login window, complete the following:
e Username—Enter the CTC username.

e Password—Enter the CTC password.

~

Note  The Node IP field is prepopulated with the node IP address.

Click Ok. The CTC window opens with the node setup selection window for the selected node. The CTP
window becomes inactive.

In the node setup selection window for the selected node, choose the node to be provisioned. Click OK.

On the Node Setup for node name page, choose one or more of the following:

e Node/Shelves Layout—Choose to preprovision the slots when no DWDM cards are installed. The
slots are preprovisioned in each shelf in CTC for the cards defined in the network plan. (Errors will
occur if cards are installed or the slots are preprovisioned). Preprovisioning the slots before the
physical cards are installed ensures that card installers place the cards in the correct slots.
Preprovisioning the slots is also useful if you want to set up the network prior to card installation.
The node layout also preprovisions the chassis and passive units.

¢ Passive Units—Choose to preprovisions the passive units.

e (Card Parameters—Check this check box to provision the following parameters, if the cards are
installed.

- TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP
cards—Provisions the OTN and FEC parameters.

- OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE
cards—Provisions the card mode.
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Pluggable Port Modules—Check this check box to allow the provisioning of PPMs on TXP, MXP,
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP cards, including PPM
payloads.

Internal Patchcords—Check this check box to allow creation of internal patchcords among cards
provisioned in the node.

Optical Sides—Check this check box to allow the provisioning of optical sides.

ANS Parameters—Check this check box to install the ANS parameters. ANS parameters provision
the values required for the node to function within the specified network design. ANS parameters
include span losses, optical power, optics thresholds, amplifier working mode, gain, tilt, and so on.

Select All—Check this check box to select all the options.

Skip Interactive Mode—Check this check box to enable CTC to provision all the chosen setup
components automatically without displaying the results after each step.

Save Installation Files (XML and log) On Node—Check this check box to enable CTC to save the
XML and log files on the node.

Step32 Click OK. The NE Update wizard appears. If you chose Skip Interactive Mode in Step 31, continue
with Step 33. If not, the wizard page that appears depends on the options chosen in Step 31. Table 2-10
describes the NE Update wizard options.
Table 2-10 NE Update Wizard Options
NE Update Function Action

Node/Shelves Layout

View the cards and slots on the left side of the page and verify that they are the same as the layout
in the Cisco Transport Planner Shelf Layout. If the cards and slots match, click Apply. If not, click
Cancel and contact your next level of support to verify that you have the correct node setup file. If
the site has a multishelf configuration, click Next and repeat this step for each shelf at the site.

CTC preprovisions the slots. (This might take a few seconds.) The results appear in the Log window.
Slots that are successfully provisioned display an “Applied” status. A “Slot not empty” status
appears if slots cannot be provisioned because a card is physically installed or the slot is already
provisioned. If this occurs, complete the following steps. Otherwise, continue with the next NE
Update function.

1. Click Cancel, then click Yes in the confirmation dialog box. The slot preprovisioning does not
revert when you click Cancel.

2. If a physical card is installed, remove it from the shelf.
3. Perform one of the following steps:
— Delete all the preprovisioned slots.

— Delete the slot where the Slot Not Empty error occurred. Provision the slot manually, then
repeat Steps 31 and 32 making sure to uncheck the Provision Node Layout option in
Step 31.

Note  When you preprovision a slot, the card is purple in the CTC shelf graphic and
“NP” (not present) appears on the card. After the physical card is installed, the card changes
to white and “NP” is removed from the CTC shelf graphic.

Passive Units Layout

1. Review the passive unit settings.
2. Click Apply.
3. Click Next.
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Table 2-10 NE Update Wizard Options

NE Update Function

Action

Pluggable Port Modules

1.

Review the PPM settings for each TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and
OTU2_XP card.

2. Click Apply.
3. Click Next.
Card Parameters 1. Review the OTN, FEC, and card mode settings for each TXP, MXP, GE_XP, I0GE_XP,
GE_XPE, 10GE_XPE, and OTU2_XP card.
2. Click Apply.
3. Click Next.
Internal Patchcords 1. Review the internal patchcords.
2. Click Apply.
3. Click Next.
Optical Sides 1. Review the optical side assignments.
2. Click Apply.
3. Click Next.
ANS Parameters 1. Review the ANS parameters on the left half of the page.
2. Click Apply. The log file displays the results. At the end, a Done status will appear. If a

parameter could not be applied, a Setting Refused status appears. If this occurs, contact your
next level of support.

Select All

If checked, selects all the options.

Skip Interactive Mode

If checked, CTC provisions all the chosen setup components automatically without displaying the
results after each step.

Save Installation Files
(XML and log) On
Node

If checked, CTC saves the XML and log files on the node.

Step33  Click Finish, then click OK in the Wizard Complete confirmation dialog box. The confirmation box
indicates whether importing the NE UPdate Configuration file to the node was completed successfully.

Note  Common control cards are not provisioned by CTP.Common control cards are not provisioned by CTP.

Note  From release 10.1 onwards, CTP supports import of Span length and Span loss, and DCU.

2.14.1 Limitations

The following limitations apply when CTP imports and exports node parameters of the network:

Imports or exports node parameter data from the network element running Software Release 9.1 and
later releases.

Prompts to create a default rack layout when importing individual shelf configuration.
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e Fails to import the internal patch cord connections in correctly if they are not provisioned
completely in CTC.

e Fails to export omnidirectional and colorless properties of an optical side.
¢ Fails to export PSM unit data.

e Requires passive units like Mux/Demux units to be provisioned in CTC before importing the node
parameters into CTP.

e Imports passive units like DCU only if the initial provisioning is made using the NeUpdate. XML
file generated by CTP.

e Sets 10G-LAN-PHY as the default service rate for incomplete OCHNC circuits while the
wavelength and path are forced appropriately.

e Defaults protection for OCHNC circuits to Unprotected. If there is a working and protected trail for
the same demand, each will be a separate point-to-point demand.

e Displays any demands on muxponder cards as a single demand and aggregation is not visible.
The following limitations apply to Split ROADM:

e Supports hardware only till release 9.8.

e Supports only Fiber Switch Protection.

¢ Does not support import of dangling transponders/transponder only shelves.

¢ Does not support import of OCH-NC, OCHNC-DCN, STS/VCAT/VLAN/Partial circuits.

¢ Does not support Split ROADM nodes.

e Does not support attenuators.

¢ Does not support TNC/OTS/TXP/MXP port forcing.

¢ Does not support import of FLD-OSC based sites.

¢ Does not support Omni/Colorless/Remote Spur.

¢ Does not support OSMINE/Insulator.

¢ Does not support import of Shelf Management, Node protection, Regeneration, Fan tray, AC/DC
power supply.

e Limitations in importing Optical/ANS parameters.

2.15 Split ROADM

CTP supports Node Splitting (from release 10.1 onwards). The ROADM node can be configured to have
separate Network Elements for different Line Sides (Per-side NE). Split Node feature is available only
for the below configurations in CTP 10.1:

e Line -> ROADM -> 80WXC
e Multi-degree -> OXC -> 80WXC MESH-PP-4
e Multi-degree -> OXC -> 80WXC MESH-PP-8

When a node is split, each line side becomes a separate NE. TXPs/MXPs associated with specific side
are placed under the specific NE side. TXPs/MXPs associated with multiple sides (multi-trunk, Y-cable,
Fiber-Switched) are placed under a separate non co-located NE called as “Common NE”.
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So, on applying node split on an N-degree site, CTP converts it into N separate Per-Side NEs with an
optional Common NE (if needed).

A split node scenario is described in the following steps.

Step 1 Release upgrade the network to System Rel. 10.1 (if not already in 10.1) and modify network (if
required) except node-split.

Step2  Go to the network tasks pane on the right side and click Copy to take a backup copy of the network
(modified) created in Step 1.

Step3  Node splitting can be done at any time (before and after analysis). For splitting a node before analysis
go to Step 4. For splitting a node after analysis go to Step 6.

Step4  To enable node splitting at the network level (all sites), check the node split check box in the network
properties pane and analyze the network. The (s) next to the site indicates that the specific site is split.

Step5  Or, to enable node splitting in a specific site, click on the site and check the node split check box in the
site properties pane. To force the functionality and type parameters, see 4.22 Modifying Site Properties.
Then, analyze the network.

Step6  To enable node splitting at the network level (all sites), right click on the network and select the Split
Node option. Or, to enable node splitting in a specific site, right click on the required site and select the
node split option.

Step7  During the analysis, the Split Roadm IP dialog box appears displaying the sites in which node split has
been enabled.

Step8  Expand each site to enter the IP address for each NE (optional). To assign the IP addresses at a later time,
click Cancel. After analysis, expand the site in the project explorer and enter the IP addresses for each
NE.

Step9  To export the NeUpdate.xml file, click the NE Update link on the reports pane. To export the circuits in
the XML, check mark the export circuit flag option in the “Network Element Update File” Dialog Box.

Step10 To view the NE IDs, double-click on the layout. Each NE is colored differently.

Step11  For protected cards (for example, Y - cable) and multi- trunk cards (for example, OTU2-XP), a common
NE is created and the cards are moved to this common NE. The following table describes the card
positions for various Protection cards.

Table 2-11 Card Positions for Protection Cards

Protection Schemes TXP/MXP position Common Card/Module Position
Unprotected Corresponding Side NE -

Client 1+1 Corresponding Side NE -

Y-Cable Common NE Common NE (Y-Cable module)
Fiber Switched Common NE -

Step12 To view the common NE IDs, double-click on the layout. The common NE ID is displayed.
Step13 To view the Virtual PP-Mesh Unit IDs, click on the PP-MESH Unit in layout.
)

Note  Virtual PP Mesh units are created to interconnect different NEs. These are visible only in the
NeUpdate file.
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The following tables display the ports for virtual PP Mesh 4 and virtual PP Mesh 8.

Table 2-12 Ports for Virtual PP Mesh 4

VPASSIVE_1_PPMESH4 VPASSIVE_2_PPMESH4 |VPASSIVE_3 _PPMESH4 |VPASSIVE_4 PPMESH4
1 COM-RX A 1 COM-RX B 1 COM-RX C 1 COM-RX D
2 EXP-TX A-1 2 EXP-TX B-1 2 EXP-TX C-1 2 EXP-TX D-1
3 EXP-TX A-2 3 EXP-TX B-2 3 EXP-TX C-2 3 EXP-TX D-2
4 EXP-TX A-3 4 EXP-TX B-3 4 EXP-TX C-3 4 EXP-TX D-3
5 EXP-TX A-4 5 EXP-TX B-4 5 EXP-TX C-4 5 EXP-TX D-4
6 VEXP-RX-2 6 VEXP-RX-1 6 VEXP-RX-1 6 VEXP-RX-1
7 VEXP-TX-2 7 VEXP-TX-1 7 VEXP-TX-1 7 VEXP-TX-1
8 VEXP-RX-3 8 VEXP-RX-3 8 VEXP-RX-2 8 VEXP-RX-2
9 VEXP-TX-3 9 VEXP-TX-3 9 VEXP-TX-2 9 VEXP-TX-2
10 |VEXP-RX-4 10 |VEXP-RX-4 10 VEXP-RX-4 10 VEXP-RX-3
11 |VEXP-TX-4 11 |VEXP-TX-4 11 VEXP-TX-4 11 VEXP-TX-3
Table 2-13 Ports for Virtual PP Mesh 8 (1 to 4)

VPASSIVE_1_PPMESH8 |VPASSIVE_2_PPMESH8 |VPASSIVE_3_PPMESH8 |VPASSIVE_4 PPMESHS
1 COM-RX A 1 COM-RX B 1 COM-RX C 1 COM-RX D

2 EXP-TX A-1 2 EXP-TX B-1 2 EXP-TX C-1 2 EXP-TX D-1
3 EXP-TX A-2 3 EXP-TX B-2 3 EXP-TX C-2 3 EXP-TX D-2
4 EXP-TX A-3 4 EXP-TX B-3 4 EXP-TX C-3 4 EXP-TX D-3
5 EXP-TX A-4 5 EXP-TX B-4 5 EXP-TX C-4 5 EXP-TX D-4
6 EXP-TX A-5 6 EXP-TX B-5 6 EXP-TX C-5 6 EXP-TX D-5
7 EXP-TX A-6 7 EXP-TX B-6 7 EXP-TX C-6 7 EXP-TX D-6
8 EXP-TX A-7 8 EXP-TX B-7 8 EXP-TX C-7 8 EXP-TX D-7
9 EXP-TX A-8 9 EXP-TX B-8 9 EXP-TX C-8 9 EXP-TX D-8
10 VEXP-RX-2 10 |VEXP-RX-1 10 |VEXP-RX-1 10 |VEXP-RX-1
11 VEXP-TX-2 11 |VEXP-TX-1 11 |VEXP-TX-1 11 |VEXP-TX-1
12 VEXP-RX-3 12 |VEXP-RX-3 12 |VEXP-RX-2 12 |VEXP-RX-2
13 VEXP-TX-3 13 |VEXP-TX-3 13 |VEXP-TX-2 13 |VEXP-TX-2
14 VEXP-RX-4 14 |VEXP-RX-4 14 |VEXP-RX-4 14 |VEXP-RX-3
15 VEXP-TX-4 15 |VEXP-TX-4 15 |VEXP-TX-4 15 |VEXP-TX-3
16 VEXP-RX-5 16 |VEXP-RX-5 16 |VEXP-RX-5 16 |VEXP-RX-5
17 VEXP-TX-5 17 |VEXP-TX-5 17 |VEXP-TX-5 17 |VEXP-TX-5
18 VEXP-RX-6 18 |VEXP-RX-6 18 |VEXP-RX-6 18 |VEXP-RX-6
19 VEXP-TX-6 19 |VEXP-TX-6 19 |VEXP-TX-6 19 | VEXP-TX-6
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Table 2-13 Ports for Virtual PP Mesh 8 (1 to 4) (continued)

VPASSIVE_1_PPMESH8 VPASSIVE_2_PPMESH8 VPASSIVE_3_PPMESH8 |VPASSIVE_4 PPMESHS8

20 VEXP-RX-7 20 |VEXP-RX-7 20 |VEXP-RX-7 20 |VEXP-RX-7

21 VEXP-TX-7 21 |VEXP-TX-7 21 |VEXP-TX-7 21 |VEXP-TX-7

22 VEXP-RX-8 22 |VEXP-RX-8 22 |VEXP-RX-8 22 |VEXP-RX-8

23 VEXP-TX-8 23 |VEXP-TX-8 23 |VEXP-TX-8 23 |VEXP-TX-8

Table 2-14 Ports for Virtual PP Mesh 8 (5 to 8)

VPASSIVE_5_PPMESH8 VPASSIVE_6_PPMESH8 VPASSIVE_7_PPMESH8 VPASSIVE_8_PPMESHS8

1 COM-RX E 1 COM-RX F 1 COM-RX G 1 COM-RX H

2 EXP-TX E-1 2 EXP-TX F-1 2 EXP-TX G-1 2 EXP-TX H-1

3 EXP-TX E-2 3 EXP-TX F-2 3 EXP-TX G-2 3 EXP-TX H-2

4 EXP-TX E-3 4 EXP-TX F-3 4 EXP-TX G-3 4 EXP-TX H-3

5 EXP-TX E-4 5 EXP-TX F-4 5 EXP-TX G-4 5 EXP-TX H-4

6 EXP-TX E-5 6 EXP-TX F-5 6 EXP-TX G-5 6 EXP-TX H-5

7 EXP-TX E-6 7 EXP-TX F-6 7 EXP-TX G-6 7 EXP-TX H-6

8 EXP-TX E-7 8 EXP-TX F-7 8 EXP-TX G-7 8 EXP-TX H-7

9 EXP-TX E-8 9 EXP-TX F-8 9 EXP-TX G-8 9 EXP-TX H-8

10 VEXP-RX-1 10 |VEXP-RX-1 10 |VEXP-RX-1 10 |VEXP-RX-1

11 VEXP-TX-1 11 |VEXP-TX-1 11 |VEXP-TX-1 11 |VEXP-TX-1

12 VEXP-RX-2 12 |VEXP-RX-2 12 |VEXP-RX-2 12 |VEXP-RX-2

13 VEXP-TX-2 13 |VEXP-TX-2 13 |VEXP-TX-2 13 |VEXP-TX-2

14 VEXP-RX-3 14 |VEXP-RX-3 14 |VEXP-RX-3 14 |VEXP-RX-3

15 VEXP-TX-3 15 |VEXP-TX-3 15 |VEXP-TX-3 15 |VEXP-TX-3

16 VEXP-RX-4 16 |VEXP-RX-4 16 |VEXP-RX-4 16 |VEXP-RX-4

17 VEXP-TX-4 17 |VEXP-TX-4 17 |VEXP-TX-4 17 |VEXP-TX-4

18 VEXP-RX-6 18 |VEXP-RX-5 18 |VEXP-RX-5 18 |VEXP-RX-5

19 VEXP-TX-6 19 |VEXP-TX-5 19 |VEXP-TX-5 19 |VEXP-TX-5

20 VEXP-RX-7 20 |VEXP-RX-7 20 |VEXP-RX-6 20 |VEXP-RX-6

21 VEXP-TX-7 21 |VEXP-TX-7 21 |VEXP-TX-6 21 |VEXP-TX-6

22 VEXP-RX-8 22  |VEXP-RX-8 22  |VEXP-RX-8 22 |VEXP-RX-7

23 VEXP-TX-8 23 |VEXP-TX-8 23 |VEXP-TX-8 23 |VEXP-TX-7
Step14 Before un-splitting a node, take a backup copy of the Split Node. To unsplit the nodes in a site after

analysis, right-click on the site and select UnSplit. This can be performed in the project explorer pane
also. When a node is unsplit:
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e Per-side NEs are combined to single NE and reflected in site navigation and net view.
e Common NE is removed.

e Layout is unlocked.

e Unit IDs/MSM IDs are regenerated for the combined layout.

e Reserved Virtual-PPMesh unit IDs are removed.

e P addresses are removed.

To unsplit or split multiple sites, select the sites and perform the required action.

| 2151 Limitations

The following limitations apply to Split ROADM for this release:
¢ No support for splitting of site having omnidirectional sides and/or colorless ports.

e No support for creating OCH-CC circuits for Ethernet aggregate and TDM aggregate demands.
Creating OCH-NC circuits is recommended.

e No support for creating OCH-CC circuits with alien/line/pluggable cards. Creating OCH-NC
circuits is recommended.

¢ No support for exporting PSM-OCH protected circuits in NeUpdate XML.

e No support for circuit regenerating on a split node. Delete such circuits before splitting the node to
avoid invalid reports.

e No support for circuit having optical bypass on a split node. Delete such circuits before splitting the
node to avoid invalid reports.

¢ Information related to PPC and virtual PP-MESH is available only in NeUpdate XML file.

e PPM port types are not available in NeUpdate XML for the following cards. Creating OCH-NC
circuits is recommended.

- 40E-TXP-C

- 40G-TXP-C

- MXP_MR_I0DMEX_C

- MXP_2.5G_10EX_C

- TXP_MR_10EX_C

- ADM_10G

- MXP_MR_10DME

- TXP_MR_10E_y

- MXP_2.5G_I10E_y

- TXP_MR_I0E

- 40G DWDM ITU-T MXP
- 40G DWDM ITU-T TXP
- MXP_MR_2.5G

- MXPP_MR_2.5G

- 530 MR MXP

| Cisco Transport Planner DIWDM Operations Guide, R10.1
| oL-29753-m .ﬂﬂ



Chapter2  Creating and Analyzing Networks |

M SplitROADM

- 530 MR TXP

- TXP_MR_10E

- MXP_2.5G_10E

- 530 MR TXP/MXP

- TXP_MR_2.5G

- TXPP_MR_2.5G

- TXP_MR_10G

- MXP_2.5G_10G

- 15454-10GE-XPE

- 15454-10GE-XP

- 15454-GE-XPE

- 15454-GE-XP

- 15454-40EX-TXP-C

- 15454-40G-TXP-C
e Virtual PP-MESH Unit IDs are not editable.
e Merging two side NEs is not recommended.

e All circuits originating or terminating from the same transponder/muxponder cards should be
OCH-NC or OCH-CC or OCH-NCDCN.

¢ Circuits are exported in NeUpdate XML only if at least one of the nodes is split and the circuit is
originating/terminating or expressing through the split node.
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Cisco Transport Planner provides the reports listed in Table 3-1. Report availability depends on whether
a network has been analyzed or whether it is in the Install or Upgrade state. Reports are also available
by site. See Table 3-1 for report availability details.

3.1 Types o